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UNIT

1
MS OFFICE

STRUCTURE

1.1 	 Learning Objective
1.2 	 Introduction
1.3 	 Different tools used in MS Word
1.4 	 Study and Application of different tools used in MS Excel
1.5 	 Student Activity
1.6 	 Study and Application of different tools used in MS Paint
1.7 	 Study and Application of different tools used in MS Power Point
1.8 	 Summary
1.9 	 Glossary
1.10 	 Review Questions

1.1  LEARNING OBJECTIVE 

After studying this unit you should be able to:
●● Explain the meaning and definition of Word Processing Tools.
●● Describe the main responsibilities of a Standard Toolbar.
●● Describe the Formatting Toolbar.
●● Explain the meaning and significance of Excel Charts and Design Tools.
●● Explain the procedure of MS Painting Tools Functions.
●● Describe the technology for Advantages and Disadvantages of PowerPoint.
●● Explain The most basic element of a PowerPoint presentation is the slide..

1.2 � INTRODUCTION 

Modern textile and clothing manufacturers can today use the entire range of 
conventional CAD/CAM systems together with new computer graphics and 
Internet-based technologies in order to strengthen their position on the market, 
building a completely new electronic-business offer. Graphical presentation of 
textile products and processing, or visualisation, presents a promising technology 
that can be treated as a potential enrichment of conventional computer aided 
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technologies used today by the majority of advanced producers of textile fabrics, 
clothing, and other textile products.

Word processing is the ability to create documents using a word processor. It 
can also refer to advanced shorthand techniques, sometimes used in specialised 
contexts with a specially modified typewriter. These were primarily aimed at 
typists, particularly in offices where other workers sent handwritten notes to be 
transcribed into documents for printing which were returned for reviewing.

●● Textile Design Systems:  Woven textiles are used by designers and 
merchandisers for fabrics for home furnishing and to men-women-children 
wear. Most fabrics whether yarn dyes, plain weaves, jacquards or dobbies can 
be designed and in fact are invariably used abroad using a CAD system for 
textiles. Similarly embroideries are also developed at CAD workstations.

●● Knitted Fabrics:  Some systems specialize in knitwear production and final 
knitted design can be viewed on screen with indication of all stitch formation. 
For instance a CAD program will produce a pullover graph that will indicate 
information on amount of yarn needed by color for each piece. Another example 
of the new technology in the industries using a yarn scanner, which is attached 
to the computer scans a thousand meters of yarn and then simulates a knitted/ 
woven fabric on-screen. This simulation will show how the fabric will look like 
if woven from that yarn.

●● Printed Fabrics:  The process involves use of computers in design, development 
and manipulation of motif. The motif can then be resized, recoloured, rotated or 
multiplied depending on the designer’s goal. The textile design system can show 
color ways in an instant rather than taking hours needed for hand painting. 
New systems are coming which have built-in software to match swatch color 
to screen color to printer color automatically i.e. what you see is what you get.

●● Illustrations/ Sketch Pad Systems:  These are graphic programmes that 
allow the designer to use pen or stylus on electronic pad or tablet thereby 
creating freehand images, which are then stored in the computer. The end 
product is no different from those sketches made on paper with pencil. Different 
knit and weave simulations can be stored in a library and imposed over these 
sketches to show texture and dimensions.

●● Texture Mapping:  3D Draping Software: This technology allows visualization 
of fabric on the body. Texture mapping is a process by which fabric can be draped 
over a form in a realistic way. The designer starts with an image of a model 
wearing a garment. Each section of the garment is outlined from seam line to 
seam line. Then a swatch of new fabric created in textile design system is laid 
over the area and the computer automatically fills in the area with new color. 
The result is the original silhouette worn by original model in a new fabric.

●● Embroidery Systems:  The designs used for embroidery can be in corporate 
on the fabric for making garment. For this special computerized embroidery 
machines are used. Designers can create their embroidery designs or motifs 
straight on the computer. All they need to do is design color and stitch to 
different parts of the design.
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Apparel Industry And Computer
●● Digitizing Systems:  Digitizer put original patterns into the computer for 

use and storage. It can be done by defining the X, Y coordinates of series of 
selected points around the pattern. These basic patterns can be manipulated 
with the help of a computer, for example in case of trousers, darts can be moved, 
pleates can be created. In this way new designs can be created on screen from 
pre-existing pattern.

●● Grading Systems:  After a sample size pattern has been put, it has to be 
graded up and down on size. Certain points on the pattern are considered as 
“growth points” or places at which the pattern has to be increased or decreased 
to accommodate changing body size. At each growth point the operator indicates 
the grade rule to the computer. The system will then automatically produce 
the pattern shapes in all the pre-specified sizes. Say if we define pattern for 
size 30, it can be easily graded for size 32/34/36 and so on.

●● Marker Making Systems:  Computerized marker making systems help in 
laying the pattern part together more economically than an operator could 
hands. This ensures minimum wastage of fabric. On plain fabric this is 
relatively simple but on striped fabric also automatic matching is done by the 
computer.

●● Cutting Operations:  Pattern generated by marker making systems can be 
directed to automated cutting machines which are operated without the help 
of human hands.

●● Marketing Integration Using Computer:  Designer is in direct contact with 
the customer and also the manufacturer to be aware of the latest trends and 
also needs and demands of the customer.

●● Internet And Information Explosion:  NIFT, Calcutta is linked to internet 
with TCP/IP account and students have continuous access to the sites of the 
top designers, trend forecasting agencies, fashion houses and fabric suppliers. 
This has helped both the institute and the students immensely keeping them 
updated with the latest trends.

1.3 � DIFFERENT TOOL USED IN MS WORD 

Word Processing Tools 
Maple contains numerous word processing tools to help you create professional-
looking reports.  For your reference, here is a list of some of the more common ones
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A. Sections and Tables
The fundamental organization of a Maple document is controlled by using sections 
and tables.

Using Sections in a Document
Use sections in your Maple document to:

●● Organize content
●● Hide distracting code or detailed information 
●● To insert a section (or subsection):  Insert > Section.

●● To expand or collapse sections:  View > Sections > Expand All Sections / 
Collapse All Sections

●● To expand or collapse one section:  Click on the arrow beside the section 
name.

●● To organize existing content:  Use the Indent and Outdent toolbar icons to 
shift selected text into a new subsection or out of a subsection level.

●● To delete a section:  Place the cursor in the title and press [Ctrl][Delete] or 
Edit > Delete Element
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Using Tables
Tables can contain text, math, plots, graphics, and embedded components. Use 
tables to:

●● Organize your content effectively, increasing readability and reducing wasted 
space

●● Align text and graphics
●● Control the layout of embedded components

To insert a table: Insert > Table

●● To change table size/column widths:  Click and drag column boundaries.
●● To add or delete rows and columns:  Use the Table menu found in the 

Format menu or through the context panel for the table.
●● To switch between navigation and indentation modes for the Tab 

key:  Use Tab Navigation.

●● To format a table: Format > Table > Properties
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This dialog box allows you to adjust table properties. Options include:
●● Table Size Mode:  There are two options:

Fixed percentage of page width
The width of the table is adjusted whenever the width of the worksheet 

changes. This option is useful for ensuring that the entire content of the table 
always fits onto the screen or printed page.
Scale with zoom factor

Preserves table appearance regardless of the size of the worksheet window or 
the zoom factor by using horizontal scroll when needed. Ensures line breaks occur 
in fixed locations, allowing you to control the breaks in long expressions. With this 
option, the table could be truncated when printing if it is too wide.

●● Set visibility of borders:  As an example, in the previous bullet item a table 
is used to create two columns with the borders set to None.

●● Add table captions:  Use to add a table numbering or titles.  Then, elsewhere 
in the document, you can easily refer to a table using a table cross-reference.

●● Set order of cell execution:  Control the order in which math in the table 
is executed.
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Note: To avoid confusion, ensure execution order is visibly obvious to reader.

B. Document Enhancements

Annotations and Drawing Tools 

Annotations:
You can create annotations that will pop up when a user hovers over the annotated 
text or math.
To create an annotation: 

●● Select the text or math to be annotated.
●● Click on Format > Annotations > Annotate Selection and enter the note.
●● Click outside the entry box to finish entering text. The selection will have a 

colored background indicating the annotation was added.
●● Move your mouse over the selection to see the annotation.

To edit or remove an annotation, place your cursor in the annotated text and from 
the Format menu, choose Annotations > Edit Annotation or Delete Annotation.

C. Drawing Tools and Plot Annotations
●● Using the drawing tools, you can sketch an idea in a canvas, draw on a plot, 

or draw on an image.
●● To draw on a plot, click on the plot, then click on the   button on the toolbar.  

You can add additional information to plots such as text, 2-D math, lines, 
arrows, and shapes. 

●● To create a new drawing, insert a canvas from the Insert menu.
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From the Drawing toolbar, you can use the following tools: selection tool, pencil 
(free style drawing), eraser, text insert, straight line, rectangle, rounded rectangle, 
oval, diamond, alignment, drawing outline, drawing fill, drawing linestyle, and 
drawing canvas properties.
You can hide the gridlines through the drawing canvas properties.

D. Creating Hyperlinks
Hyperlinks in your document can link to:

●● Help topic
●● Different location in current document
●● Other Maple documents
●● Dictionary topic
●● Email
●● Web page (URL)
●● Maplet application

To create a hyperlink:
1.  Highlight the text that you want to make a hyperlink.
2. � From the Format menu, select Convert To > Hyperlink. This option is also 

available in the Context Panel.
3. � Specify the hyperlink Type and Target.  To link to a Maple document, choose 

Worksheet for the Type.
To insert an image hyperlink:
1.  From the Insert menu, select Hyperlink.
2. � In the Hyperlink Properties dialog box, select the Image check box and click 

Choose Image for the file. The image appears as the link. You can resize the 
image as necessary. Click and drag from the corners of the image to resize.

3.  Specify the hyperlink Type and Target.
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●● To view or edit the properties of an existing hyperlink:  With your cursor 
in the hyperlink, select Format > Hyperlinks > Hyperlink Properties.

E. Creating Bookmarks
You can link to a specific location in a Maple document. To do this, you will need 
to create a bookmark.

●● To display bookmark formatting icons, activate the Marker feature: 
View > Markers.

To insert a bookmark:
1. � Place the cursor at the location at which to place the bookmark. For example, 

place the cursor in a section title.
2. � From the Format menu, select Bookmarks. The Bookmark dialog opens, listing 

existing bookmarks in the document.
3. � Click New. The Create Bookmark dialog opens. Enter a bookmark name and 

click Create.
Note: You can also rename and delete bookmarks from the Bookmark dialog.

●● To link to a bookmark:  Follow the steps to create a hyperlink. Enter the 
bookmark target under Bookmark in the Hyperlink Properties.

F. Using Startup Code
The Startup Code region allows you to enter Maple code to be executed every time 
the current document is reopened.

●● Startup code can include loaded packages, defined variables and procedures, 
and any other Maple commands.

●● The commands entered in the Startup Code region do not appear anywhere in 
the Maple document, and can only be accessed by opening the Startup Code 
Editor. This provides you with a cleaner way to generate Maple documents 
with no visible code.

To enter startup code:
1. �From the Edit menu and select Startup Code. Alternatively, click the Edit 

startup code icon in the toolbar. A dialog appears in which you can enter Maple 
commands.
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2. Enter the desired Maple code
3. �When you are finished defining your startup code, and you have checked the 

code for syntax errors, save the code and exit, either select Save from the File 
menu, or click the Save button 

4. �To check that your startup code works as desired, save the current document, 
close it, and then reopen it. You can then check that packages were loaded, 
variables were assigned, and other code was successfully compiled. 

G. Important Tools in Microsoft Word
Microsoft Word offers many additional tricks for writers to speed and facilitate 
our craft. In this series of articles, I'll present a few of these features, and perhaps 
take you beyond your normal usage of this premier writer's aid, including crafting 
manuscript submission templates and easy tools for collaboration and tracking 
changes. But before we get there, we have to start with the basics.

The following five tools are some of the most basic in Word, and you may 
already use them. But they offer much to the writer, so be sure to check out my 
"bonus points" section for each item. These notes offer further tips and tricks, and 
you might be surprised at the additional depth these simple tools offer! Knowing 
these tricks will enable you to improve your writing, your editing, and eventually, 
your bottom line!

1. Auto Correct

Obviously, Spell Checker is a key feature of Word, and everyone knows how to 
use it, right? But a subsidiary of Spellchecker is Auto Correct, and it can speed 
your writing by correcting your “usual” misspellings without forcing you to run 
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Spellchecker. More importantly, you can program it to overcome your standard 
mistakes, and others can be switched on by checking the appropriate rule boxes on 
the Auto Correct tab! These "built in" rules include automatically correcting any 
word that starts with two capital letters, capitalizing the first letter of a sentence, 
and automatically changing any accidental use of the caps lock key.

More importantly, though, if you have some standard misspellings that you 
frequently trip over, you can also add these words to the Auto Correct function, 
and you'll never have to correct them by hand again – or even see them. Auto 
Correct will fix them as you type!

●● Here's How:  Click the Tools Menu. Choose Auto Correct. Choose the Auto 
Correct tab (if not already selected.) Check any boxes for rules you want to 
automatically include. To add your commonly misspelled words, be certain 
the "Replace Text as you Type" rule is checked, and then type the misspelled 
word in the open record under "Replace." Add the correct spelling in the open 
record under "with."  Then click "Add." Be certain the box for "automatically use 
suggestions from spell checker" is checked. Repeat as many times as you need 
to get all your frequently misspelled words into the Auto Correct dictionary.

●● Bonus points:  Some writing requires the use of certain words that might be 
long, or technical in nature, but requires repeating them. With autocorrect, 
you can give these words a two or three letter code word, and then each time 
you enter it, Auto Correct change it to the full word! That's a real time saver!

●● Additional bonus points:  Fine tuning Word. Many publishers often ask 
writers to make certain they are using "straight quotes," since these are often 
translated as an unrecognized letter online or via a Mac. Simply click the tab 
marked "auto formatting as you type" and uncheck the appropriate boxes! The 
same is true if you want to stop unwanted auto formatting changes, like lines 
beginning with numbers triggering an indentation and a numbered list. When 
you are finished, simply click "OK" and you're set!

H. Undo 
Again, this is another common feature of Word that everyone knows – but be 
aware there are a few different ways to use it, with some powerful traits! It is 
found under the Edit menu, though most people I know use the toolbar button (a 
bent left arrow). This will undo a single action – though the shortcut "CTRL+Z" 
achieves the same thing, without pausing your typing. But many people do not 
realize that you use "Undo" to reverse multiple actions at once, or choose a specific 
previous action to undo!

●● Here's How: On the toolbar, there is a "look in" arrow to the right of the 
Undo button. (A black triangle pointing down.) Click it to open, and then slide 
your mouse down the list. This list will highlight, and clicking the bar at the 
bottom of the list (which reads "undo x actions" depending how many you've 
highlighted) will undo the listed number of actions, at once! Right now, I could 
undo 216 actions – which would take me back to the title of this chapter!

This is a powerful feature that can save lots of time, since in editing an article, you 
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can often backtrack to a place you chose the wrong path!  You can also use it to find 
a specific action you performed earlier, and undo that single item. Or, for example, 
you can wipe out a group of edits you made that you decided you really didn't like, 
while keeping all the more recent changes you did like!

Bonus Points: The sister button "Redo" becomes a lifesaver as well, allowing you 
to put a change back when you realize you liked the previous change after all!

I. Fast Highlighting 
In Word, we select the text we want to move or format or delete by "hightlighting" 
it. Better yet, in Word, as everyone knows, we can drag and drop this highlighted 
text by clicking on it and holding the mouse button while we move the mouse 
pointer to a new position. This feature allows us to rearrange paragraphs in an 
article quickly, and is a real boon to writers. But many people seem to have great 
difficulty highlighting just the right amount of text! Problems generally arise with 
a speedy zip through the entire article when you reach the edge of the page.
There are many easy "workarounds" for this common problem.

●● The 1-2-3 click: In Word, a click on a word highlights that single word. A second 
click on the same word highlights the line, and a third click will highlight the 
entire paragraph! With this, dragging and dropping a paragraph is a snap! 

●● The Shift Method: Another easy way is to select exactly the right amount 
of text: single click your mouse at the start of the text you want to highlight, 
placing your insertion point there. Then use the scroll bar, (or the page down 
feature, or the cursor arrows,) to reach the end of the piece of text you want 
highlighted. If you hold down your SHIFT key as you single click the mouse 
at the end of the text in question, the entire text between the two points will 
be highlighted.

●● Additional Bonus Points: You likely already know you can select an entire 
line by moving your mouse into the margin, and clicking in front of the line 
you want to highlight. If you hold the mouse button down, and drag the mouse 
down, you'll continue to highlight additional lines.

J. Find and Replace
This is another simple feature that everyone knows, but realize it can do more 
than you might think! 
Word allows you to search for non-printing characters as well as letters and words! 
Found you put in a tabs when you shouldn't have? Looking to get rid of fields, or 
page breaks, or other non-standard items? Find and Replace has you covered!

●● Here's How: Under the Edit menu, click Replace. When the new window 
opens, click the "More" button if it is showing. This opens more options, and 
one of them is a "Special" button. Opening this gives us all the non-printing 
characters we can use. Then decide what you'd like to  replace them with – 
which again, could be another "special" feature, a space – or even nothing! 
(The special button also offers options to find a range of letters or numbers, 
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and many other special search qualities as well. Check it out!)
●● Also:  If you are looking to replace a Word or a Character, it is always good 

to "test drive" the change with a "find next" rather than the "replace" or the 
"replace all" button. Also remember that unless you use leading or trailing 
blank spaces, it will find your text anywhere, including inside another word!
Still, this is a wonderful feature for any author that has over used a noun or 
verb, or more importantly, someone who has changed the name of a character 
when they were pages into a story. Find and Replace will find every previous 
use of the name, and replace it with the new name. Very fast, and greatly 
appreciated!

●● Special Bonus Points:  Ever find you spelled your character's name a variety 
of ways in your story? Find and Replace can fix that in a flash! Clicking on the 
Use Wildcards option allow you to spell the name with placeholders in certain 
spaces, in case you sometimes used an 'o' and sometimes an 'e' for example. The 
question mark and the asterisk are the two common wildcards.  Thus, using 
Anders?n in Find or Replace would bring back Anderson or Andersen. (It would 
also find Andersin, or any other word that matched all the other letters.) This is 
very handy, but what if you changed the name drastically halfway through the 
draft story, perhaps from "Anderson" to Andropolous? Worst yet, you frequently 
spelled  the new name a number of different ways? "And*" would find every 
word that began with "And" in your story (but it would not find "and" since it 
is looking for an uppercase A, unless your "match case" box has been cleared.)

K. The Thesaurus 
This is the last of the basic features in Word for this chapter, and I'll only mention 
it briefly, since I suspect many people here are well versed in its use. The program 
allows users to find substitute words, which can be a godsend for some of us! 
(Nothing worse than coming to a screeching halt because you can't think of the 
right word!)

●● Here's How:  The process is very simple: place your insertion point in the 
word in question, and do a Shift+F7 (that's the function key F7, not the F 
key and the 7 key!) The Thesaurus window will open, and you can chose your 
replacement word – and that's all there is to it!
I used the shortcut keys since opening the Thesaurus is a three step process 
otherwise:  Click on the Tools Menu, go to Language, then on the additional 
menu, and choose Thesaurus. Then make your word choices. (Again, make 
certain your insertion point is in the word you want to replace – or have it 
highlighted. Otherwise, you won't get the right option!)

●● Additional Method:  You can find additional replacement words even faster 
if you 'right-click' on the word you want to change. This will give you a menu 
list, and one option near the bottom  is synonyms. When you place your mouse 
on it, it will give a list of similar words. To replace your current word, simply 
click on the new one you'd rather use. If you don't like the choices, the bottom 
choice on the synonym  menu will offer to open the Thesaurus as well.
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●● Bonus Points: Since some words can be nouns or verbs, the choices may 
not always match. If that happens to you, in the Thesaurus choose one of the 
words that more closely matches your meaning in the left hand box, and click 
the "look up" button instead of "replace." You'll then get a list of new options 
based on this choice.

These five tools are all very simple, but they offer writers a fast option to overcome 
potential time wasters. These quick fixes allow the writer to stay in the flow of the 
article, which is very important, since any distraction that takes your mind out of 
the process can result in a big delay – or perhaps even threaten the completion of 
a particularly tough article!

Now that we've covered the basics will draw attention to some of the wonderful 
higher end features of Word, including how to make your own submission template, 
complete with special formatting, headers and page numbers.

1. � Microsoft Word Toolbars, ScreenTips and Toolbar 
Buttons

a. The Toolbar

A toolbar is a bar containing buttons and options that you use to carry out 
commands. With toolbars, commands become just handy and easily accessible to 
users. The buttons contained in them are used to access commands more quickly 
than by opening the menus and the respective dialog boxes.

b. ScreenTips

The toolbars contain smart icons serving as shortcuts to the main menu commands. 
However, these toolbars offer too many buttons of various looks and shapes for a 
user to easily remember their names or their functions. You might well ask: 'What 
is the use of a toolbar button if its name or function is not known?' Well, the ever-
creative programmers at Microsoft also once contemplated this problem. So they 
fashioned a tool known as ScreenTip. 

ScreenTips, also known as Tooltips, are little pop-up descriptions that appear 
when you rest the mouse pointer over a toolbar button. They appear on the screen 
to provide certain information about a toolbar button, tracked change, or comment 
or to display a footnote or endnote.

So, any time you are at a loss as to the name or use of a toolbar button, simply 
rest the mouse pointer over such button and immediately, you'll see a little text 
pop-up below the pointer, saying something. This is a ScreenTip or ToolTip.

In case the ScreenTips don't appear when you move the pointer over a button, 
it is possible the feature has been disabled/turned off. You can turn it on by doing 
the following:
1.  On the Tools menu, click Options and then click the View tab.
2.  Under Show, select the ScreenTips check box.
That's all. Those are the steps you'll also take to deactivate the feature, for one 
reason or another, though not advisable.
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2.  How to Display/invoke a (Missing) Toolbar 
Suppose a toolbar you need very much to hasten your work (e.g., the Formatting 
Toolbar) is not currently visible on screen, what would you do to invoke such 
'missing' or 'hiding' toolbar from its hiding place? Well, anytime you face a situation 
like this, simply use any of the following methods to bail yourself out. 
Displaying A Toolbar Using the View Menu 
1.  On the Menu bar, click View. This displays the View menu.
2.  Then, on the View menu, point to Toolbars item.
This now displays the Toolbars sub-menu, in which the names of certain toolbars 
are shown. Here, you'll find that some of the toolbar names have a check mark 
to the left of them, while some have none. The check mark indicates the toolbar 
bearing it is already displayed on screen. 
3.�Select and click the name of the desired toolbar from the Toolbars sub-menu.The 

toolbar you selected will then appear on screen.

Figure:1.1 Showing or hiding a toolbar using the View menu
Those are the steps you'll also follow to hide a toolbar you no longer want on screen 
at a particular moment.
NOTE: If you can't find the particular toolbar you are really looking for on the 
Toolbars sub-menu, click Customize, and then click the Toolbars tab in the 
Customize dialog box that appears. In the Toolbars list, click the checkbox next to 
the name of the toolbar you want and then click Close. 
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Figure:1.2 Showing or hiding a toolbar using the Customize dialog box

3.  To Display a Desired Toolbar Using a Shortcut
Simply right-click an empty space on any toolbar, and then click the name of 
toolbar you want.
TIP:  If you do not see the toolbar you're looking for on the shortcut menu, click 
the Toolbar Options arrow, point to Add or Remove Buttons, click Customize, click 
the Toolbars tab in the Customize dialog box, and then, in the toolbars list, click 
the checkbox next to the toolbar you want and click Close when you are through.

Figure:1.3 Displaying the Customize dialog box via the Toolbar Options 
button

At this juncture, I'm quite confident to a reasonable extent that how to determine 
the name of any toolbar button/icon should never be a problem to you, since the 
ScreenTips are there to "tell-tale". Right now, your problem, I guess, should be: 
"What exactly is the function of each of these toolbar buttons/icons?" Well, if you 
have asked that question, it simply shows you are bright and ready to learn. 
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The good news is, you are not helpless: I have dedicated the following sections to 
expatiate a little on the Standard toolbar, Formatting toolbar, and the Drawing 
toolbar, since you will be using them constantly.

Standard Toolbar 
You have learned that the Standard toolbar is, by default, docked directly below 
the Menu bar, and that it contains buttons used for performing tasks similar to 
the commands available in the Menu bar. Let's now take a moment to identify the 
name and purpose/use of each of the buttons on the Standard toolbar.
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Formatting Toolbar
The Formatting toolbar offers shortcut buttons to help format a document 

quickly. From the Formatting toolbar, you can quickly apply formatting attributes 
such as Font; Font Color; Alignment; Line Spacing; Bullets and Numbering, etc, 
document text, to save time.
The following table provides a list of Formatting toolbar buttons and a brief 
description of each. 
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Drawing Toolbar
The Drawing toolbar is located at the bottom of the window, between the Horizontal 
Scroll bar and the Status bar. Like every other toolbar, this also contains smart 
icons representing shortcuts to Main menu commands in Word.

It holds buttons/tools used in creating drwaings, such as rectangles, ovals, 
lines, arrows, WordArt text, etc. It also offers tools for inserting organizational 
charts and ready-made pictures and Clip Arts from their different locations.

Also included in this toolbar are tools for formatting inserted objects and for 
adding special effects such as shadow or 3-D to lines, rectangles, ovals, etc. Like 
every other toolbar also, the Drawing toolbar can be displayed or hidden.

The following table shows a list of tools offered on the Drawing toolbar, and 
their functions: 
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1.4 � STUDY AND APPLICATION OF DIFFERENT 
TOOLS USED IN MS EXCEL

A. Uses of Microsoft Excel 

1. Analyzing and storing data

One of the best uses of MS Excel is that you can analyze larger amounts of data to 
discover trends. With the help of graphs and charts, you can summarize the data 
and store it in an organized way so that whenever you want to see that data then 
you can easily see it. It becomes easier for you to store data and it will definitely 
save a lot of time for you.

Once the data is stored in a systematic way, it can be used easily for multiple 
purposes. MS Excel makes it easier to implement various operations on the data 
through various tools that it possesses.

2. Excel tools make your work easier

There are so many tools of MS Excel that make your work extremely easy and save 
your time as well. There are wonderful tools for sorting, filtering and searching 
which all the more make you work easy. If you will combine these tools with 
tables, pivot tables etc. then you will be able to finish your work in much less time. 
Multiple elements can be searched easily from large amounts of data to help solve 
a lot of problems and questions.

3. Data recovery and spreadsheets

Another best use of MS Excel is that if your data gets lost then you can recover it 
without much inconvenience. Suppose, there is a businessman who has stored his 
important data in MS Excel and somehow it gets lost or the file gets damaged then 
he must not worry as with the new MS Excel XML format one can restore the lost 
or damaged file data.

The next important use is that there are spreadsheets in MS Excel which also 
makes your work easy and with the help of new Microsoft MS Excel XML format 
you can reduce the size of the spreadsheet and make things compact easily.

4. Mathematical formulas of MS Excel make things easier

Next best use of MS Excel is that it makes easy for you to solve complex 
mathematical problems in a much simpler way without much manual effort. There 
are so many formulas in MS Excel and by using these formulas you can implement 
lots of operations like finding sum, average, etc. on a large amount of data all 
at once. Therefore, people use MS Excel whenever they have to solve complex 
mathematical problems or they need to apply simple mathematical functions on 
tables containing larger data.

5. Security

The chief use of MS Excel is that it provides security for excel files so people can 
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keep their files safe. All the files of MS Excel can be kept password-protected 
through visual basic programming or directly within the excel file. People store 
their important data in the MS Excel so that they can keep their data in an 
organized way and save their time as well. Almost every person wants his files to 
be password protected so that no one is able to see them or ruin them so here MS 
Excel solves this problem very efficiently.

6. Add sophistication to data presentations

Next use of MS Excel is that it helps you in adding more sophistication to your 
data presentations which means that you can improve the data bars, you can 
highlight any specific items that you want to highlight and make your data much 
more presentable easily.

Suppose you have stored data in MS Excel and you want to highlight something 
that is important so then you can do that through the various features of data 
presentations available in MS Excel. You can even make the spreadsheets more 
attractive on which you have stored data.

7. Online access

Another use of MS Excel is that it can be accessed online from anywhere and 
everywhere which means that you can access it from any device and from any 
location whenever you want. It provides the facility of working conveniently which 
means that if you don’t have laptops then you can use mobile and do your work 
easily without any problem. Therefore, due to the large amount of flexibility that 
MS Excel provides, people like to work on MS Excel so that they can comfortably 
work without worrying about their device or location.

8. Keeps data combined at one location

Another interesting use of MS Excel is that you can keep all your data at one 
location. This will help you in saving your data from getting lost. It will keep all 
your data in one place and then you will not have to waste your time in searching 
for the files. So it will save your time and whenever need be, you can look up the 
categorized and sorted data easily.

9. �Helps businessmen in developing future strategy

You can represent data in the form of charts and graphs so it can help in identifying 
different trends. With the help of MS Excel, trend lines can be extended beyond 
graph and therefore, it helps one in analyzing the trends and patterns much easier. 
In business, it is very important to analyze the popularity of goods or the selling 
pattern that they follow to maximize sales. MS Excel simplifies this task and helps 
businessmen grow and maximize profits through the same.

10. �Manage expenses

MS Excel helps in managing expenses. Suppose if a doctor is earning around 
50,000 per month then he will make some expenses as well and if he wants to 
know how much he is exactly spending per month then he can do it with the help 
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of MS Excel easily. He can write his monthly income as well as expenses in the 
excel tables and then he can get to know that how much he is spending and he can 
thus, control his expenses accordingly.

There are a lot of benefits of using MS Excel, which is why it is used worldwide 
by people for performing so many tasks. It not only saves time but also it makes 
the work easier. It can almost perform every type of task. For example, you can 
do mathematical calculations and you can also make graphs as well as charts for 
storing the data. It becomes easy for the businessman to calculate things and store 
data in it.

You can store a large amount of data in the MS Excel and analyze it as well. It 
helps in keeping the data combined in one place so that data does not get lost and 
one does not waste time in finding a particular data. Due to these factors, it has 
become such a popular software and we have become habitual of using it.

B.  Working in Excel 
Microsoft® Office contains a variety of tools that help people accomplish many 
personal and professional objectives. Microsoft Excel is perhaps the most versatile 
and widely used of all the Office applications. No matter which career path you 
choose, you will likely need to use Excel to accomplish your professional objectives, 
some of which may occur daily. 

This chapter provides an overview of the Excel application along with an 
orientation for accessing the commands and features of an Excel workbook. Taking 
a very simple view, Excel is a tool that allows you to enter quantitative data into 
an electronic spreadsheet to apply one or many mathematical computations. These 
computations ultimately convert that quantitative data into information. 

The information produced in Excel can be used to make decisions in both 
professional and personal contexts. For example, employees can use Excel to 
determine how much inventory to buy for a clothing retailer, how much medication 
to administer to a patient, or how much money to spend to stay within a budget. 
With respect to personal decisions, you can use Excel to determine how much 
money you can spend on a house, how much you can spend on car lease payments, 
or how much you need to save to reach your retirement goals. We will demonstrate 
how you can use Excel to make these decisions and many more throughout this 
text.

Figure below shows a completed Excel worksheet that will be constructed 
in this chapter. The information shown in this worksheet is top-line sales data 
for a hypothetical merchandise retail company. The worksheet data can help 
this retailer determine the number of salespeople needed for each month, how 
much inventory is needed to satisfy sales, and what types of products should be 
purchased.
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Figure :1.4 Example of an Excel Worksheet

Starting Excel 
1.  Locate Excel on your computer.
2. � Click Microsoft Excel to launch the Excel application and present you with 

workbook options.
3.  Click the first option; “Blank Workbook”.
1. The Excel Workbook 
Once Excel is started, a blank workbook will open on your screen. A workbook is an 
Excel file that contains one or more worksheets (sometimes referred to as spread-
sheets). Excel will assign a file name to the workbook, such as Book1, Book2, 
Book3, and so on, depending on how many new workbooks are opened. A blank 
workbook after starting Excel. Take some time to familiarize yourself with this 
screen. Your screen may be slightly different based on the version you’re using.

Figure :1.5 Blank Workbook
Your workbook should already be maximized (or shown at full size) once Excel 
is started, as shown in Figure above. If necessary locate the Maximize button as 
shown in Figure below. 
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Figure:1.6 Restored Worksheet

2. Navigating Worksheets 

Data are entered and managed in an Excel worksheet. The worksheet contains 
several rectangles called cells for entering numeric and nonnumeric data. Each 
cell in an Excel worksheet contains an address, which is defined by a column letter 
followed by a row number. For example, the cell that is currently activated in 
Figure above is A1. This would be referred to as cell location A1 or cell reference 
A1. The following steps explain how you can navigate in an Excel worksheet:
1.  Place your mouse pointer over cell D5 and left click.
2. � Check to make sure column letter D and row number 5 are highlighted, as 

shown in Figure below.
Note: � Your highlighted column letter and row number may be different than 

figure shown.

Figure :1.7 Activating a Cell Location 
1.  Move the mouse pointer to cell A1.
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2. � Click and hold the left mouse button and drag the mouse pointer back to cell 
D5.

3. � Release the left mouse button. You should see several cells highlighted, as 
shown in Figure below.

This is referred to as a cell range and is documented as follows: A1:D5. Any two 
cell locations separated by a colon are known as a cell range. The first cell is the 
top left corner of the range, and the second cell is the lower right corner of the 
range. 

Figure :1.8 Highlighting a Range of Cells
1. � At the bottom of the screen, you’ll see worksheets. Depending on your version 

of Excel, you will see either three as displayed above or just one. If you only 
have one sheet, click the “Insert Worksheet” to add a worksheet. Depending on 
your version, you instead may have a + sign; a click on the + adds an additional 
worksheet as well. This is how you open or add a worksheet within a workbook. 
Add another worksheet so that you now have three sheets displaying here.

2. � Click the Sheet1 worksheet tab at the bottom of the worksheet to return to the 
worksheet shown in Figure above.

3. The Excel Ribbon 
Excel’s features and commands are found in the Ribbon, which is the upper area 
of the Excel screen that contains several tabs running across the top. Each tab 
provides access to a different set of Excel commands. Figure below shows the 
commands available in the Home tab of the Ribbon. Table below “Command 
Overview for Each Tab of the Ribbon” provides an overview of the commands 
that are found in each tab of the Ribbon.
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Figure :1.9 Home Tab of Ribbon

Table : Command Overview for Each Tab of the Ribbon
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The Ribbon shown in Figure above is full, or maximized. The benefit of having 
a full Ribbon is that the commands are always visible while you are developing a 
worksheet. However, depending on the screen dimensions of your computer, you 
may find that the Ribbon takes up too much vertical space on your worksheet. 
If this is the case, you can minimize the Ribbon by clicking the button shown in 
Figure above. When minimized, the Ribbon will show only the tabs and not the 
command buttons. When you click on a tab, the command buttons will appear 
until you select a command or click anywhere on your worksheet.

Quick Access Toolbar and Right-Click Menu 

The Quick Access Toolbar is found at the upper left side of the Excel screen above 
the Ribbon, as shown in Figure below. This area provides access to the most 
frequently used commands, such as Save and Undo. You also can customize the 
Quick Access Toolbar by adding commands that you use on a regular basis. By 
placing these commands in the Quick Access Toolbar, you do not have to navigate 
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through the Ribbon to find them. To customize the Quick Access Toolbar, click the 
down arrow as shown in Figure below. This will open a menu of commands that 
you can add to the Quick Access Toolbar. If you do not see the command you are 
looking for on the list, select the More Commands option.

Figure :1.10 Customizing the Quick Access Toolbar
In addition to the Ribbon and Quick Access Toolbar, you can also access commands 
by right clicking anywhere on the worksheet. Figure below shows an example of 
the commands available in the right-click menu.

Figure :1.11 Right-Click Menu 

4. The File Tab 
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The File tab is also known as the Backstage view of the workbook. It contains 
a variety of features and commands related to the workbook that is currently 
open, new workbooks, or workbooks stored in other locations on your computer 
or network. Figure below shows the options available in the File tab or Backstage 
view. To leave the Backstage view and return to the worksheet, click the arrow in 
the upper left-hand corner as shown below.

Figure :1.12 File Tab or Backstage View of a Workbook 
Included in the File tab are the default settings for the Excel application that can 
be accessed and modified by clicking the Options button. Figure below shows the 
Excel Options window, which gives you access to settings such as the default font 
style, font size, and the number of worksheets that appear in new workbooks.

Figure :1.13 Excel Options Window 

5. Saving Workbooks (Save As)

Once you create a new workbook, you will need to change the file name and 
choose a location on your computer or network to save that file. It is important to 
remember where you save this workbook on your computer or network as you will 
be using this file. The process of saving can be different with different versions of 
Excel.  Please be sure you follow the steps for the version of Excel you are using. 
The following steps explain how to save a new workbook and assign it a file name.
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C.  Costing sheet in Excel
Each type of the product has different specifics and therefore a different Costing 
table. Each one has essential elements that you don’t want to miss. We prepared 
some visual examples to help you create a detailed and easy-to-read Costing Table 
in Techpacker for your particular product.

The number of details always depends on the complexity of the garments. 
To calculate the final cost of the garment you will need to clearly specify each 
piece that goes into making. For example: main fabric, lining, interfacing, trims, 
buttons, zippers, embellishments, appliques, etc. All of these details have to be 
included in the Costing Table. Quantities of each item must be listed, ideally on 
another column to make the visualization and calculation easier.

There are parts that are commonly used for all types of products. Things like 
tags, labels, sewing thread, packaging materials will be a part of any Costing Table 
no matter what type of product you are creating. So make sure to add those too.

Tip: Add supplier’s name to every material that goes into your Costing Table, 
that will save you time in future if you run out of any of the parts and will need to 
order more. Tracking the status of each order is useful too - whether it’s in stock 
or needs to be placed on the backorder.

1. Tops 

Let’s start with the example of a Costing Table for a shirt. In our example it is a 
mens shirt with a button up closure. Like for any other kind of shirt the essential 
element will be the main fabric, interfacing for the collar, collar stand and cuffs, 
thread and of course buttons for the placket, pockets and cuffs. As you can see all 
of those elements are added to our Costing Table. 

Figure :1.14. Straight cut full sleeve shirt Tech pack
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Figure :1.15 Costing sheet example of the Shirt

2. Bottoms

There are various types of bottoms that can be made, like tailored pants, elastic 
waistband pants, leggings, denim pants, etc. The number of details depends on the 
complexity. Our example is a pair of denim pants. Apart from essential elements 
like main fabric, thread, zippers, buttons don’t forget to include the metal rivets 
and the contrasting orange thread that distinguishes a pair of jeans from a pair of 
classic pants.

Fitted 		 Denim 	 jeans 	   Tech 	 pack	   cover 	 page
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Figure :1.16 Denim costing sheet example

3. Dresses

Whether you are creating a casual dress or a special occasion one the number 
details depends on the style you are making. Our next example is a casual wrap 
dress made with knit jersey fabric. This style features a waist tie belt therefore 
the buttons or any other types of closure are missing. For this dress the essentials 
elements that we put in the Costing Sheet will be the main fabric, thread, fusible 
interfacing and the packing supplies. You will be able to calculate the needed 
amount of the main fabric at the Sample Making stage of your product development.

		



MS Office

NOTES

Self-Instructional Material  39

4. Jumpsuits

Complex styles like jumpsuits usually have more parts like additional zippers, 
buttons and other closures. Our example here also has a decorative detail - white 
crochet lace.

5. Outerwear

Outerwear is technically the most time consuming piece of clothing to make. It 
is often fully lined and needs a certain type of interfacing to keep its shape.  For 
example, if you are going for a tailored, more structured look you may wish to 
choose a woven fusible hair canvas. If you are going for a softer look then you 
might choose a woven non-fusible midweight interfacing. 
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6. Swimwear

Although swimwear doesn’t seem to have as many parts as other types of clothing 
it has certain specifics that are different. Swimwear and activewear fabrics are 
mostly made of a special type of fabric which is stretchy and doesn’t absorb water, 
usually it is nylon that has a significant amount of Lycra or spandex. Please note 
that womens swimsuits often have bra cups, if your style has those don’t forget to 
add those to your Costing Sheet. 
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7. Handbags

Costing sheets for handbags and other accessories are slightly different from the 
clothing ones, they also require different types of machines to manufacture them. 
The leather used to make a handbag is often heavier than for the clothing, lining 
is more durable and the hardware is specific to this type of product. It may include 
sliders, metal rivets, internal wire frames to make a specific form, rings, metal 
labels, locks, screws, chains, clips or snap closures. 

8. Sportswear

The main difference of the sportswear from the casual clothing is the type of fabric 
you use. Make sure it has a lot of stretch to it to allow easy moving. The thread is 
different too. Most sports tops include the bra cups for comfortable fit. If you are 
planning to add lining make sure to add its cost to your table.

In Techpacker you can calculate the total price per piece as well as the total 
price for the whole order. In our Costing Sheet for the leggings we calculate the 
total cost of one pair.



Computer 
Application 

in Apparel & 
Textile

NOTES

42  Self-Instructional Material

9. Lingerie

Usually lingerie consists of many little details like elastics, underwires, hooks & 
eyes, knit interfacing, ribbons and lace for decorations, hardware for adjusting 
straps and stretchy main fabric. Your final cost will depend on how many parts 
you are including, so make sure to add the correct quantity and final cost for each 
one.
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10. Kids Clothing

The Costing Table for the kids clothing will be very similar to the grown ups 
clothing. However, some brands would stand out by creating a high quality kids 
product by for example, making it with flame resistant fabric or using snaps over 
buttons to decrease the risk of swallowing.

11. Home Goods

Dreaming of creating your own bedding? No problem! Include the type and cost 
of the main fabric (the most common for bedding are cotton, linen or silk), lining 
(optional) and the closures like zippers or buttons. And don’t forget the labels and 
packaging.
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Excel Charts and Design Tools
Chart tools comprise of two tabs Design and Format.
Step 1 − �When you click on a chart, Chart Tools comprising of Design and 

Format tabs appear on the Ribbon.

Step 2 − �Click the Design tab on the Ribbon. The Ribbon changes to the Design 
commands.
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In this chapter, you will understand the design commands on the Ribbon. 

12. Add Chart Element
Add Chart Element is the same as chart elements.
Step 1 − �Click Add Chart Element. The chart elements appear in the drop-down 

list. These are same as those in the chart elements list.
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13. Quick Layout

You can use Quick Layout to change the overall layout of the chart quickly by 
choosing one of the predefined layout options.
Step 1 − �On the Ribbon, click Quick Layout. Different predefined layout options 

will be displayed. 

Step 2 − �Move the pointer across the predefined layout options. The chart layout 
changes dynamically to the particular option.

Step 3 − �Select the layout you want. The chart will be displayed with the chosen 
layout.

14. Change Colors

The functions of Change Colors are the same as Chart Styles → COLOR.
Step 1 − �On the Ribbon, click Change Colors. The color schemes appear in the 

drop-down list. These are the same as that appear in Change Styles → 
COLOR.
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15. Chart Styles

The Chart Styles command is the same as Chart Styles → STYLE.

16. Switch Row/Column 

You can use Switch Row/Column to change the data being displayed on X-axis to 
be displayed on Y-axis and vice versa.

Click Switch Row / Column. The data will be swapped between X-axis and Y-axis 
on the chart. 

17. Select Data

You can use Select Data to change the data range included in the chart.
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Step 1 − Click Select Data. A Select Data Source window appears.

This window is the same as that appears with Chart Styles → Select data.

Step 2 − Select the chart data range in the select data source window.
Step 3 − �Select the data that you want to display on your chart form the Excel 

worksheet.
18. Change Chart Type 

You can use the Change Chart Type button to change your chart to a different 
chart type.
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Step 1 − �Click Change Chart Type. A Change Chart Type window appears.

Step 2 − Select the chart type you want.
Your chart will be displayed with the chart type you want.

20. Move Chart
You can use Move Chart to move the chart to another worksheet in the workbook.
Step 1 − Click the Move Chart command button. A Move Chart window appears.

Step 2 − �Select New Sheet. Type the name of the new sheet. 
The chart moves from the existing sheet to the new sheet. 

1.5  STUDENT ACTIVITY 

1.	� What is Textile Design Systems? Explain the Apparel Industry And 
Computer?

	 ...........................................................................................................................
	 ...........................................................................................................................
	 ...........................................................................................................................
2. 	� What is Important Tools in Microsoft Word? Explain the future and improve 

Microsoft Word Toolbars, ScreenTips and Toolbar Buttons?
	 ...........................................................................................................................
	 ...........................................................................................................................
	 ...........................................................................................................................
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1.6 � STUDY AND APPLICATION OF DIFFERENT 
TOOLS USED IN MS PAINT

Microsoft Paint, also called MS Paint or simply Paint is a computer program made 
by Microsoft. It allows people to create picture files as well as edit picture files 
saved on their computer. Microsoft Paint is also a program for adding texts to 
images saved on a computer. There are various tools to help people edit photos, 
including:

●● the paint bucket
●● pencils
●● spray can
●● eraser
●● line and curved line tools
●● multiple shape tools
●● text tool
●● cut out tool

The program has a color palette displayed on the bottom left of the screen, as well 
as an "Edit Colors..." menu, allowing users to create all the shades they need.

Using the selection tools (the 2 tools at the top if the tools bar), users can select all 
or part of an image and then cut, copy, delete and paste it.

Many digital artists or editors prefer programs like Photoshop, but many on a 
tighter budget or with less time on their hands use Paint. Because of this, there 
are many Internet tutorials to help enhance the creative skill of every Microsoft 
Painter.

A.  MS Painting Tools Functions
Microsoft Paint is a basic computer graphics program found on most personal 
computers using a Windows operating system. Images created within MS Paint 
are typically saved as GIF, Windows bitmap, PNG, TIFF or JPEG files. Originally, 
MS Paint only allowed users to create black and white images, but now users can 
paint in a full array of colors with simple, user friendly tools.

1. Select

The "Select" tools look like a star or rectangle outlined with hashed lines. The star 
shape is the "Free-Form Select" tool that allows you to select part of a picture that 
is any shape. The button with the image of a rectangle lets you select a rectangular 
area within an image.

2. Eraser

Under the star "Select" tool is the "Eraser" tool. This allows you to erase small areas 
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of the image by dragging the mouse pointer over the part you wish to eliminate.

3. Fill Tool

The "Fill Tool" looks like a jar that has paint spilling out of it. When you select an 
area of your image with the left mouse button, the foreground color will fill with 
a color. When you select an area of your image with the right mouse button, the 
background of the image will fill with a color.

4. Pick Color

The button with the image of an eyedropper is the "Pick Color" tool. This allows 
you select an object whose color you want to copy and use the color elsewhere in 
the image.

5. Magnifier

Next to the "Pick Color" button is the "Magnifier" button, which looks like a 
magnifying glass. Selecting this tool will allow you to zoom in an out of an image.

6. Pencil and Brush

The button with an image of a pencil in it is the "Free-Form Line" tool. It allows 
you to draw lines by clicking and dragging your computer mouse.
The image of the paintbrush next to the image of the pencil is the "Brush" tool. Use 
this to brush a thick line on your image with different brush shapes.

7. Airbrush

The "Airbrush" tool's button has the image of a paint can in it. This tool allows you 
to "spray" an area of your image with a color of your choice.

8. Text 

The "Text" tool is next to the image of the paint can, and has the letter "A" on it. 
Use this to type text directly onto your picture.

9. Line and Curve

The "Line" button has the image of a diagonal line in it. Use this tool to draw 
straight lines in your picture.
To draw a curve, click on the button with the image of a curvy line in it. The 
"Curve" tool allows you to draw a line with one or two arcs in it.

10. Rectangle

The "Rectangle" tool has an image of a rectangle drawn with a solid line on the 
button. Use this tool to draw rectangles in your picture.

11. Polygon

The "Polygon" tool is next to the "Rectangle" tool. This tool allows you to make 
several lines at different angles to form the shape of a polygon.

12. Ellipse and Rounded Rectangle
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The bottom left tool with the shape of an oval in it is the "Ellipse" tool. Make circles 
and ovals by selecting this tool and dragging the computer mouse diagonally after 
clicking on a place in your image.

Draw a rectangle with rounded corners by selecting the last tool in MS Paint. 
Use the "Rounded Rectangle" tool in the same manner you would the "Ellipse" tool.

B.  MS Paint Window

	

1. Editing Photos Using Paint

Apart from creating new drawings, Paint can also be used for editing pictures. 
It can be an important program for writers who want to edit pictures to use for 
illustrating purposes in their articles. For example, I capture screenshots using 
the print screen and paste them on the MS Paint window. Then, from there, I 
modify them before using them for my articles.

The drawings you make can be printed, e-mailed to your friends, used as a 
desktop background, copied to another document, sold for a profit, and a variety 
of other uses. 

2. How MS Paint Can Be Used to Edit an Image
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Figure :1.17 MS Paint Tool Box 

3. Starting MS Paint

To start the Paint program:
●● Click on start
●● All programs
●● Accessories
●● Paint

The MS Paint Window Features
Note: �If you are using Windows 7 or other advanced operating systems, you will 

find a much more improved MS Paint Program. 
At the very top, we have the title bar written untitled – Paint. Once you save your 
file, the name untitled will be replaced by the name you are going to assign your 
drawing.

4. Menu Bar

It consists of the following menus:
1.	� File menu – this is for creating a new file, saving, printing, setting as 

desktop background, etc.
2.	� Edit menu – For undoing, redoing, copying, pasting, etc.
3.	� View menu – For displaying toolbox, colour box, status bar, text toolbar, 

zooming and viewing bitmap.
4.	� Image – This menu is used for flipping, stretching, inverting colours among 

others.
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5.	 �Colours – You can use this menu for editing colours.
6.	� Help menu – This provides comprehensive help about the paint program.

5. The Tool Box

The toolbox is very useful because it contains the tools you will use in order to 
come up with your drawing. It contains the following tools:
1.	� Free-form select and select tool – for selecting a specific object which then 

you can copy and paste in another location, or you can opt to delete that 
selection.

2.	� Eraser/colour eraser – this is for erasing your drawing or the colour you 
have applied.

3.	� Pick colour – this picks a specific colour you want and makes it the active 
colour, meaning that whatever you do next will have that colour.

4.	� Pencil – you will use it for drawing.
5.	� Airbrush – for spraying your object with colour.
6.	� Line tool – for drawing a line. To make your line straight, hold down the 

shift key and then drag your mouse holding the left button. Select the 
thickness of the line below the toolbox.

7.	� Rectangle tool – for making rectangles. You can also draw a square by 
holding the shift key.

8.	� Ellipse – for drawing an ellipse, you can also draw a perfect circle by holding 
the shift key before you start dragging your mouse.

9.	� Fill with colour – as the name suggests, you use this tool to fill an object 
with colour at once.

10.	� Magnifier – this is a zoom tool, you can use to magnify a part of your 
drawing.

11.	 Brush – use this for painting, just like you would paint your house.
12.	 Text – you will use this for entering text.
13.	 Curve tool – for drawing a curve.
14.	� Polygon tool – for drawing a polygon but still you can draw a lot of other 

objects.
15.	� Rounded rectangle – this tool helps you to draw a rectangle with rounded 

corners.

6. The Colour Box

The colour box contains the colours that you will use for painting your drawings.
Knowing the tools used in Paint, you can now come up with a drawing. Open 
Paint and think of something to draw. It is only by a lot of practising that you can 
improve your skills

C.  Paint Tools

Figure :1.18 The Paint Tools (Tools menu) 
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1. Common Features

The GIMP Toolbox includes thirteen “paint tools”, all grouped together at the 
bottom (in the default arrangement).

Figure :1.19 The Paint Tools (Tools Box)

The feature they all have in common is that all of them are used by moving the 
pointer across the image display, creating brush-strokes. Four of them

●● the Pencil,
●● the Paintbrush,
●● the Airbrush and
●● the Ink tool

and MyPaint brushes, a new feature in Gimp-2.10.6,
behave like the intuitive notion of “painting” with a brush. Pencil, Paintbrush, 

and Airbrush are called “basic painting tools” or brush tools.
The other tools use a brush to modify an image in some way rather than paint on 
it:

●● the Bucket Fill fills with color or pattern;
●● the Gradient fills with gradients;
●● the Eraser erases;
●● the Clone tool copies from a pattern, or image;
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●● the Perspective Clone tool copies into a changed perspective;
●● the Heal tool corrects small defects;
●● the Convolve tool blurs or sharpens;
●● the Smudge tool smears;
●● and the Dodge/Burn tool lightens or darkens.

The advantages of using GIMP with a tablet instead of a mouse probably 
show up more clearly for brush tools than anywhere else: the gain in fine control 
is invaluable. These tools also have special “Pressure sensitivity” options that are 
only usable with a tablet. 
In addition to the more common “hands-on” method, it is possible to apply paint 
tools in an automated way, by creating a selection or path and then “stroking” it. 
You can choose to stroke with any of the paint tools, including nonstandard ones 
such as the Eraser, Smudge tool, etc., and any options you set for the tool will be 
applied. 

D.  Key modifiers

1. Ctrl

Holding down the Ctrl key has a special effect on every paint tool. For the Pencil, 
Paintbrush, Airbrush, Ink, and Eraser, it switches them into “color picker” mode, 
so that clicking on an image pixel causes GIMP's foreground to be set to the active 
layer's color at that point (or, for the Eraser, GIMP's background color). For the 
Clone tool, the Ctrl key switches it into a mode where clicking sets the reference 
point for copying. For the Convolve tool, the Ctrl key switches between blur and 
sharpen modes; for the Dodge/Burn tool, it switches between dodging and burning.

2. Shift

Holding down the Shift key has the same effect on most paint tools: it places the 
tool into straight line mode. To create a straight line with any of the paint tools, 
first click on the starting point, then press the Shift key. As long as you hold it 
down, you will see a thin line connecting the previously clicked point with the 
current pointer location. If you click again, while continuing to hold down the 
Shift key, a straight line will be rendered. You can continue this process to create 
a series of connected line segments.

3. Ctrl+Shift

Holding down both keys puts the tool into constrained straight line mode. This is 
similar to the effect of the Shift key alone, except that the orientation of the line 
is constrained to the nearest multiple of 15 degrees. Use this if you want to create 
perfect horizontal, vertical, or diagonal lines.

E.  Tool Options
Figure :1.20 Tool options shared by paint tools
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Many tool options are shared by several paint tools: these are described here. 
Options that apply only to one specific tool, or to a small number of tools, are 
described in the sections devoted to those tools.

1. Mode

The Mode drop-down list provides a selection of paint application modes. As with 
the opacity, the easiest way to understand what the Mode setting does is to imagine 
that the paint is actually applied to a layer above the layer you are working on, 
with the layer combination mode in the Layers dialog set to the selected mode. You 
can obtain a great variety of special effects in this way. The Mode option is only 
usable for tools that can be thought of as adding color to the image: the Pencil, 
Paintbrush, Airbrush, Ink, and Clone tools. For the other paint tools, the option 
appears for the sake of consistency but is always grayed out. 

2. Opacity

The Opacity slider sets the transparency level for the brush operation. To 
understand how it works, imagine that instead of altering the active layer, the 
tool creates a transparent layer above the active layer and acts on that layer. 
Changing Opacity in the Tool Options has the same effect that changing opacity 
in the Layers dialog would have in the latter situation. It controls the “strength” 
of all paint tools, not just those that paint on the active layer. In the case of the 
Eraser, this can come across as a bit confusing: it works out that the higher the 
“opacity” is, the more transparency you get.

3. Brush

The brush determines how much of the image is affected by the tool, and how it is 
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affected, when you trace out a brushstroke with the pointer. GIMP allows you to 
use several different types of brushes, which are described in the Brushes section. 
The same brush choices are available for all paint tools except the Ink tool, which 
uses a unique type of procedurally generated brush. The colors of a brush only 
come into play for tools where they are meaningful: the Pencil, Paintbrush, and 
Airbrush tools. For the other paint tools, only the intensity distribution of a brush 
is relevant.

4. Size

This option lets you to modify precisely the size of the brush. You can use the 
arrow keys to vary by ±0.01 or the Page-Up and Page-Down keys to vary by ±1.00. 
You can obtain the same result if you have correctly set your mouse-wheel in the 
Preferences. 

5. Aspect Ratio

This determines the ratio between the height and the width of the brush. The 
slider is scaled from -20.00 to 20.00 with the default value set to 0.00. A negative 
value from 0.00 to -20 will narrow the height of the brush while a positive value 
between 0.00 and 20.00 indicates the narrowing rate of the width of the brush.

6. Angle

This option makes the brush turn round its center. This is visible if the brush is 
not circular or made from a rotated figure.

7. Spacing

This option sets the distance between the brush marks in a stroke.
Figure :1.21 Spacing option

Fig. Different spacings

8. Hardness

Modifies the size of the brush hard center.
Figure : 1.22 Hardness option
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On the left: hardness=50 On the right: hardness=100.

9. Force

Modifies gain.
Figure :1.23 Force option 

Force is 10%, 20%, 40%, 80%.

10. Dynamics

Brush dynamics let you map different brush parameters to several input dynamics. 
They are mostly used with graphic tablets, but some of them are also usable with 
a mouse.

You can read more about dynamics in Dynamics
When stroking paths and selections using a paint tool there is a an option 

to select “Emulate brush dynamics”. That means that when you stoke, brush 
pressure and velocity are varying along the length of the stroke. Pressure starts 
with zero, ramps up to full pressure and then ramps down again to no pressure. 
Velocity starts from zero and ramps up to full speed by the end of the stroke.

11. Dynamics Options

These options are described in Dynamics Options

12. Apply Jitter

You know “spacing” in brush strokes: strokes are made of successive brush marks 
which, when they are very near, seem to draw a continuous line. Here, instead 
of being aligned brush marks are scattered over a distance you can set with the 
Amount slider.

Figure :1.24 “Jitter” example

From top to bottom: without jitter, jitter = 1, jitter = 4.
Jitter is also available in the Paint Dynamic Editor where you can connect jitter 
to the behavior of the brush.
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13. Smooth Stroke

This option doesn't affect the rendering of the brush stroke but its “shape”. It takes 
away the wobbles of the line you are drawing. It makes drawing with a mouse 
easier. 
When this option is checked, two setting areas appear, Quality and Weight. You 
can change the default values to adapt them to your skill.
High weight values rigidifies the brush stroke.

Figure :1.25 “Smooth Stroke” example

Trying to draw a straight line and a sine curve with the mouse. 1 : option 
unchecked 2 : default values 3 : maximum values
14. Lock brush size to view

When you are working on an image that is bigger (in pixels) than your screen, 
you have to zoom in and out a lot. This option allows a very natural "iterative 
refinement" process with no need to repeatedly ask the application to change 
brush size as you go between the broad strokes and the detailing.
If the brush size is relative to the canvas (option unchecked), zooming in makes 
the brush zoomed also and it appears larger (takes up more pixels on the screen). 
If you're working with a 300 pixels radius brush and you zoom in from 12% to 
100%, the brush is now half the size of your screen! So you have to shrink the 
brush back down.
If the brush size is relative to the screen (option checked), then when you zoom 
in, the size of the displayed brush doesn't change, it looks smaller and so you can 
work on tiny details.

Figure :1.26 Lock brush to view rotation example

Screenshot. Here, the option is unchecked and we use View → Flip and 
Rotate → Rotate 15° clockwise: brush stroke is rotated.
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Same thing but the option is checked: the brush is locked to the original, not 
rotated view and brush stoke is not rotated

15. Incremental

Applies the effect incrementally as the mouse pointer moves.
The incremental checkbox does not seems to work as everyone expect. If it is 
deactivated (the default value) the maximum effect of a single stroke is determined 
by the opacity set in the opacity slider. If the opacity is set to less than 100, moving 
the brush over the same spot will increase the opacity if the brush is lifted in the 
meantime. Painting over with the same stroke has no such effect. If Incremental 
is active the brush will paint with full opacity independent of the slider's setting. 
This option is available for all paint tools except those which have a “rate” control, 
which automatically implies an incremental effect. 

F.  Paint Mode Examples
The following examples demonstrate some of GIMP's paint modes:

1. Dissolve

Figure :1.27 Dissolve mode example

Two brush-strokes made with the Airbrush, using the same fuzzy circular brush. 
Left: Normal mode. Right: Dissolve mode.

For any paint tool with opacity less than 100%, this very useful mode doesn't 
draw transparency but determines the probability of applying paint. This gives 
nice patterns of dots to paint-strokes or filling.

Figure : 1.28Painting in Dissolve mode



Computer 
Application 

in Apparel & 
Textile

NOTES

62  Self-Instructional Material

This image has only the background layer and no Alpha channel. The background 
color is sky blue. Three strokes with Pencil and various opacities: 100%, 50%, 25%. 
Foreground color pixels are scattered along brushstroke.

2. Behind

Figure :1.29 Example for layer mode “Behind”

Wilber over a blue background layer

Layers dialog

Filled with pattern
This mode applies paint only to transparent areas of the layer: the lower the 
opacity, the more paint is applied. Thus, painting opaque areas has no effect; 
painting transparent areas has the same effect as normal mode. The result is 
always an increase in opacity. Of course none of this is meaningful for layers that 
lack an alpha channel.

In the above example image, Wilber is on the top layer, surrounded by 
transparency. The lower layer is solid light blue. The Bucket Fill tool was used, 
with the Fill Whole Selection option checked and the entire layer was selected. A 
pattern was used to paint with the Bucket Fill tool.

The next image (below) has two layers. The upper layer is active. Three 
brush strokes with pencil, red color at 100%, 50%, 25%: only transparent or semi-
transparent pixels of the layer are painted.

Figure :1.30 Painting in “Behind” mode

Painting with 100%, 50%, 25% transparency (from left to right)
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3. Color Erase

Figure :1.31 Example for layer mode “Color erase” 

Wilber over a blue background layer 

White foreground color erased 
This mode erases the foreground color, replacing it with partial transparency. It 
acts like the Color to Alpha filter, applied to the area under the brushstroke. Note 
that this only works on layers that possess an alpha channel; otherwise, this mode 
is identical to Normal. 

In the above example image, the color of the Bucket Fill tool was white, so 
white parts of Wilber were erased and the blue background shows through. 

This image below has only one layer, the background layer. Background color 
is sky blue. Three brush strokes with pencil: 
1.  With the exact color of the blue area: only this blue color is erased.
2. � With the exact color of the red area. Only this red color is erased, whatever its 

transparency. Erased areas are made transparent.
3.  With the sky blue color of the layer background: only this color is erased.

Figure :1.32 Painting in “Color Erase” mode

Painted with 1. blue; 2. red; 3. background color

4. Further Information

Advanced users may be interested to know that paint tools actually operate at a 
sub-pixel level, in order to avoid producing jagged-looking results. One consequence 
of this is that even if you work with a hard-edged brush, such as one of the Circle 
brushes, pixels on the edge of the brushstroke will only be partially affected. If 
you need to have all-or-nothing effects (which may be necessary for getting a good 
selection, or for cutting and pasting, or for operating pixel-by-pixel at a high zoom 
level), use the Pencil tool, which makes all brushes perfectly hard and disables 
sub-pixel anti-aliasing.
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G.  Use of MS Paint for Weave and Colour Pattern Designing 
In Textile industry, different types of Dobby designing – Computer Aided Textile 
Designing (CATD) software are in use. Few software names are: Auto Tex cad, 
Wonder Weaves, Textronics and Texgraphics. Dobby designing software is very 
simple in its tools, options, and operations and hence it is cheaper when compared 
with jacquard designing software. By using dobby-designing software, simple 
basic weaves - plain, twill, sateen and all its derivatives and their combinations 
can be designed and ornamented with required thread density, colour pattern and 
yarn quality to produce solid, cross, vertical stripe, cross- over stripe and check 
effects. Dobby designing software generally has the option to generate simulation 
of colour and weave patterning with required thread density. It has also option to 
generate simulation of colour and weave patterning with required yarn creation.

MS Paint is a default accessory provided in Microsoft Windows operating 
system to draw simple drawings in pixel form. The possibility of using MS Paint, 
as a simple weave and colour patterning software to prepare different colour 
patterns with different weaves has been explored. The steps involved in preparing 
the desired colour pattern and weave are studied and noted. It is observed that 
without making any additional programming, the paint tool is directly useful to 
prepare patterns with required colour and weave.

1. Preparing the warp pattern file 

The warp pattern is prepared in MS Paint. Open MS Paint, go to „Attribute option‟ 
and open new file / image. Take the length pixel equal to 100 which is the total 
picks of weft pattern and take width pixel equal to 50 which is the number of ends 
of first colour A in the decided warp pattern. The new image gets opened in 50 ends 
X 100 picks with white colour. Select the Colour-A (any matching colour as per the 
pattern) from „Edit colour‟ option and change the white colour image into Colour 
- A using „Fill colour‟ option.

Figure :1.33  (a), (b) and (c) - Steps in preparing the warp pattern file 
Again go to „Attribute option‟ and change the pixels as follows. Keep the length 
pixel as 100 without changing; but change the width pixel as 60 which is equal to 
the total number of ends of the first and second colour of the warp pattern (Colour  
A + Colour B = 50 + 10 = 60). Now, the image will extend in width way from 50 
ends to 60 ends with 50 ends in colour A and 10 ends in white colour. Select the 
Colour-B (any matching colour as per the pattern) from „Edit colour‟ option and 
change the white colour part into Colour -B using „Fill colour‟ option. Repeat the 
above step by changing the width pixel from 60 to 64 (60 + 4) as per the pattern 
and change the extended white colour into „Colour C‟. Repeat the step till the 
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complete repeat of the warp pattern is obtained in 100 X 100 and save it as warp 
pattern.bmp 

2. Preparing the weft pattern file 

If the weft pattern is same as warp pattern, rotate the des1.bmp image to +90 
Degree. The des1.bmp become as weft pattern. Save it as weft pattern1.bmp. 
If the weft pattern is different from warp pattern, prepare new weft pattern by 
following the steps given below which is same as followed for warp pattern but 
only interchanging the length pixel as width pixel and vice-versa.

Open MS Paint, go to “Attribute option‟ and open new file / image. Take the 
width pixel equal to 100 which is the total ends of weft pattern and take length 
pixel equal to 42 which is the number of ends of first colour A in the decided warp 
pattern. The new image gets opened in 100 ends X 42 picks with white colour. 
Select the Colour-E (any matching colour as per the pattern) from “Edit colour‟ 
option and change the white colour image into Colour -A using “Fill colour‟ option.

Again go to Attribute option and change the pixels as follows. Keep the width 
pixel as 100 without changing; but change the length pixel as 52 which is equal to 
the total number of ends of the first and second colour of the weft pattern (Colour 
E + Colour F = 40 + 12 = 52). Now, the image will extend in length way from 40 
picks to 52 picks with 40 pick in colour E and 12 picks in white colour. Select the 
Colour-F (any matching colour as per the pattern) from „Edit colour‟ option and 
change the white colour part into Colour -F using „Fill colour‟ option. Repeat the 
above step by changing the length pixel from 52 to 58 (52 + 6) as per the pattern 
and change the extended white colour into „Colour G‟. Repeat the step till the 
complete repeat of the weft pattern is obtained in 100 X 100 and save it as weft 
pattern2.bmp.

Figure :1.34 (a) – Weft pattern same as warp pattern, (b) and (c) – Weft 
pattern different from warp pattern

3. Creating the positive weave mark file 

Go to „Attribute option‟ and open a new file / image by taking the file size as 100 
X 100 which is equal to total ends and picks of the pattern. Keep the image in 8th 
zoom level and open the grid (ctrl+g). Using pen and taking black colour, create 
a repeat of the weave (for example, let the weave be plain). Complete the plain 
weave in 100 X 100 using select, copy and paste options. Save the file as positive 
weave (plain).bmp. 
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Figure :1.35 (a) – Positive weave (Plain weave) and (b) – Negative weave 
mark (Plain weave)

1.7 � STUDY AND APPLICATION OF DIFFERENT 
TOOLS USED IN MS POWER POINT 

A power point presentation is a collection of slides, handouts , speakers, notes, and 
your outline all in one file. As we create slides , we are creating a presentation. We 
are designing how the presentation should look and give it a format that carries 
through from the beginning to the end.
SLIDES--- Slides  are the individual pages of your presentation. Slides can have 
titles, text , graphs, drawn objects, shapes, clipart, drawn art and visual created 
with other applications and more.
OUTLINES--- while working with a presentation, we have the option of working 
with our presentation in outline, the title and main text appear, but not the art or 
the text types with the text tools. We can print our outline too.

A.  Power Point Screen Elements
A window is a rectangular area on the screen in which we view a programme. 
Power point uses two windows, one nestled within the other. The outer window 
is called the application window. It contains power point windows main options 
and commands. The inner window called the presentation window, contains the 
current presentation file and the tools, options, commands, and message associated 
with this file.

Elements  
●● Control menu box.	
●● Title bar.
●● Menu bar.
●● Minimize button.
●● Maximize/restore button.
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●● Standard tool bar.
●● Drawing tool bar.
●● Status bar.
●● View slide button
●● New slide button.
●● Layout button.
●● Template button.

1. Tool Bars 

The standard and the formatting tool bars are displayed just below the menu bar, 
draw tool bar is displayed vertically on the left side of the window. Different tool 
bars appear automatically in each view.

Presentation Window  
●● Choose file,new.
●● Select the blank presentation option, and click on ok to open the new slide 

dialogue box.
●● Click on ok to open the new presentation window.

Elements 
●● Title bar.
●● Slide work space.
●● View buttons
●● Slide show button
●● Previous slide button.
●● Next slide button.

●● The auto content wizard—This wizard starts with a title slide and then 
helps us choose from a selection of presentation categories.

●● The  pick a look wizard-----This wizard helps us create a look or the style 
of our presentation.

●● Template ----- It starts by stretching a presentation template that 
determines the colour scheme , fonts, and other design features of the 
presentation.

●● Blank presentation----As the name suggests a blank presentation is 
displayed for us to create our own formats.

Opening a Presentsation File 
●● Choose file, open to open the open dialogue box.
●● If necessary we change the current drive to the drive that contains the 

presentation file we want to open.
●● If necessary we change the current directory to the directory that contains the 

presentation file we want to open.
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●● In the file name list box , we select the name of the presentation file that we 
want to open.

●● Click on ok.
Understanding Power Point View 

●● Slide View.
●● Slide Sorter View.
●● Note Pages View.
●● Slide Show View.

Creating Presentation and Slides. 
●● Introduction 
●● General procedure we use to create any presentation.
●● Open a new blank presentation in which to create our slides.
●● In the newly opened presentation create new, blank slides and enter the text.
●● Save a presentation to a file on the disk.
●● Add design elements by drawing on slides, adding charts to slides, adding 

clipart to slides, and laying on it .
●● Generate output by running a slide show of the presentation, printing slides, 

notes or handouts.

Opening a New Blank Presentsation. 
●● Choose file new to open the new presentation dialogue box.
●● Select blank presentations to open a new, blank presention that uses the 

powerpoint default slide format to open a new blank presentation. 
●● Click on ok . the new slide dialogue box appears. 
●● Select your desired auto layout for the new presentation's first slide. 
●● Click on ok. 

Creating a new slide in slide view. 
●● Display the slide directly after which we want our new slide to appear.
●● Click on the new slide button or choose insert, new slide to open the new 

dialogue box.
●● Select the desired auto layout for your new slide.
●● Click on ok.

2. Text Formatting and the Slide Master 

The format of the text we enter in a title, subtitle, or bulleted- list object is 
determined by the format settings in a special slide called the slide master.
Text Attributes- this determine the appearance of our slide text.
Aligning Text----- This determines the position of our slides text within its text 
object box. Text can be left aligned, right aligned, centered, or justified.
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Changing Line Spacing—line spacing determines two things. The amount of 
space between the individual lines of a multilane paragraph and the amount of 
space between paragraphs.
Changing Text Case-----This command allows us to easily change the case of our 
slide text.
Spell Checking----Power point provides a spell checker that searches our entire 
presentation---all the text objects in all of our slides , outlines, notes, and handouts, 
for spelling errors.

3. �Drawubg and Adding Clipart on to Slides Drawing Primer

●● Tool 
●● Selection
●● Text
●● Line
●● Rectangle
●● Eclipse 
●● ARC
●● Freedom 
●● Free Rotate 
●● Auto Shapes 
●● Fill on/off 
●● Shadow on/off 

In addition to the drawing tool bar, power point provides a drawing + tool bar that 
allowes us to do such things as change an object’s fill, line, objects, flip objects.

4. Working With Clip Art 

To add sophisticated pre drawn pre coloured images are called clip art objects or 
simply clip art.
Re Sizing Clip Art 

●● Select the clip art object.
●● To reduce the object drag a selection handle towards the center of the object. 

To enlarge the object, drag a handle away from the center of the object. Drag 
a corner a handle to maintain the proportions of the object. Ctrl+drag a corner 
handle to keep the object centered as we resize it. 

5. Cropping Clip Art 

Power point qwickly allows us to qwickly and easily crop a clip art object.
●● Select the clip art object.
●● Choose tools, crop picture or choose crop picture from the shortcut menu. The 

mouse pointer becomes the cropping tool.
●● Drag one of the clip art objects selection handles to crop the image as desired.
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●● If necessary, repeat the previous step until the image is cropped to our 
satisfaction.

●● Click on any blank area of the slide to de select both  the clip art object and 
cropping tool.

Un Cropping Clip Art 
●● Select the cropped clip art object.
●● Choose tools, crop picture or choose crop picture from the short cut menu. The 

mouse pointer become a cropping tool.
●● Drag one of the clip art objects selection handlesto in srop the image as desired .
●● Click on any blank area of the slide to de select both the clip art object and 

the cropping tool.

Scaling Clip Art 
●● Select the clip art object.
●● Choose draw, scale to open the scale dialogue box.
●● In the scale to box, specify our desired scale percentage.
●● Click on preview to observe the results.
●● Click on ok to apply scaling.

6. Colour scheme 

Every power point presentation has a colour scheme, a set of eight compatible 
colours that are used for specific side elements.

7. �Working With Organization Coloumn and Pie Chart Creating Organiza-
tion Pie Chart 

●● Move to the slide we want to place the organization chart after.
●● Click on the new slide button.
●● Select on the organization chart auto layout.
●● Click on ok.
●● Click on the title object and type a title for organization chart.
●● Double click on the organization chart object to open Microsoft organization 

chart.

8. �Exploring the Microsoft or Organization Chart window

We double click on an organization chart object ,
The Microsoft organization chart window opens displaying a chart template 
containing 4 boxes. Microsoft organization chart has its own menu bar and tool 
bar as well.
Three types of tool in the tool bar:

●● General perpose tool.
●● Box tool.
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●● Custom drawing.

9. Placing a Chartt on a Slide 

Once we have created our chart, we need exit from Microsoft organization chart 
and place that chart on the slide in our presentation.

10. Formatting the Organization Chart
There are many ways to change the appearance of our organization chart.

●● Changing the fill colour of the boxes.
●● Changing the style.

11. Microsoft Graph 
Microsoft graph consists of two windows:

●● Data sheet window. 
●● Creating chart window. 

12. Creating Coloumn Chart 
Coloumn charts are useful for showing variation over a period of time. Each 
number in the data sheet is represented by a coloumn in the chart. Data is entered 
into the data sheet by now. The information in the first coloumn of our data sheet 
appears in our data chart as the legend, and the contents of the first row become 
the labels along the horizontal axis.

Changing Legend Format 
●● Click on the chart to make it active if necessary.
●● Click on the legend.
●● Click on the placement and select a legend type.
●● Click on ok.

13. Pie Chart 

A pie chart is a circular diagram that depicts the relationship between a whole and 
its parts.

Changing the Chart Type 
●● Choose the format, auto format.
●● Command to change the chart type from the galleries list.
●● Select the chart format of our choice.
●● Click on ok.

14. Importing and Exporting Charts 

●● Importing Data From Microsoft Excel:  if we have a Microsoft excel 
worksheet that contains the information we want to plot in our power point 
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chart, we can import the data from the work sheet directly into our powe point 
presentation.

●● Importing a Microsoft Excel Chart:  we can use Microsoft excel to create 
charts as well as work sheets. If we do use excel to create a chart and then 
decide we must have that chart in our power point presentation, we can import 
the chart itself. Without importing the excel data. once we import Microsoft 
excel chart, the chart is embedded in our presentation. The original information 
is stored in our power point presentation file, allowing us to edit the object in 
power point.

15. Chaging the order of Slide in Outline view 

If we want to change the order of slide sorter view, it is generally a good idea to 
first collapse our outline by clicking on shadow titles button. Just the titles of our 
slides will then be displayed, making it easier to view all the slides and ensure 
that all the text on each slide moves with that slide.

Changing the Order of Slide Sorter View------- 
●● Move the slide sorter view.
●● Select the slide we want to move.
●● Start dragging the slide. The mouse pointer becomes a slide icon.
●● Drag the slide icon to a new position.

16. Hiding a Slide 

If we aren’t sure whether we really need a slide, we can hide it instead of deleting 
it. 

●● Select the slide.
●● Choose tools, hide slide.

17. Printing Slides 

When we print the slides in our presentation, we have 2 options-------
●● Slides(with builds) 
●● Slides(without builds) 

Printing an Outline: Power point an outline just as it appears on our screen. 
To add background items to the printed outline, we use the outline master.

B.  Tools Used By Pro PowerPoint Presentation Designers
PowerPoint presentation designers are termed ‘pro’ for one reason and that’s 
because they can transform an ordinary presentation into an enticing piece of 
information. Designers make a presentation stand out with attractive designs and 
eye-catching graphics. Ever wondered what tools that Powerpoint designers use to 
create magic in a presentation? Well, read on as we discuss them. 

Some of the tools that professional presentation designers use can be found in 
Microsoft PowerPoint itself; however, there are some third-party tools which are 
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also used to enhance the overall look and feel of the slides. PowerPoint presentation 
designers create slides with one and only aim in mind is to stun the audience with 
impressive graphics while ensuring that a message is communicated effectively.

1. Perspector 

Perspector is a tool used by designers to create 3D images on PowerPoint 
presentations. Instead of having the same old 2D images and regular slides, 
PowerPoint presentation designers now have a new way of keeping the audience 
interested in a presentation. 3D graphics definitely capture the attention of the 
audience and keep them glued to presentations.
Perspector comes with a set of templates, with images, that can be easily transferred 
onto PowerPoint slides. In addition, designers can customize these slides based on 
the user’s requirement and preference. If designers want to draw 3D images from 
scratch, they can do so using the drawing interface provided by this application.

2. PivotViewer

The Silverlight PivotViewer is yet another tool frequently used by PowerPoint 
presentation designers. It is especially useful if there are huge amounts of data 
that need to be captured in the PowerPoint slides. As you know, presenting 
large amount of information in a table format is not user-friendly or attractive. 
It is difficult for an audience to read and understand the data. Plus, too much 
information makes the presentation look cluttered.

This amazing tool allows designers to present data in a powerful manner, by 
showing trends in the data that would otherwise be difficult to observe. This makes 
a presentation informative as well as fun, without overwhelming the audience 
with a flood of information.

3. Autodesk 3DS Max

If a designer is making slides for an architect or a civil engineer, he will find the 
Autodesk 3DS Max tool extremely useful. This tool allows professional PowerPoint 
presentation designers to create as well as simulate models, which makes it an 
enriching moment for the audience. Generally, architects face the challenge of 
transferring their visualizations from paper to the screen and this tool does just 
that. Showing a building or a bridge in 3D on a PowerPoint presentation is no 
longer an impossible task with the amazing Autodesk 3DS Max.

4. VisualBee PowerPoint Add-In

Believe it or not, professional PowerPoint presentation designers too sometimes fall 
short on time and resort to automatic design tools for last minute enhancements. 
One such tool is the VisualBee add-in, which can be installed on the PowerPoint 
application. This tool allows designers to populate the deck of slides as usual and 
then, alerts the system to take care of the enhancement. There is a button in the 
tool called ‘Enhance Presentation’, which allows designers to select designs and 
styles in a jiffy, if they are rushing for time. Most designer will avoid this, as there 
is very little customization involved but it can help you for presentations when 
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time is of the essence or you don’t have the budget for a professional designer.

5. SmartArt

Most of us are already familiar with the SmartArt tool that is present in the 
Microsoft PowerPoint application. However, not all of us take full advantage 
of this tool. PowerPoint designers use this tool to create diagrams, charts and 
graphs. Instead of merely presenting data in the boring tabular style, designers go 
one step further and add the ‘glam’ element to the slides. Again, this is a powerful 
tool but lacks a lot of the customization we usually like to work with.

6. Animations and Transitions

The animations and transitions found in the Microsoft PowerPoint are great as 
long as they are handled smartly. It is not difficult to get a firm grasp of this tool, 
yet many users do not use this tool to an optimal level. To emphasize certain key 
words, professional designers use animation on the relevant text but try to do so 
in a minimalistic manner. This immediately draws the attention of the audience to 
the information which ensure their focus is exactly where it should be.
Professional PowerPoint presentation designers also use consistent transition 
between slides to exude professionalism and keep the audience entertained 
throughout the presentation. Professional designers maintain the right amount of 
activity when it comes to transition so that the audience does not get distracted by 
too much movement on the slides.

7. Wordle

Many times, PowerPoint presentation designers come across slides that are simply 
bursting with way too much content. Sometimes, it is important to include the text, 
even though it is plenty. So, what do professional designers do when they come 
across this situation? They make use of the Wordle tool to add funk to the slides. 
This tool builds a word cloud based on the text and acts as a unique backdrop to 
the slide.

8. Cacoo

Cacoo is a drawing tool that many professional PowerPoint presentation designers 
use to create flow charts and diagrams that may be difficult to draw using the 
in-built tools in Microsoft PowerPoint. Cacoo not only allows designers to create 
standard diagrams but enables user to customize the diagrams and flow charts as 
per his requirement. In addition, once the designer completes his diagram, he can 
save it as an image and incorporate it into multiple PowerPoint presentations.

9. Oomfo

Oomfo is yet another tool that enables professional designers to create charts and 
graphs, with animation. When designers use Oomfo, in a reasonable manner, 
they can really create powerful presentations. Oomfo stuns the audience with the 
visuals and makes it fun for both the user and the viewer. In addition, Oomfo 
makes graphs and charts interactive. It allows 2D images to be converted into 3D 
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images in a split second and enables slicing and rotation of pie charts to engage 
the audience.

Thanks to the advancement in technology, professional PowerPoint 
presentation designers as well as amateurs have the opportunity to create powerful 
presentations. Though these tools may help you better your presentation designs, 
they are to be used in moderation, and are often difficult to adapt to certain brands, 
which is why we tend to create all of our content custom.

C.  Tools in PowerPoint 2010 
Sometimes you may need to find out more about a particular subject, or even about 
a single word. In common with other components of MS Office 2010, PowerPoint 
has built-in research facilities that can really help.
Let’s suppose that you are preparing a presentation on the US Government. 
You need some more information, and you‘re going to start by finding out about 
Congress. You’ve prepared a header slide but now you need to get some facts 
together.

First, select the Review tab. Then select the Research button in the Proofing group.
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This opens the Research Task Pane. It appears on the right by default.

Once the pane is open, type the phrase “US Congress” in the Search for: box.

Now click on the arrow to the right of the Search for: box (the arrow has a screen 
tip of “Start Searching”) and the search for related information begins. In this case 
there are many hits on the phrase “US Congress” – almost 400 million in fact!
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With each hit there is a hyperlink to the relevant source. So, for example, the first 
hit has a link www.house.gov in blue. If you click on the link a new window opens 
up and the linked web page appears.

From this link and page you can get some of the information you need. You can 
also browse through this site or use its own search facility to find out more.
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When you’ve finished with this site, youcan close the window it’s in and return to 
the Research box. 
When using the Reference Task Pane you have a few options. When searching for 
the information on the US Congress above we accepted the default search with 
Bing. Clicking on the arrow to the right of that you can see that there are other 
options. 

(Which ones are actually available to you depends on your own installation 
of PowerPoint 2010, and they’re unlikely to be exactly the same as mine.)
You can control which options are available by clicking on Research Options… 
at the bottom of the Research Task Pane. This brings up the Research 
Options dialog.
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You can now choose which reference books to search by checking and unchecking 
the relevant boxes. Suppose, for example, that you wanted to include both the US 

and UK Encarta Dictionaries. Check the boxes as shown here, then click OK.

They will both now appear as options for your next search.
To find out more about one of the services, select it and click the Properties 
button. This shows the Service Properties dialog.
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Click on Close when you’ve finished reviewing this information.
When the Research Options dialog is open, you can update services – or remove 
ones you don’t use – by clicking on the Update/Remove… button.

Select one of the services and you can update it by clicking Update… or remove it 
altogether by clicking Remove. 

D.  Advantages and Disadvantages of PowerPoint

1. PowerPoint—Advantage or Disadvantage for the Presenter?

PowerPoint is the most popular presentation software. It is regarded by many 
as the most useful and accessible way to create and present visual aids to the 
audience.

On the other hand, others believe it has created its own mind-set which 
forces presenters to spend countless hours thinking in PowerPoint and 
developing slides. A political party has even formed to ban PowerPoint in 
Switzerland. Depending on one’s perspective, it seems that many advantages 
could easily be viewed as disadvantages.

Using PowerPoint: When used correctly, PowerPoint is a helpful program for 
creating an engaging presentation. 
Look over the list below to see where you stand—with or against PowerPoint.
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2. Advantages

Design
●● Quick and easy: the basic features are easy to master and can make you appear 

to be organized, even if you are not.
●● Simple bullet points: it can reduce complicated messages to simple bullet points. 

Bullet points are a good basis for a presentation and remind the speaker of 
main points and the organization of the message.

●● Easy to create a colorful, attractive design: using the standard templates and 
themes, you can create something visually appealing,even if you do not have 
much knowledge of basic graphic design principles.

●● Easy to modify: when compared to other visual aids such as charts, posters, 
or objects, it is easy to modify.

●● Easily re-order presentation: with a simple drag and drop or using key strokes, 
you can move slides to re-order the presentation.

Finally, PowerPoint is integrated with other products that allow you to include 
parts of documents, spread sheets, and graphics.
Delivery

●● Audience Size: PowerPoint slides are generally easier to see by a large audience 
when projected than other visual aids.

●● Easy to present: you can easily advance the slides in the presentation one after 
another with a simple key stroke while still maintaining eye contact with the 
audience.

●● No need for Handouts: they look good visually and can be easily read if you 
have a projector and screen that is large enough for the entire room.

3. Disadvantages

Design
●● Design power pointless: gives the illusion of content and coherence, when in 

fact there is really not much substance or connection between the different 
points on the slides.

●● PowerPoint excess: some speakers create presentations so they have slides to 
present rather than outlining, organizing, and focusing on the message.

●● Replaces planning and preparation: PowerPoint is a convenient prop for poor 
speakers, as it can reduce complicated messages to simple bullet points and 
elevates style over substance.

●● Oversimplification of topic: the linear nature of PowerPoint forces the presenter 
to reduce complex subjects to a set of bullet items that are too weak to support 
decision-making or show the complexity of an issue.

●● Feature abundance: while the basic features are easy to use and apply, a 
speaker can get carried away and try to use all the features at once rather 
than simply supporting a message. Too many flying letters, animations, and 
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sound effects without seeing much original thought or analysis can be a real 
issue. In many cases, the medium shoves the message aside.

Delivery
●● Basic equipment required: you will need to have a computer and projection 

equipment in place to display the slides to the audience.
●● Focus on medium, not message: Too many people forget that they are making 

a presentation first and that PowerPoint is just a tool.

E.  An Overview of PowerPoint
Microsoft PowerPoint is a computer software package that displays information 
in the form of a slide show.

1. An Overview of PowerPoint

PowerPoint is a presentation software program. A presentation program (also 
called a presentation graphics program) is a computer software package used to 
display information, normally in the form of a slide show. It typically includes 
three major functions: an editor that allows text to be inserted and formatted, a 
method for inserting and manipulating graphic images, and a slide-show system 
to display the content. 

PowerPoint: PowerPoint software runs on Microsoft and Mac operating systems. 
It allows users to create visual presentations comprised of individual slides.

Microsoft PowerPoint 9 is easy-to-use presentation software that runs on 
icrosoft Windows and Mac OS operating systems. PowerPoint is commonly used 
by usiness people and students to create slide show presentations. The ease of use 
is demonstrated by the fact that the program can be used by junior high and high 
school students. PowerPoint can accommodate a range of uses, with intermediate 
to more technical options. Microsoft estimates that thirty million presentations 
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are made each day using the PowerPoint program. As of 2012, various versions of 
PowerPoint claim approximately 95% of the presentation software market share, 
having been installed on at least 1 billion computers.

PowerPoint Logo: With 95% market share, PowerPoint presentation software is 
one of the most widely used programs for developing visual presentations.

PowerPoint has almost become a generic term similar to Xerox or Coke 
or Google and is often used when one is referring to any computer supported 
presentation, thus demonstrating how ubiquitous the program has become.

2. The Use of Slides in PowerPoint Presentations 

PowerPoint presentations are comprised of a number of individual pages, or 
“slides.” The “slide” analogy is a reference to slide projectors. Unlike slide 
projectors however, which only projected static images, slides in PowerPoint are 
more dynamic. They can include text, graphics, sound, movies, and other objects, 
which can be arranged by the presenter. The PowerPoint presentation can be 
printed, displayed live on a computer, or navigated through at the command of 
the presenter. For larger audiences the computer display is often projected using 
projection equipment. The slides can also be used as the basis for a webcast.

After designing the individual slides for your presentation, you can control 
the presentation by pre-programming the transitions from one slide to another 
with the exact timing you want. Or, you can advance the slides manually as you 
speak about each.

3. Supporters and Critics 

Supporters of the software say the PowerPoint can save people time by 
circumventing the need for other types of visual aids, such as hand-drawn or 
mechanically typeset slides, blackboards, whiteboards, or overhead projections. 
Because the software is easy to use, it encourages people to give presentations that 
contain visual aids who otherwise may not have even given a presentation.

PowerPoint does have its critics, and the benefits of the software are 
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continually debated. Some critics of PowerPoint argue that condensing complex 
issues into simplified bullet points is detrimental, and compromises the quality of 
information provided to the audience. This view finds that audience do not receive 
enough detailed information to make informed decisions about presentation 
topics. Additionally, there are also some critics who say that rather than providing 
too little information, PowerPoint allows users to put too much information into 
presentations. This can lead to “death by PowerPoint,” which is a state of bordem 
or fatigue as a result of sitting through a presentation that contains too much 
information.

As is clear from the debate about its merits, PowerPoint can present many 
benefits and challenges to a user who develops a slideshow to accompany a speech 
or presentation. 

F.  The Elements of a Slide
PowerPoint is a multi-media platform that incorporates elements of written, audio, 
video, and graphical communication.

1. Elements of a Slide

The basic element of the presentation is the slide. The new default aspect ratio of 
the slide is 16:9 for wide screens, but the previous aspect of 4:3 is still available. 
Some basic example elements used to compose a slide are as follows:

Titles and sub-titles: After first opening PowerPoint to start a new presentation 
using the Blank Presentation Template, the user can select a title and sub-title for 
the presentation, using one of a variety of fonts and colors.

Text: Users can enter the content as bullets on the slide along with a title 
for the slide. They can also select the font style, size, and content to support their 
message.

Shapes: PowerPoint can merge two shapes together to create a custom shape.
Pictures: Users can search for and insert their own photographs. Remember 

to re-size the photo to fit the slide.
Charts/Graphs: Create custom charts or move relevant charts from Excel 

spreadsheets.
Audio/Video Clips: Download videos, images, and audio files directly into a 

slide for a presentation without first downloading to the computer. Search for 
audio and video from within PowerPoint to find images using Bing or Flickr and 
videos on You Tube. After locating the desired supporting media, incorporate it 
into the slide. By default, the results show images that are licensed under Creative 
Common, so the images can be used in presentations without violating an owner’s 
copyright, but users can also view all results.

Transitions: Transitions move the presentation gracefully from one slide 
to the next or build the side dynamically. There are many standard transitions 
available, or users can program their own special effects to animate the movement 
of the sides.
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PowerPoint Slide: PowerPoint allows users to create slides and add animation, 
transitions, and video and audio clips.

G.  Formatting Tips
Formatting choices, including layout, font selection, transitions and use of space 
and color, are important components of a presentation.

1. PowerPoint Features

PowerPoint incorporates elements of written, oral, and visual communication. By 
focusing on decisions regarding blank space or color, contrast, and font, you can 
design a presentation that is not only aesthetically appealing, but also enhances 
and underscores key content and objectives. The following tips will help you and 
your audience get the most from your presentation.

2. Formatting the Slide

Templates: You may either select an existing template or design your own. The 
blank template allows you to modify colors, themes, and the style of different 
elements to best suit your needs.

Normal view – Blank Presentation template: The blank presentation template 
provides placeholders for title and sub-title on the first slide, and additional 
placeholders for the title on each blank slide. This allows you to distinguish your 
main points from sub-points. Follow basic design rules:

●● Use blank space to group or separate items.
●● Use visual balance to please the eye.
●● Create contrast to make objects stand out. Contrast occurs when any two 

elements are different.

Colors: Choose colors so that text is clearly legible. In addition, consider how the 
colors will look in the space where the slideshow will be presented. For example:
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Picking Colors: In a presentation, there can be different colors and fonts, but all of 
the text must be easy to read for the audience.

●● Strong light reduces contrast on dark background.
●● In a well-lit room, use light background with dark text and visuals.
●● In a dimly-lit room, use dark background with light text and visuals.
●● Avoid vibrating colors. Bright complementary colors that are close to each 

other in intensity “vibrate” or reduce legibility.

3. Adding Content

Text: Use text properly.
●● Use keywords and phrases instead of sentences.
●● Be consistent in your use of capitalization.
●● Put similar ideas in the same formatting by using the same parts of speech, 

same clauses, phrases, or all complete sentences.

Organization: On a slide, information can be organized using bullet points or 
lists.

●● Use bullet points. Bullets help the audience skim the slide and see relationships 
between main and sub-points. Here is how to use bullets:

	 1. � Select the “bulleted list” or “two-column list” slide (from the pre-
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designed slide formats).

	 2.  Type a phrase then hit “return.”

	 3.  Type a second phrase, hit “return” then hit “tab” to indent.

	 4. � OR use “promote” or “demote” arrows at top to create a bulleted 
hierarchy, in order to distinguish main claims from subclaims.

Creating a Contrast: A speaker can create contrast in a presentation changing 
the font, color, or size. 

Fonts: Choose easy-to-read fonts. 
●● Select fonts that are good for projecting, not ones that are just good for printing.
●● Pay attention to the legibility of the font you choose, such as the contrast 

between background and text, size of the font, and any type treatment such 
as shadowing that may reduce legibility.

Graphics: Insert needed visuals such as WordArt, shapes, or images. Make sure 
to re-size the images to best fit the slide. Here is how to re-size images:

1.	 Click on the visual you wish to resize.

2.	 Go to “format” and then “object” or “autoshape.”

3.	 Select “size.”

4.	 Change size and scale.

5.	 OR, simply click and drag the corners of the image.

6.	� You can also combine two different shapes by selecting one and then 
selecting and dragging another into it for a custom image.

Video and Audio: You can search and select video in different media formats. Just 
click to select the video/audio and insert where you want them to play on the slide. 
You can also record your own audio to add to a slide. When choosing video or audio 
to add to your presentation, make sure that it is of a high quality. This enhances 
the authority of the presenter as well as improves audience receptivity.

4. Moving Between Slides

Effects and transitions: PowerPoint comes with a preset collection of transitions. 
You can choose different types of transitions to move between slides. Newer 
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versions of PowerPoint even have some 3D transitions. In addition, there are 
many free transition templates available from Microsoft and open sources.

Effects between slides: Effects should have a point and support the overall concept 
of the presentation. Avoid slow moving or fancy effects such as crawl in, swivel, and 
spiral. Don’t overuse special effects as they can distract your audience from your 
main points. To avoid this from happening, keep effects and transitions consistent.

5. After the Presentation

Handouts: You can export your PowerPoint presentation to a Word Document. 
When you do this, there are different choices available for how slides and notes 
are positioned. In the latest version of PowerPoint you can go to File—-> Export 
and then click on the {Create Handouts} button. Your presentation will then be 
exported to a Word document for formatting.

Share: You can also share your PowerPoint presentation by email, through web 
access. or publish your slides so that others can access them electronically rather 
than having to distribute handouts.

H.  Delivery Tips

PowerPoint presentation software is your assistant and should help you by 
supporting your presentation, not taking over the show.

1. PowerPoint Software Is Your Assistant

PowerPoint presentation software is your assistant and should help you, not take 
over the show. Nothing can substitute for a carefully prepared message, whether 
that message is a standard linear message or a relational interactive message. The 
delivery of the message is guided by the best practices that you have been using 
throughout your speeches; however, there are some special considerations when 
working with PowerPoint.

2. Practice and Rehearsal

After putting together a PowerPoint slide show, you will want to get a “reality 
check” by actually running the show to see what it will look like when you present 
it. You may control the movement from one slide to the next as you speak, or you 
may preprogram the amount of time that each slide appears on the screen and 
speak only for that amount of time.

If at all possible, rehearse with the same display equipment in a similar space. If 
you are speaking to a colocated audience, make sure that your projected slides are 
large enough for all members of the audience to see (usually about 1 inch high for 
each 10 feet that separates the audience from the projected slide). Additionally, if 
you are speaking to a remote audience, check your display so that you can see the 
presentation in the same way that the audience will see it on their screens.
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3. Basic Delivery 

One critical aspect of delivery is avoiding the temptation to read the content to 
the audience; the audience can read what is projected themselves. The content of 
the slides serves as a guide or outline for you and the audience. Stand to the left 
of the screen. For the English speaker who reads from left to right, the audience 
will see you as their eyes move across the screen in one continuous left to right eye 
movement. And remember to speak WITH the audience, not AT them. 

Delivering a Speech: The speaker delivers the speech with assistance from 
PowerPoint slides in the background.

4. Using Views

Using PowerPoint Views allows you to follow a linear path or relational interactive 
paths for delivery.

5. Slide Show View

You can use the Slide Show view to deliver your presentation. The slide occupies 
the full screen and displays the way your presentation will look when you project 
it. You can use the Slide Show view to see the slide show on your computer screen 
one slide at a time. You can move to the next slide by clicking the mouse or using 
the up and down arrow keys.

6. Presenter View

You can see your notes on your monitor while the audience only sees the slide. You 
can also zoom in on a particular part of the slide or use a pen or laser pointer to 
call attention to details. In Presenter view, you can display the current slide on the 
left side, the next slide on the right, and the notes at the bottom right of the screen.
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7. Interactive Relational Delivery

Relational presentation (also known as visually interactive presentation) uses 
standard presentation software such as PowerPoint in a way that allows for 
dynamic customization of messages while presenting.

Relational presentation practitioners structure their material using a 
combination of strategies to develop and access small message units. Each small 
message unit is rather self-contained and can be pulled together as the speaker 
interacts with the audience. While presenting, you interact with the audience 
rather than “talk at” them. You can use the Presenter view to quickly select and 
navigate to each message unit spontaneously within and between collections of 
interconnected shows. Some of these navigation devices use text links and others 
incorporate picture thumbnails or miniature screenshots as link sources.

8. Navigation in a Presentation

Whether you are delivering a traditional, linear message or an interactive, 
relational presentation, it is helpful to gain control of the basic movements for the 
slide show.

Interact with the Audience: It’s important that the speaker maintains eye contact 
with the audience while projecting the slides.

Move to the last slide: Drag the scroll box to the bottom of the scroll bar or press 
[Ctrl] and [End] 

Move to the first slide: Drag the scroll box to the top of the scroll bar or press 
[Ctrl] and [Home] 

Move to the next slide: Click in the scroll bar below the scroll box or press [Page 
Down] 

Move to the previous slide: Click in the scroll bar above the scroll box or press 
[Page Up] 

Move to a specific slide: Drag the scroll box up or down until you displays the 
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slide you want 

9. Delivery Wrap-Up

So to wrap it up, you should prepare your lecture before firing up your software. 
Remember that the technology is your assistant and should help you, not take over 
the show. You may creatively deliver a linear presentation, but you can also use 
PowerPoint to craft a highly interactive relationship experience with the audience.

I.  Other Presentation Software Options

Microsoft PowerPoint dominates the presentation software market, but other 
options include Mind Maps, SlideRocket, and Prezi.

1. Alternatives to PowerPoint Presentation Software

Presentation software is a computer software package used to display information, 
normally in the form of a slide show. The software typically includes three major 
functions:

●● an editor that allows text to be inserted and formatted;
●● a method for inserting and manipulating graphic images, and;
●● a slide-show system to display the content.

Microsoft PowerPoint dominates the market with 95% of the presentation software 
market share. However, there are other presentation graphic programs with 
different features and approaches. Some of the alternatives to PowerPoint include:

Mind Maps You can use mind maps to plan and modify your presentation. Mind 
Maps break away from the linear format of PowerPoint by using graphic symbols 
to show connections between different ideas, allowing the presenter to show a top 
level map and then drill down to show details for different connecting ideas. For 
presentation slides, you can start with a general, top level map and then create 
additional slides to drill down to the subtopics. You can summarize the sub points 
and then go back to the main, top-level mind map to show the connection to the 
whole. 

Mind Map Software: A graphic and conceptual layout that can be used for non-
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linear presentation.

SlideRocket is an online presentation platform that lets users create, manage, 
share and measure presentations. SlideRocket is provided via a monthly SaaS 
model or an annual subscription plan. You can also import your PowerPoint 
presentations or Google Presenter presentations into SlideRocket.

Users initially sign up for a free 14-day trial then decide which plan to 
subscribe to. Users can also use a free, basic version of the software. In addition, 
SlideRocket premiered the presentation resume with a variety of templates for 
users to promote themselves to different companies.

Prezi is a free application which allows you to create visual presentations by 
zooming in, out and around your visual workspace.Instead of individual slides, 
these ZUI’s (zoom user interface) are based on one infinite canvas on which all 
content is presented. This allows for non-linear presentations, richer detail of 
content, and a better overview of complex visual messages. Prezi also has a mobile 
app for tablet users.

Prezi: Prezi is web-based presentation software that uses zoom interface rather 
than individual slides.
Google Docs is now a part of Google Drive’s “software as a service” office suite. The 
free service includes it own presentation software that can be exported in open 
office format as well as Microsoft Office. Google Docs are automatically saved to a 
Google server, which prevents loss while also offering”anytime, anywhere” access.

2. Internet based collaboration

Another option with all these different packages is internet based collaboration. 
Using this method, several people revise content or review the changes as they are 
made by others.

J  Microsoft PowerPoint You Should be Using
PowerPoint is a highly innovative and versatile program that can ensure you a 
successful communication whether you’re presenting in front of potential investors, 
a lecture theatre or simply in front of your colleagues. Below are five features you 
should be using – if you aren't already. Learn everything about these tips: they 
will improve your presentation skills and allow you to communicate your message 
successfully.
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1. Adding Smart Art 

Don’t confuse SmartArt with the similarly named WordArt. Where WordArt just 
allows you to display text using a wide variety of different formats and effects, 
SmartArt is a comprehensive and flexible business diagram tool that greatly 
improves upon the ‘Diagram Gallery’ feature found in previous versions of Office.

Click the insert SmartChart Graphic to choose from a selection of options.

SmartArt can be used to create professional diagrams that include pictures and 
text or combinations of the two. An obvious use of SmartArt would be to create an 
organisation chart but it can be used for many different kinds of diagrams and 
even to provide some variety to slides using text bullet points.

2. Inserting Shapes 
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If you need to include some sort of diagram in your presentation, then the quickest 
and easiest way is probably to use SmartArt. However, it is important to be able 
to include shapes independently of SmartArt and worth being familiar with the 
various Drawing Tool format options.

Not only will they be useful if you do need to manually draw a diagram (and 
SmartArt doesn’t suit all diagrams), but they can also be applied to objects on a 
slide that you might not immediately think of as shapes. For example the box that 
contains your slide title or your content. This can be anything from text to a video, 
or even the individual shapes in a SmartArt diagram.

As you can see, the gallery of available shapes is very extensive. Once you 
have selected your chosen shape, you can just click in your slide to insert a default 
version of the shape or, to set a particular size and position, click and drag with 
the mouse to create the shape and size you want.

3. Inserting an Image

Here are two content type icons which appear in new content Placeholders for 
inserting pictures. You can Insert Picture from File or Insert Clip Art. Alternatively, 
the Illustrations group of the Insert ribbon tab includes the same two tools. In 
addition, PowerPoint 2010 has a new ‘Screenshot’ option that allows you to capture 
an entire window or part of a window for inclusion on a slide. You can also copy 
any image and just paste it directly to a slide. 

Insert Picture from File allows you to browse to an image file saved somewhere 
on your system whereas Clip Art is held in an indexed gallery of different media 
types. Clip Art is not limited to pictures: ‘The Results should be:’ box lets you 
choose between: ‘All media file types’ and one or more of the following different 
types: 

●● Illustrations
●● Photographs
●● Video
●● Audio
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Once you have found the image you want to use, click on it to insert it into the 
current slide. You can now re-size and move the image accordingly with further 
editting options available when you right click the desired image.

4. Slide Transitions

Properly used, slide transitions can be make your presentations clearer and 
more interesting and, where appropriate, more fun. Badly used, the effect of slide 
transitions can be closer to irritating or even nauseating. Simple animation effects 
are often used to add interest to bullet point text. Much more extreme animation 
effects are available but, in most cases, should be used sparingly if at all. 

Two main kinds of animation are available in a PowerPoint presentation: the 
transition from one slide to the next and the animation of images/text on a specific 
slide. 

In PowerPoint 2010 & 2013 there is also a separate Transitions ribbon tab 
that includes a gallery of different transition effects. These can be applied to 
selected slides or all slides. If you want to apply different transition effects to 
different groups of slides, then you might want to choose ‘Slide Sorter’ view from 
the Presentation Views group of the View ribbon. 
5. Adding Animations

Whereas the transition effects are limited to a single event per slide, animations 
can be applied to every object on a slide – including titles and other text boxes. Many 
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objects can even have animation applied to different components, for example each 
shape in a SmartArt graphic, each paragraph in a text box and each column in a 
chart. Animations can be applied to three separate ‘events’ for each object: 
Entrance – how the object arrives on the slide 
Emphasis – an effect to focus attention on an object while it is visible 
Exit – how the object disappears from the slide 

To apply an animation effect, choose the object or objects to be animated, then 
choose Animation Styles or Add Animation from the Animations toolbar.

Where an animation is applied to an object with different components (for 
instance a SmartArt graphic made up of several boxes), the Effect Options tool 
becomes available to control how each component will be animated. So for example, 
your animation can be used to introduce elements of an organisation chart to your 
slide one by one.

K.  PowerPoint Designer

Think of PowerPoint Designer or the Design Ideas tool as your personal presentation 
designer. Just type in a few lines of text to the slide, maybe an image or two, and 
voila! You have 8 different layout and design suggestions from PowerPoint! The 
first time you use it, you’ll probably be amazed by the visual feast PowerPoint will 
serve right before your eyes. The suggestions are random but can be breathtaking.

If you have an Office 365 subscription, you can go to the Design tab. The Design 
Ideas button should be on the right side of your screen, like you see here: 

Now, let me give you a quick peek into how this tool works!
Take a look at the screenshots below. I only wrote the word ‘Hello’ on the slide, 
and look at what the Design Ideas panel on the right side of the screen have come 
up with!

This is on PowerPoint (Mac): 
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This is on PowerPoint (Windows): 

As you can see, the same text (Hello) generated vastly different design ideas. On 
Mac, the suggestions were visually captivating with beautiful imagery used as 
background. On Windows, the suggestions were a bit basic to be honest. 

This is the beauty of Design Ideas – the suggestions appear to be random. So, 
if you’re not happy with any of the suggestions, you can give it another try and 
you’ll get a bunch of new ideas. 

So, for the next example, I deleted a couple of characters from the ‘Hello’ text, 
and then retyped them again. I got the following design ideas next: 

As you can see, it’s still the same text, but different design suggestions. So, if 
you’re not happy with the suggestions the first time around, try this technique. 
Perhaps the next round of design ideas may be more to your liking!

M.  Reasons why you will love PowerPoint’s Design Ideas tool
Here are reasons why I think you’re going to love PowerPoint’s Designer tool.

1. It’s a huge time-saver. 

The biggest reason why you should use Designer is because it’s going to help you 
save tons of time. Instead of spending hours manually drawing graphics and 
matching fonts and colors together, you can just click on Design Ideas and you’ll 
get a variety of options to choose from.
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Think about it for a minute: if you manually copy the design suggestions from 
Designer, how long do you think it’s going to take you to finish all 8 designs? A 
long time, probably, depending on the complexity of the design. But with Designer, 
you’ll have a good-looking design set up on your slide in just a few seconds! That 
includes the time to scroll down the list of design ideas and then clicking on the 
one you like!

If you need to come up with 50 slide designs, you can literally wrap everything 
in under an hour. You can just type your text on the slide, maybe add an image or 
two, and let Designer do its magic. With all your newfound free time, you’ll have 
the freedom to spend your day as you wish. Get away from the computer for a few 
hours and just chill with family and friends!

2. Plenty of professional layouts to choose from

Wouldn’t you agree with me when I say the designs looked good? Even if you found 
some of the designs to be too simple, you can always spruce it up and edit it to your 
liking.

On PowerPoint for Windows and Mac, Designer gives you 8 design layouts 
to choose from. However, on PowerPoint Online (the browser-based version of 
PowerPoint), you can have up to 10 design ideas.

The good thing is when you copy and paste your content to your slide (text 
and images), you don’t need to worry about formatting them. You don’t need to 
resize the images and make sure the foreground text is visible. It’s a pain to do 
this manually.

But with Designer, all these is taken care of. You can write your text first on 
the slide, and then put an image over the text. Designer will detect that there’s a 
text box and an image, and will give you different layouts to choose from where 
both elements are visible.

In case you’re wondering, the most common layouts suggested will include 
a graphic, an image, or an icon, even if there’s only text on the slide. So, if you 
have no time to look for images, just type your text on the slide, and see what 
PowerPoint Designer gives you!

3. Automatically add illustrations to your slides

This is one of my favorite Design Ideas features. If you type in a word or phrase 
that matches an icon from the Office 365 icons library, then Designer will add that 
icon to your slide.

Say, for example, your topic is about computers. You can just type the word 
‘computer’ on the slide, click on Design Ideas, and PowerPoint will suggest some 
layouts with a computer icon on it. Here’s what came up on my end:
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So, what can you do with this tip? Well, first of all, select the layout with the 
illustration. Then, start adding more content to the slide, and edit as you normally 
would.

This technique is so much better than adding all the text to the slide, and 
then not getting any Design Ideas at all. When there’s too much info on the slide, 
Designer can fail to deliver design ideas. I think putting your slide’s topic first, 
then applying a layout from Designer, will help speed up your workflow.

4. Convert text into graphic

Designer recognizes when you use lists on your slides. Even if you don’t format 
your list into either bullet or numbered list, it will still recognize your list. I tried 
to trick Designer by adding a list of unrelated words on the slide and look what it 
got me:

Note that for this particular example, I used PowerPoint Online to generate the 
ideas. As you can see, it was able to recognize the list. In the first 2 design ideas, it 
also added icons! In the 3rd design idea, it transformed the list into bullet points 
and added a graphic on the left side of the slide as well.

For the next example, I tried to add a series of dates to see if Designer will convert 
it into a timeline SmartArt graphic. Check out the result:
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You can see that Designer converted my holiday list into a timeline graphic. This 
is barely scratching the surface of what Designer can do!

If you need to add more dates to the list, you can either edit the text box again 
or just click on the graphic and a text box editor will appear. If you want to edit 
the graphic itself, just click it and you’ll be given the option to change the style, 
color, or layout.

As you can see in the screenshot below, we selected the first design idea shown 
in the previous image. We right-clicked on the graphic, then clicked on Layout. We 
got a bunch of different layout suggestions to change my timeline’s graphic.

Here’s what it looks like: 

Changing your SmartArt graphic’s appearance is just a click away. You can try 
inserting an image with your text, or just use an image and see what kind of 
designs PowerPoint will give you. It’s a pretty fun tool that will help you look like 
a professional designer even if you’re new to PowerPoint – and designing slides, 
in general! 

5. You’re free to edit your slides after applying a design idea
Another thing we love about PowerPoint Designer is its flexibility. When you select 
a design idea, it’s not set in stone. You can still edit the slide as you see fit, just like 
we showed you in the previous example.



MS Office

NOTES

Self-Instructional Material  101

But what’s even more awesome is that once you select a design idea, you can 
then use it to re-generate a new batch of design ideas! We used the same holiday 
SmartArt timeline from the example above and then clicked on Design Ideas. 
Here’s what we got: 

You can see on the Designer panel that it gave me a bunch of differently-designed 
timeline graphics. It uses a variety of colors as well which is really great. You can 
select the design which complements your presentation’s overall color theme.

To sum this point up, the Designer tool will help you generate some nice ideas 
for your slide. But you are still fully in control of the entire design process. You 
can scrap the design idea from Designer, or you can build on it and make it totally 
unique. Your call! 

6. The requirements for PowerPoint Designer

If you don’t see the Design Ideas tab in your copy of PowerPoint, then you probably 
don’t meet the following requirements:

●● PowerPoint on Windows/Mac – an active Office 365 subscription
●● PowerPoint Online (web version) – you don’t need an Office 365 subscription, 

but you need a OneDrive or SharePoint Online account
●● iOS – you need an iPad. This feature isn’t available on iPhones.
●● Android – you need an Android tablet. This feature is missing on Android 

smartphones.
●● Windows mobile – you need a Windows tablet to access PowerPoint Designer. 

This feature is not available on Windows smartphones.

7. �Don’t have an Office 365 subscription, but want to use PowerPoint De-
signer?

An Office 365 subscription can go as low as $6.99 per month (or $69.99 per year) 
for the Office 365 Personal plan. Whether you want to invest the money or not is 
up to you. 

Personally, we think the subscription is worth it because in addition to 
PowerPoint, you do have access to the entire Microsoft Office suite. Plus, you also 
get 1TB of storage on OneDrive. However, if you’re only going to be subscribing 
just so you can use the Designer tool, then we suggest you follow this tip below 



Computer 
Application 

in Apparel & 
Textile

NOTES

102  Self-Instructional Material

instead. 

Here’s a workaround if you don’t have a subscription, but really really want to use 
the Design Ideas tool (we don’t blame you, it’s a useful feature!): 

1.	� Sign up for a free Microsoft account as it automatically comes with 5GB 
OneDrive storage. 

2.	 You can then go to Office.com and login using your account credentials.
3.	 Click on the PowerPoint icon to open the app on your browser.
4.	� You’ll notice that when you go to the Design tab, you’ll see the Design Ideas 

button in there! Here’s a screenshot:

So, now you know that you don’t need to pay for a subscription if all you want is 
PowerPoint’s Designer feature! And what’s really cool about using PowerPoint 
Online is that you get 10 design suggestions as opposed to the 8 on either Windows 
or Mac desktop app. 

Now, here are a couple of ways you can go about taking advantage of the free 
Design Ideas tab on PowerPoint Online: 

Method 1: You can design your slides on PowerPoint desktop. Then upload your 
presentation file to PowerPoint Online and edit it using the Design Ideas feature.

Method 2: Just go directly to PowerPoint Online and work on your slides there. 
The downside to this method is that the web app is not as robust or as full-featured 
as the desktop version (specifically, PowerPoint for Windows). But if you just want 
a simple presentation without putting too much effort into the design, then this 
method is a great workaround.

8. �How to activate or enable PowerPoint Designer on your computer?

Now if you have an Office 365 subscription, but your Design Ideas button is missing 
in the Design tab, then it’s probably not activated. Here’s how you do it:

PowerPoint Windows:
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Go to File > Options. In the General tab, you’ll see the options for PowerPoint 
Designer. There are a couple of choices for you:

●● •	 If you want to automatically show design ideas every time you click on 
Design Ideas, then you should tick the option that says ‘Automatically show 
me design ideas.’

●● •	 If you want PowerPoint to automatically show you suggestions every time 
you open a new blank document, then you should tick the option that says 
‘Automatically show me suggestions when I create a new presentation.’

PowerPoint Mac:
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Go to PowerPoint Preferences or press the command and comma keys simultaneously 
(command + ,). In Authoring and Proofing Tools, click on General. You’ll then see 
the options for PowerPoint Designer. Just like the Windows version, make sure 
you tick on the two options.

Still don’t see PowerPoint Designer? Try these fixes.

If you know for a fact that you have an active Office 365 subscription, but still don’t 
see the Designer button in your copy of PowerPoint, then you should try these 
possible solutions:

●● If you’re coming from a standalone copy of Microsoft Office (not Office 365) 
and have recently subscribed to the service, you will need to uninstall your 
old copy. Then, you’ll need to install Office 365.

●● Check with your IT department if they’ve turned off the Designer feature 
(apparently, some organizations aren’t a fan).

●● Restart your copy of PowerPoint. If this doesn’t work, try restarting your 
computer.

●● Check if you have the latest version of PowerPoint. With an active Office 365 
subscription, you should receive the latest versions automatically. Unless, of 
course, you choose to manually disable updates for some reason.

9. Check your PowerPoint Windows version

To turn on automatic updates for PowerPoint, go to File > Account. 

If you’re running the latest version, you’ll get this message on your screen: 
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Now that you have the latest version of PowerPoint, you should be able to access 
the latest features. If, for some reason, the Designer button is still missing, check 
your version and build number. You can see this info in About PowerPoint, just 
below the Office Updates button. Here’s a screenshot:

As you can see, I am on the monthly channel and have version 1906.

If you no longer have an active subscription and can’t update PowerPoint anymore, 
you can check PowerPoint Designer’s requirements for Windows. Perhaps your 
version still gives you limited access to some designer features. Just scroll down 
the web page and you’ll see a section for Requirements. Here’s a screenshot of the 
page: 
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You can check your version and see what kind of design options are available for 
your copy of PowerPoint. For instance, if you only have Version 1511, you’ll get 
design ideas for a single photo only. You won’t get design suggestion if you have 
multiple photos. Neither can you convert your lists to SmartArt graphics.

If you have version 1603, you’ll get design ideas for a single photo as well as 
multiple photos. But it’s not going to convert your lists to SmartArt graphics. The 
requirements list is frequently updated, so make sure you visit that page regularly.

Alternatively, you can always upload your PPT file to PowerPoint Online. The 
web app has all the latest Design Ideas features, so if your desktop PowerPoint is 
outdated, try going online!

10. Check your PowerPoint for Mac version:

For Mac users, you can check for updates by going to the Help tab. Then click on 
Check for Updates. If your software is updated, you’ll see this message: 

I also recommend that you tick the ‘Automatically Download and Install’ button, 
so you get all the latest features from PowerPoint.

There’s not a lot of version requirements for Mac users. If you check the 
Requirements for MacOS, you’ll see this on your screen:
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According to Microsoft, PowerPoint Designer is available on Version 15.26.0.160910 
or later for Mac users. You can check your PowerPoint for Mac version by going to 
PowerPoint > About PowerPoint. Here’s a screenshot of my PPT version: 

As you can see, I have version 16.26 which means I should have access to all 
Designer features for PowerPoint Mac.

11. Design Ideas button is grayed out, what to do?

So, if you see the Design Ideas button in your copy of PowerPoint, but it’s grayed 
out, you may need to check your Internet connection. If you’re online but the 
button remains grayed out, then you should double check that you’ve selected a 
single slide. If you’re in between slides, your Design Ideas button will be grayed 
out. Here’s an example:
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12. �Have PowerPoint Designer button, but no design ideas generated?

It can be quite frustrating to add content to your slides, click on Design Ideas, and 
see nothing but a blank panel. And, of course, the message “Sorry, no design ideas 
for this slide.” Try the tips below to see if any of these will solve your problem:

●● The most likely culprit for this scenario is actually your Internet connection. 
Designer needs a stable connection to the web to function properly.

●● Use a default PowerPoint theme, not one that you downloaded elsewhere. You 
can choose your theme by going to Design > Themes. Choose from any of the 
available themes that show up in the Office section. Here’s a screenshot:

●● Someone else is editing the slide you’re working on. You can either wait for 
that person to finish, or ask them to go work on another slide (this works if 
you’re the boss).

●● There’s no content on the slide. Add some text or photo, and let Designer do 
its magic!

●● You’ve drawn a shape on the slide. As of this time, Designer (Windows/Mac/
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Online) doesn’t support shapes. But you can insert icons, SmartArt graphics, 
tables, and charts, and Designer will give you several design ideas!

Pro Tip: If you absolutely must use a shape on the slide, I would suggest removing 
the shape first. Then select a new layout from the Designer panel. Afterward, you 
can insert your shape anywhere you want on the slide! 

●● There are too many images on the slide. Currently, Designer can only 
accommodate up to 6 images. If you insert 7 images, Designer will let you 
know there are too many images. I find this is a super cool way to get your 
photos resized into several different layouts. You can do it with SmartArt too, 
but with Designer, there are no extra text boxes added. Just images. Check 
out this example:

As you can see, you can just insert all images into the slide all at once. No need to 
rearrange anything. Designer will automatically do it for you!

Now, if you want to add more images, we would recommend you insert 6 images 
first. Then select the Designer layout you want to use. And then, add all the other 
images you need to show on the slide. This may take some maneuvering, but at 
least Designer gets you halfway there. You just need to make a few extra clicks 
depending on how many extra images you want to add! If you want to know more 
about working with multiple images in PowerPoint, check out this chapter.

●● You’ve got too many charts on the slide. As of this time, Designer can only 
generate ideas if you’ve only got a single chart on the slide. Otherwise, you’ll 
get the message, “Having multiple charts isn’t supported right now. Design 
Ideas will appear here when you’re working on a slide without multiple charts.”

●● There are too many elements on the slide. Ideally, the fewer elements you have 
on the slide, the better. If, for example, you add text, a photo, and an icon to the 
slide, Designer isn’t going to work. But if you delete the icon (thereby leaving 
the text and photo on the slide), Designer will give you several suggestions. 
Keep your slide simple at first, and once you’ve selected a Designer layout, feel 
free to add more elements to the slide.
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13. How to disable PowerPoint Designer?

The answer is you can’t. But you can turn off automatic Designer suggestions. Just 
head on over to PowerPoint Options (on either PC or Mac) and untick the boxes in 
the PowerPoint Designer section. You’re not going to get automatic suggestions, 
but you can still view the Design Ideas in the Design tab. You’re just going to 
manually click on the button to get some design suggestions.

1.8  SUMMARY

Microsoft has gone away from using the menu format in favor of the tab format, 
or tool ribbon. In this format, each tab across the top of a document opens a new 
set of options in the ribbon format - options and buttons are laid out horizontally 
along the top of the document page. Here, we'll review the nine standard tabs in a 
Word document.

File: When you open a new file in Word, the first tab you will see is File. Look 
carefully - you may miss it because it is a different color than the other tabs 
(depending on what color scheme you have your desktop set on). The File tab has 
just what you would think: options related to the entire file, such as save, print, 
share, and open.

Home: The Home tab has the most commonly used features, especially as they 
relate to modifying text. In the Home tab you can select your font, size, color, 
attributes (bold, italics, underline), and alignment (left, center, right). You can 
also select a style, which is a predetermined text made to fit certain document 
parts, such as headings, subtitles, and text.

Insert: Under the Insert tab, there are a number of choices. In a Word document, 
there are many types of visual aids and highlights you can add to a file to help 
summarize and present information. It's in the Insert ribbon tab where you can find 
options for graphics, charts, hyperlinks, page breaks, headers, footers, textboxes, 
and reference information, such as date and time, comments, page numbers, and 
bookmarks.

Design: The Design tab can be either very useful or hardly used, depending on 
your own understanding of Word. Most of the space in the Design tab is taken 
up by examples of document designs that you can select, such as documents with 
centered titles, offset headings, and left justified text. However, in addition to 
those less popular tools, the Design tab also includes watermarks, page color, and 
page borders, which may be used by advanced Word users.

Page Layout: The Page Layout ribbon is an important tab to determine how 
your document looks. This is the tab that has the options to modify margins, page 
orientation, paper size, columns, indents, spacing, page breaks, and the arranging 
of any parts of the document, such as text and graphics or tables.
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References: The References tab is one that you may never use, or may be used 
heavily, depending on the type of work you do in Word. For students, the References 
tab is the easiest way to insert citations and references into the Word document. It 
can help with creating the reference page, table of contents, footnotes, and sources.

Every commercial establishment uses Microsoft Office Excel in some way or 
the other. It is the layman’s best friend to compute data and use formula for basic 
calculations. Even without specific accounting software, you can input data and 
create sheets for basic accounting purpose with the help of Excel.

The Excel has some really effective options to edit data the way you want. No 
matter how simple or complex your data is, you can create a comprehensive report 
using various formula provided in Excel.

With Excel, you can not only enter data and calculate them; you can edit; 
filter or format them the way you want. The tool has infinite spreadsheets to 
accommodate extensive data base so that you arrange all your data in specific 
individual files.

Excel files can be as large or small as per your need and you can insert 
additional sheets if required.

Although Excel is a fine spreadsheet, it is not a statistical data analysis 
package. In all fairness, it was never intended to be one. Keep in mind that the 
Data Analysis ToolPak is an "add-in" - an extra feature that enables you to do a few 
quick calculations. So it should not be surprising that that is just what it is good 
for - a few quick calculations. If you attempt to use it for more extensive analyses, 
you will encounter difficulties due to any or all of the following limitations:

●● Potential problems with analyses involving missing data. These can be 
insidious, in that the unwary user is unlikely to realize that anything is wrong.

●● Lack of flexibility in analyses that can be done due to its expectations regarding 
the arrangement of data. This results in the need to cut/paste/sort/ and 
otherwise rearrange the data sheet in various ways, increasing the likelyhood 
of errors.

●● Output scattered in many different worksheets, or all over one worksheet, 
which you must take responsibility for arranging in a sensible way.

●● Output may be incomplete or may not be properly labeled, increasing possibility 
of misidentifying output.

●● Need to repeat requests for the some analyses multiple times in order to run 
it for multiple variables, or to request multiple options.

●● Need to do some things by defining your own functions/formulae, with its 
attendant risk of errors.

●● No record of what you did to generate your results, making it difficult to 
document your analysis, or to repeat it at a later time, should that be necessary.

If you have more than about 10 or 12 columns, and/or want to do anything beyond 
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descriptive statistics and perhaps correlations, you should be using a statistical 
package. There are several suitable ones available by site license through OIT, or 
you can use them in any of the OIT PC labs. If you have Excel on your own PC, 
and don’t want to pay for a statistical program, by all means use Excel to enter 
the data (with rows representing the subjects, and columns for the variables). All 
the mentioned statistical packages can read Excel files, so you can do the (time-
consuming) data entry at home, and go to the labs to do the analysis.

When you want to create the best presentations in the easiest way, Microsoft 
Office PowerPoint is the tool to use. You can create just the perfect presentation 
to impress your audience without any fancy applications just by using Microsoft 
PowerPoint.

The Microsoft PowerPoint is indeed a powerful application that allows you 
to add drama and highlights to your presentation. You can use the application 
to enhance your presentations by adding picture, text and even videos. Your 
presentations thus become more engaging and interactive and audience can relate 
to it better.

Advanced uses of PowerPoint allows you to create master slides as templates, 
inserting other Office documents, inserting and editing text boxes, cross-linking 
and much more.

Microsoft SharePoint is a tool that allows you to organize, store and share 
information across different platforms. You can also create your own website 
with this tool. The SharePoint allows you to organize and manage information for 
effective and efficient dissemination.

Whether your project is small or large, you can collaborate with co-workers 
anytime, anywhere with the SharePoint.

A thorough knowledge of SharePoint allows you to create lists, manage 
calendars, coordinate libraries and edit documents and much more.

1.9  GLOSSARY

accelerator key			   : �Any combination of keys that are pressed 
simultaneously to run a command.

allocated command		  : �A built-in command that requires the user 
to specify a value for a parameter when 
customizing the command.

anchor				    : �A set of qualifiers and quantifiers that 
specifies the location of an element or object 
within a document. These values are typically 
relative to another element or known location 
in the document, such as the edge of a page or 
margin.
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annotation bookmark		  : �An entity in a document that is used to denote 
the range of content to which a comment 
applies.

ASCII					    : �The American Standard Code for Information 
Interchange (ASCII) is an 8-bit character-
encoding scheme based on the English 
alphabet. ASCII codes represent text in 
computers, communications equipment, and 
other devices that work with text. ASCII 
refers to a single 8-bit ASCII character or an 
array of 8-bit ASCII characters with the high 
bit of each character set to zero.

Augmented Backus-Naur		 : A modified version of Backus-Naur Form 
Form (ABNF) 			    �(BNF), commonly used by Internet 

specifications. ABNF notation balances 
compactness and simplicity with reasonable 
representational power. ABNF differs from 
standard BNF in its definitions and uses of 
naming rules, repetition, alternatives, order-
independence, and value ranges. 

auto spacing			   : �A condition in which space is inserted 
automatically before and after a series of 
consecutive paragraphs that do not have 
breaks or other items between them.

AutoCaption			   : �A feature that adds a caption to an object 
automatically when the object is inserted in 
a document.

AutoCorrect				   : �A feature that corrects errors and makes other 
substitutions in a document automatically by 
using default and user-defined settings.

auto-hyphenated			   : �A condition of content where the distance 
between the text is measured and maintained 
to force breaks automatically in elongated 
words that would not otherwise end correctly 
on a line.

automark file			   : �A file that stores the text, location, and index 
level of a set of characters that were marked 
for inclusion in a document index.

AutoSummary			   : �A process in which key points are identified 
in selected text by analyzing document 
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content. A score is assigned to each sentence; 
sentences that contain frequently used words 
are given a higher score.

AutoText				    : �A storage location for text and graphics, such 
as a standard contract clause, that can be used 
multiple times in one or more documents. 
Each selection of text or graphics is recorded 
as an AutoText entry and assigned a unique 
name.

bar tab				    : �A tab that specifies where to draw a vertical 
line or bar in a paragraph. It neither affects 
the position of characters nor creates a 
custom tab stop in a paragraph.

bidirectional compatibility	 : �The ability to display and process text in two 
directions, right-to-left and left-to-right.

big-endian				    : �Multiple-byte values that are byte-ordered 
with the most significant byte stored in the 
memory location with the lowest address.

1.10  REVIEW QUESTIONS

1.	 Discuss the Annotations and Drawing Tools.
2.	 What kind of Using Startup Code?
3.	 What are the various functions a Drawing Toolbar?
4.	 Uses of Microsoft Excel: Excel tools make your work easier
5.	� Mention what is the difference Costing sheet in Excel and Costing sheets 

for handbags?
6.	 What is Sportswear?
7.	 How To Know What is Lingerie?
8.	 What Are The Principles For MS Paint Window?
9.	 What Is Editing Photos Using Paint?
10.	 Which of the PowerPoint—Advantage or Disadvantage for the Presenter??
11.	 What is The Elements of a Slide?
12.	 Explain the Alternatives to PowerPoint Presentation Software.
13.	 How to activate or enable PowerPoint Designer on your computer?
14.	 Have PowerPoint Designer button, but no design ideas generated?
15.	 How to disable PowerPoint Designer?
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2.1  LEARNING OBJECTIVE

After studying this unit you should be able to:
●● Describe the CorelDRAW Tools.
●● Explain the meaning and significance of Tool Bar.
●● Explain the procedure of Symmetrical nodes.
●● Describe the technology for Drawing lines and Tools.
●● Explain the Working with the Mesh Fill tool.
●● Explain the meaning and significance of Creating a Geometric Fashion 

Mannequin in CorelDRAW.
●● Explain the Corel DRAW Software to Apparel Design.

2.2  INTRODUCTION

Color Trapping is a major aspect in the apparel decorating (screen printing) industry 
as well as any printing industry for that matter. Most artists supplying designs to 
screen printers are expected to supply accurate color separations utilizing chokes 
and spreads (traps). Color Trapping is the spreading, overprinting or under cutting 
of objects in order to prevent printing inaccuracies such as registration issues. One 
of the most widely seen issues in the textile screen printing industry is the poor 
registration where the white underbase (white printer for dark shirt printing) is 
visible where it should not be visible.

UNIT

2
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2.3 Introduction of Corel Tools and its Uses
2.4 Different tools used in Corel Draw
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Understanding Color Trapping and the various methods to utilize them will ensure 
your prints are correct along with ease of setup and in many cases will speed up 
the overall production.

Trapping and Overprinting can be set in multiple ways within CorelDRAW; 
directly in your document with each object, on the Separations Tab in the 
Document Overprints dropdown list or by using the Automatic Trapping 
option in the print dialog. 

The basic methods for Trapping are Overprint, Choke and Spread. Note: 
Spread is generally described as Trapping in the apparel decorating industry.

Overprint is where one object or color prints directly over another.

Spread (Trapping) is where a thin line (outline) is added to the edges of the 
objects where the object is cut out of the underlying object. The spread overprints 
the underlying objects. Essentially, an outline is added to the top object to make 
it larger.

Choke is where the underlying object is given a small outline so that the top 
object overprints the underlying object or color. Essentially, the bottom object is 
given an outline so that it prints larger than the original object.

Manually setting Traps on objects when designing can ensure an accurate 
separation for your screen printer. Sometimes you may forget to add traps when 
designing and a global choke and spread size may not work due to varying sized 
elements in your design. This is when manual color separations and trapping are 
needed. Small type with serifs may not allow a .5 choke while other elements in 
the design warrant a .75 choke or trap.
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Fig shows a side view of a Butt registered element where the colors or objects 
are exactly the same on top of each other. The Spread or Trap shows where the 
top color has an outline to make the top color slightly larger than the bottom or 
underlying color and a Choke where the underlying color has a white outline to 
make it slightly smaller than the top color or object.

The following steps will show you how to apply Chokes and Traps to a manual 
separation in CorelDRAW. In this design, we will be adding Chokes and Traps 
to a simple spot color design that will be printed on dark t-shirts where a white 
underbase (white printer) is needed yet NO white is supposed to show in the print.

Step 1: Create your design and size it to final print size.

Step 2: Add registrations marks and labels (ink colors)

Step 3: Duplicate your design for each color to be printed or copy and paste to a 
new page for each color to be printed.

Step 4: Convert each color plate to Black & White or Grayscale if halftones are 
used in the design.
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Step 5
●● Apply a white outline to all objects on the white plate (white printer or 

separation). This will make the white slightly smaller so the top colors cover 
all of the white underbase. This is also referred to as Choking.

●● Apply a black outline to the top colors (plates or separations)

In some instances, you may only be able to apply one or the other, Choke or 
Trap, due to the object properties or how the objects are stacked in the design. 
Practice, printing equipment and the inks used will also play a role in dictating 
which method is used or if both Chokes and Traps are warranted. Basically, some 
R&D and trial and error will turn anyone into a good color separator.

In the diagram below, it shows the outlines in the color of the actual plate. 
For the manual separations you would use black or white outlines for your Traps 
or Chokes.

Step 6: Print your separations to film knowing the final print will look as expected 
and there should be no issues with registration.

A.  CorelDRAW Tools 

CorelDRAW is a graphics and drawing program that is vector-based and developed 
by a software company based in Ottawa called Corel. When you sketch an object on 
the CorelDRAW drawing page using the tools that are available, a mathematical 
formula determines the structure of the object that is displayed on the screen.

Computer graphics programs can be classified into two groups: Bitmapped 
programs like Adobe Photoshop where images are produced in the shape of 
bitmap and programs that use vector graphics where the graphics comprise of 
mathematical curves. CorelDraw can be considered in the group of vector graphic 
program.

You will be able to create any graphic image file that you need with the help of 
CorelDRAW. There are many tools available in CorelDRAW with the help of which 
you can create logos, motifs, signs, etc.
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Figure:2.1 Tool Bar 

B.  Different Tools In CorelDRAW

Below are some important tool in CorelDraw which are as follows:

1. Pick Tool

This tool allows you to pick or select the object and transform it. You can position 
the object too.

2. Shape Tool

If you want to edit the shape of objects chosen by the pick tool then you can use 
this tool.

3. Free Transform Tools

This tool allows you to alter the image objects with the help of rotation angle, 
rotation free, and resize. It also lets you bend the image structure.

●● Smudge Brush: This tool will help you to change as well as distort the picture 
in general with engaging shorelines.

●● Roughen Brush: This tool will let you change as well as distort the outline 
shape of the sketch in general with engaging shorelines.
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4. Crop Tool

This tool can be used in clipping the region of an image that is not needed.
●● Virtual Segment Delete: If you want to remove an object which is a part of 

an intersection then you can use this tool.
●● Erase: It helps to get rid of some areas of the image.

5. Zoom Tool

It helps you in changing the level of magnification in the illustration window in 
order to look at the object more intently. In simple words, it is used as a magnifying 
glass.

●● Hand: It helps in balancing the images that materialize in the image window

6. Curve Tools

●● Freehand Tool: This tool with the help of a mouse lets you sketch curves and 
lines. Essentially it is used for sketching.

●● Bezier: It helps to draw curves in the shape of a solitary line per point.
●● Pen: It helps in sketching curves in the form of a node.
●● Three-Point Curve: It helps you in drawing a curve first by identifying the 

start and the end point, then it’s center.
●● Poly-line: It lets you sketch curves and lines in preview mode.
●● Dimension: It helps you sketch a horizontal, vertical, oblique and angular line.
●● Interactive Connector: It lets you combine the two objects accompanied by 

a line.

7. Artistic Media Tool 
It helps in accessing the sprayer, brush, calligraphic, preset and pressure tools.

8. Rectangle Tool 

This tool helps you in drawing squares and rectangles to initiate boxes and terms.
●● Three-Point Rectangle: If you want to arrange boxes and create terms from 

one point to another point then this is the tool.
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9. Ellipse Tool

This tool helps you sketch circles and ellipses.

10. Polygon Tool

If you want to sketch stars and polygons in a symmetric manner then you can use 
the polygon tool.

●● Star: This tool can be used to draw stars.
●● Complex Star: This tool allows you to create stars that have intersection 

angles and complex shapes.

11. Basic Shapes Tool

This tool helps you to select from a complete set of forms such as a right-angle 
triangle, smiley face, and a hexagram. You can draw arrows and slanted rectangles.

●● Arrow Shapes: You can draw arrows ranging from diverse shapes such as 
arrowheads, direction, etc.

●● Flowchart Shapes: You can create a flowchart with this tool.

12. Text And Table Tool

This tool helps you in typing words straight on the screen as a paragraph text or a 
creative text. The table tool helps you in creating and editing tables.

13. Dimension Tools 

This tool allows you to draw numerous lines like segment, slanted, horizontal, 
vertical, and three-point dimensions.
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14. Connector Tools

This tool helps you in drawing a straight line, right-angle, edit anchor connector 
line and rounded right-angle connector lines.

15. Interactive Tools

●● Interactive Blend: Boxes and terms can be created using this tool.
●● Interactive Distortion: It helps you in applying a pull or push distortion and 

a zipper distortion to an object.
●● Interactive Drop Shadow: It helps you to put an object into the shadow.
●● Interactive Fill: It helps you to apply numerous amount of fills to an object.
●● Interactive Mesh: If you want to apply network lines to an object then you can 

use this tool.

16. Eyedropper Tool

Object properties like size, line thickness and effects can be selected and copied 
using the eyedropper tool.

17. Outline Tool

This tool lets you open a fly-out that helps you in setting the outline properties.

18. Fill Tool

This tool lets you open a fly-out that helps you in setting the fill properties.

C.  Coreldraw ToolBox and its Functions

1.   �Pick Tool = To select, resize, and rotate toward the image object.

2.   �Shape Edit 
●● Shape : Editing an image object shape.
●● Smudge Brush : Alter / distort the overall picture with attractive 

shorelines.
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●● Roughen Brush : Alter / distort the overall outline shape drawing by 
attractive shorelines.

●● Free Transform Tools : Transform image objects using rotation 
(rotation)free, rotation angle, and resize, and also tilt the image shape.

3.   �Crop Tool
●● Crop : Eliminate the unwanted parts in the object.
●● Knife : Alter / distort the overall picture with attractive shorelines.
●● Erase : Remove the area in the picture.
●● Virtual Segment Delete : Delete an object that is part of the intersection 

(the intersection).

4.   �Zoom
●● Zoom : Change the magnification of the image in the image window
●● Hand : Adjusts the images that appear in the image window

5.   �Curve
●● Freehand : Draw segments or curves in the form of a single line
●● Bezier : Drawing curves in the form of a single line per point (node)
●● Artistic Media Tool : Bring up the generator function form (pen), such 

as brush (brush effect with a particular pattern of outward appearance), 
sprayer (spray paint effects), calligraphic (calligraphy pen effects), and 
Pressure (pen effects techniques that will form the curved edge without 
lines).

●● Pen : Drawing curves in a segment point to point (node).
●● Polyline : Drawing lines and curves in preview mode.
●● 3 Point Curve : Draw a curve by specifying the start and end point, then 

the center of the curve.
●● Interactive Connector : Combining the two objects with a line.
●● Dimension : Draw a vertical line, horizontal, angular, and oblique.

6.   �Smart Tools 
●● Smart Fill : To create objects of an area then fill with color or texture.
●● Smart Drawing : To change your pointer graffiti images to form the basis 

of its form or shape that is more subtle.

7.   �Rectangle
●● Rectangle : To establish terms and boxes.
●● 3 Point Rectangle : To establish terms and arrange boxes with point 

to point.

8.   �Ellipse
●● Ellipse : To draw an ellipse to a circle.
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●● Hand : Adjusts the images that appear in the image window.

9.   �Object
●● Polygon : To form a polygon and star symmetrically.
●● Star : To form stars.
●● Complex Star : To form stars with more complex shapes with intersection 

angles.
●● Graph Paper : To establish a similar arrangement of tables or boxes 

such as engineering drawings on paper.
●● Spiral : To form a spiral (per) is symmetrical and logarithmic.

10.   �Perfect Shapes
●● Basic Shapes : A variety of forms so as octagonal, smiley face, until the 

triangle.
●● Arrow Shapes : To facilitate drawing arrows with various forms of 

variation form, direction, and number of arrowheads.
●● Flowchart Shapes : To facilitate drawing flowchart shapes (chart).
●● Banner Shapes : To make it easier to draw shapes and symbols tape 

explosion.
●● Callout : To make it easier to draw and label the speech bubble shape.

11.   �Text Tool = To make the text directly in the drawing area that serves 
as both an artistic and caption text.

12.   �Interactive Tools
●● Interactive Blend : To establish terms and boxes
●● Interactive Contour : To establish terms and arrange boxes with point 

to point
●● Interactive Distortion : To distort objects in push / pull, zipper, and 

twister.
●● Interactive Drop Shadow: To insert an object into the shadow
●● Interactive Envelope : To change the shape of the object by dragging 

a point (node) on the outline
●● Interactive Extrude : To form the illusion of depth on the object.
●● Interactive Transparency : To insert a transparent effect on the object.

13.   �Eyedropper
●● Eyedropper : To select and copy the relevant properties of an object, such 

as color (fill in the object), lines, line thickness, size, and effects.
●● Paintbucket : To implement the related property of an object, such as 

color (fill in the object), lines, line thickness, size, and effects; taken by 
the eyedropper tool, to other objects.
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14.   �Outline
●● Outline Pen Dialog : To access the outline pen dialog box
●● Outline Color Dialog : To access the color settings dialog box outline
●● No Outline : To eliminate the outline of an object.
●● ½ Point Outline : To establish the thickness of ½ point line
●● 1 Point Outline : To form a line thickness of 1 point
●● 2 Point Outline : To form the 2 point line thickness.
●● 8 Point Outline : To form the line thickness 8 points.
●● 16 Point Outline : To form the 16 point line thickness.
●● 24 Point Outline : To form a 24-point line thickness.
●● Color Docker Window : To open the docker for setting color and object 

outline.

15.   �Fill Tools
●● Fill Color Dialog : To access the settings dialog box of paint (charger 

interior of the object) of an object.
●● Fountain Fill Dialog : To access the dialog box filler color and gradation 

to the object.
●● Pattern Fill Dialog : To access the dialog box filler patterns into objects.
●● Texture Fill Dialog : To access the dialog box filler into the texture object.
●● Post Script Fill Dialog : To access the dialog box filler image post-script 

to the object.
●● No Dialog : To eliminate the filler element of an object
●● Color Docker Window : To open the docker for setting color and object 

outline.

16.   �Interactive Fill
●● Interactive Fill : To fill a variety of fill (filler objects) into an object.
●● Interactive Mesh : To apply network lines on an object. may be useful

2.4  DIFFERENT TOOLS USED IN COREL DRAW

1. The Curve Tools

Drawing objects in CorelDRAW is accomplished by using a variety of tools found 
in the Toolbox. In this Tutorial, we will look at the Curve Tool Flyout. The curve 
tools include: the Freehand tool, the 2-Point Line tool, the Bezier tool, the Artistic 
Media tool, the Pen tool, the B-Spline tool, the Polyline tool, and the 3-Point Curve 
tool. Once properly mastered, the use of these tools will make design creation 
simple and accurate.
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2. Controlling Nodes

Before looking at the various curve tools available in CorelDRAW, we must look 
at the types of nodes that can be created, and how they are controlled. The figure 
below shows what a node would look like if selected with the Shape tool. The Shape 
tool is the standard tool for moving an manipulating nodes. This node pictured is 
what a cusp node would look like.

3. Cusp Node

Cusp nodes let you create sharp transitions, such as corners or sharp angles, in a 
curve object. You can move the control handles in a cusp node independently of one 
another, changing only the line on one side of the node.

4. Smooth Nodes

With smooth nodes, the lines passing through the node take on the shape of a 
curve, producing smooth transitions between line segments. The control handles 
of a smooth node are always directly opposite one another, but they may be at 
different distances from the node.

5. Symmetrical nodes

Symmetrical nodes are similar to smooth nodes. They create a smooth transition 
between line segments, but they also let you give lines on both sides of a node the 
same curve appearance. The control handles of symmetrical nodes are directly 
opposite each other and at an equal distance from the node.

6. Line Nodes

Line nodes let you shape curve objects by changing the shape of their segments. 
You can make a curved segment straight or a straight segment curved. Making 
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a straight segment curved does not noticeably change the segment’s appearance, 
but it displays control handles that you can move to change the segment’s shape.

Now that we understand the various types of nodes in CorelDRAW, we can look at 
the tools used to create objects and then look at how to modify these objects by adding 
nodes and using the various types of nodes to make the necessary adjustments. 
For the purpose of this tutorial, we will only be looking at the freehand tool. While 
there are a number of other tools available, we will save them for future tutorials 
that will allow us to better focus on them.

7. Drawing lines

Now we can move on to the various curve tools available in CorelDRAW. The 
Curve Tool Fly-out that lets you create both curved and straight line segments.

8. Freehand and Polyline tools

The Freehand tool lets you control the smoothness of the curved line you are 
drawing as well as add segments to an existing line. However, the Polyline tool is 
easier to use for quickly drawing a complex line that consists of alternating curved 
and straight segments and allows you to draw in preview mode..

9. 2-point Line tool

You can draw straight lines by using the 2-point line tool. This tool also allows you 
to create straight lines that are perpendicular or tangent to objects.

10. Bezier and Pen tools

The Bezier and Pen tools let you draw lines one segment at a time by placing each 
node with precision and controlling the shape of each curved segment. The Pen 
tool gives you the added ability to preview the line segments as you are drawing.

11. Artistic media

The Artistic media tool provides access to the Brush, Sprayer, Calligraphic, and 
Pressure tools.

12. B-spline tool
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The B-spline tool lets you draw curved lines by setting control points that shape 
the curve without breaking it into segments.

13. 3-point Curve tool

The 3-point curve tool lets you draw simple curved lines by specifying their width 
and height. You can use this tool to create arc shapes quickly without manipulating 
nodes.

We are going to use a this tool to show how easy it is to recreate a logo from a 
low resolution (72dpi) bitmap.

Select the Freehand tool and we will start by doing a single left mouse click on 
the top of the letter "C" of our logo as indicated by the letter "A". Next, double left 
click on the top right corner then follow around the straight edges, double clicking 
as you go. A single left click will end it off. Recreate the path as indicated below.

Once the object has been created, select the 4 nodes on the left side vertical lines 
with the shape tool. Next, on the Interactive property bar, select the Convert to 
Curve icon.

This will then allow you to use the shape tool to drag the control handles out to 
match the curvature of the image below.

Once you are satisfied with the shaping of the path around this character, give it 
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a solid contrasting Colors, this way it is easier to see your progress. You can then 
move on to the next character.

When creating a character or object that is made up of multiple paths or areas 
that need to be "knocked out" such as in the letters A,a, B,b, D,d, O,o P,p Q,q or R 
remember that the objects need to be combined once they have been created. This 
can be done from the Arrange menu and select Combine, once both objects have 
been selected.

Using this process you will find it easy to re-create almost any image you wish. 
Some may take a bit more time than others, but in the end, you will have a piece 
of artwork that will remind you just how easy it is to recreate in the CorelDRAW 
Graphics Suite.

A.  CorelDRAW: Basic Drawing Tools

Whether you're fresh to vector, or you're an Adobe Illustrator user expanding your 
vector horizons, learning the basic tools of CorelDRAW is a worthy task. We're 
going to start with drawing tools such as the Pen Tool, Freehand Tool and 
3-Point Curve Tool, as well as a review of some commonly used dockers and 
toolbars.

1. The Pen Tool

Step 1

Start by creating a New Document (Control-N) at your preferred work size 
(you can change this any time while working), in RGB color mode, and at 300 dpi. 
These are my preferred settings, but if you'd rather work in CMYK for printing 
purposes, do so (while remembering to switch to RGB when exporting for web 
use).
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Step 2
Let's start with the Pen Tool (you'll find it in the Toolbox, to the left, under the 
Bézier Tool). This tool works just like the Pen Tool found in Adobe Illustrator 
and Adobe Photoshop.

You place Nodes and draw curves in segments. We're going to start with a cute 
little ghost shape:

1.   �Place one Node and curve up and to the left. This is the start of the tail.

2.   �Continue curving around to the right to form the top of the ghost and back down 
to the right to join with the original Node. Notice that while you're placing 
anchor points, you get a preview of the curve you're drawing. It's quite helpful.

3.   �You can edit your Node handles with the Shape Tool (F10), and you'll find 
additional options for editing within the Property Bar (Window > Toolbars 
> Property Bar).

Step 3

To edit your newly drawn object, go to Window > Dockers > Object Properties 
or hit Alt-Enter. In this docker you'll find an assortment of options for your 
selected object.

For the purposes of this tutorial, select Outline and change the width of your 
stroke to 2.0 pt, color to black, and both Cap and Corner for the Rounded options.

Select the next option within the docker, Fill, select Uniform Fill, and change 
the color to white. We'll explore other options within this docker in future tutorials 
and quick tips.
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2. Freehand and Bézier Tools

Step 1

Using the Freehand Tool (F5) is fairly simple if you're drawing with a graphics 
tablet. Draw an additional ghost shape. Instead of choosing where your Nodes 
appear, they'll be added automatically depending on what level of Freehand 
Smoothing you've set in the Property Bar.

1.   �I started with a low setting of 12 for Freehand Smoothing. This example was 
quickly drawn with a mouse. Note how it has an abundance of Nodes and is 
quite choppy in shape.

2.   �I changed the Freehand Smoothing setting to 97. Again, this was drawn quickly 
with my mouse. It has 3 Nodes in total.

3.   �Note how smooth the second, object is compared to the first. Your settings in 
the Property Bar matter quite a bit when using drawing tools in this program.

Step 2

1.   �Now that we have a second little ghost, we want its stroke and fill attributes to 
match. Instead of changing the new object's attributes in the Object Properties 
docker, use the Attributes Eyedropper found within the Toolbox.



Computer 
Application 

in Apparel & 
Textile

NOTES

132  Self-Instructional Material

2.   �Select the first ghost with the eyedropper.

3.   �Select the second ghost, and all of its attributes are copied over into the second 
shape. For extremely simple objects like those seen below this seems hardly 
worth it, but when you're using a variety of transparency, gradient, and 
blending mode settings it'll save you so much time in the long run when you 
need to create similar items within your artwork.

Step 3

To illustrate the further use of drawing tools, we'll work with the Bezier Tool 
to draw a face onto the first ghost. As with the Pen Tool, you draw curves in 
segments.

1.   �Start with a small mouth. Draw a curve that dips downward. Hit Enter or 
Shift to stop the curve.

2.   �Repeat for the eyes. Change the weight of all lines drawn in the Object 
Properties docker.

3.   �I prefer the Pen Tool over the Bézier Tool for shapes like the ones created 
for the second face: two funny little circle eyes and a wide, open mouth. You'll 
notice it's difficult to draw curving shapes that stop sharply at a Node and 
move into the next curve. Which tool you use for projects will depend on your 
needs in drawing.
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4.   �Set the Fill color to black for all three new shapes.

3. B-Spline and Smart Drawing Tools

Step 1

These little ghosts need crowns. Using the B-Spline Tool, start with a line that 
curves to the right and up. Notice that the further inward to the center you place 
your Nodes, the more curved your edges and corners become.

The shape drawn below has 7 Nodes in total. Set the Fill color to bright orange in 
the Object Properties docker.
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Step 2

The Smart Drawing Tool (Shift-S) is quite similar to the Freehand Smoothing 
options of the Freehand Tool.

1.   �In the Property Bar, you'll find two options with drop-down menus: Shape 
Recognition Level and Smart Smoothing Level. To start, set both to None.

2.   �With both level options set to None, I've drawn another simple and quick 
ghost-like shape with my mouse. It takes a moment for the smart drawing to 
load. Note how choppy and Node-filled it is.

3.   �Set both level options to Highest and redraw the same shape. Note how smooth 
and simple it is with only 2 Nodes.

4.   �See the difference between the two shapes and the extremes of their settings 
below.

4. 2-Point Line and 3-Point Curve Tools

Step 1

We're going to give the ghosts a long overdue rest and draw a spider web with the 
final two tools we'll review in this tutorial.

1.   �Start with the 2-Point Line Tool and draw a long vertical line. In the Object 
Properties docker, change the line weight to 3.0 pt, color to black, and Cap 
and Corner to Rounded.

2.   �Keep the vertical line selected and start the horizontal line at the top Node. 
This will continue the object without having to draw a new one.
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3.   �Draw four thinner, diagonal lines radiating outward from the corner of the 
previous object. Group (Control-G) your objects together.

Step 2

1.   �Using the 3-Point Curve Tool, start on the top horizontal line and draw a 
straight line to meet the first diagonal line (this creates the first two points).

2.   �Next, the line will curve toward the corner of the cobweb (this creates the third 
point). Set the width of the line at 1.5 pt.

3.   �Continue drawing curved lines between each section of the cobweb. When 
possible, select a curved line and continue it by picking up an open Node and 
creating another 3-Point Curve.

4.   �Your web is complete when each section is filled with curves.
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Step 3

Finally, here's a quick review of the Object Manager docker. This docker is 
comparable to the Layers panel in Adobe Illustrator. In the case of the Object 
Manager, however, you can not only create multiple objects, layers, and groups of 
layers (and objects), but also multiple pages.

Note that next to each layer there are three icons:

1.   �Show or Hide: Toggling this changes the visibility of a layer within the active 
document.

2.   �Enable or Disable Printing or Exporting: Toggling this changes whether or not 
a layer will be included in a printed or exported document. Even if you have 
a layer hidden, if this isn't toggled off, your exported image will still show 
whatever is on the layer.

3.   �Lock or Unlock: Toggling this allows for your layer to be editable or not. It's 
quite useful for making sure objects remain untouched while working with 
multiple, overlapping elements within a document.

Sadly, individual objects or object groups have to be on separate layers if you want 
some to be hidden, some to be unprintable, or some to be locked.

B. Drawing basic shapes with CorelDRAW

This tip has been written for CorelDRAW® Graphics Suite X3. While similar 
features might be available in previous releases the tip will be fully applicable to 
CorelDRAW Graphics Suite X3 and newer versions only.

With CorelDRAW®, drawing basic shapes — such as rectangles, ellipses, polygons, 
and stars — is quick and easy. All the tools you need are easily accessible from the 
following flyouts in the toolbox: the Rectangle flyout, the Ellipse flyout, and the 
Object flyout.
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Top to bottom: the Rectangle flyout, the Ellipse flyout, and the Object flyout

1. Drawing rectangles and squares

You can draw a rectangle or a square by dragging diagonally with the Rectangle 
tool or by specifying the width and height with the 3 point rectangle tool. You'll 
find the 3 point rectangle tool very useful for creating rectangles at an angle. Both 
tools are located on the Rectangle flyout.

●● To draw a rectangle, open the Rectangle flyout, click the Rectangle tool  , and 
drag in the drawing window until the rectangle is the size you want.

●● To draw a square, click the Rectangle tool, hold down Ctrl, and drag in the 
drawing window until the square is the size you want.

●● To draw a rectangle at an angle, click the 3 point rectangle tool  . In the drawing 
window, point to where you want to start the rectangle, drag to draw the width, 
and release the mouse button. Move the pointer to draw the height, and click.

Drawing a rectangle at an angle with the 3 point rectangle tool
●● You can draw a rectangle from its center outward by holding down Shift as 

you drag with the Rectangle tool.
●● You can draw a square from its center outward by holding down Shift + Ctrl 

as you drag with the Rectangle tool.
●● You can draw a rectangle that covers the drawing page by double-clicking the 

Rectangle tool.

2. Drawing ellipses, circles, arcs, and pie shapes

You can draw an ellipse or a circle by dragging diagonally with the Ellipse tool, 
or you can draw an ellipse by using the 3 point ellipse tool to specify its width 
and height. The 3 point ellipse tool lets you quickly create an ellipse at an angle, 
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eliminating the need to rotate the ellipse. Both tools are located on the Ellipse 
flyout.

After you draw an ellipse or a circle, you can easily change it into a pie shape or 
an arc.

Left to right: a circle, a pie shape, and an arc
●● To draw an ellipse, open the Ellipse flyout, click the Ellipse tool  ,and drag 

where you want to place it. Holding down Ctrl while dragging with the Ellipse 
tool draws a circle, while holding down Shift draws an ellipse from the center.

●● To change the ellipse into a pie shape or an arc, click the Pie button  or the 
Arc button  on the property bar.

●● To draw an ellipse at an angle, click the 3 point ellipse tool  , and drag in the 
drawing window to draw the centerline of the ellipse at the angle you want. 
Next, move the pointer to define the height of the ellipse, and click.

Drawing an ellipse at an angle with the 3 point ellipse tool

Left to right: a circle, a pie shape, and an arc

3. Drawing polygons and stars

You can draw polygons and two types of stars: perfect stars, which have a traditional 
star appearance and complex stars, which have intersecting sides. With perfect 
stars, you can apply a fill to the entire star shape. With complex stars, you can 
produce unique results when you apply a fill.

Left to right: a polygon, a perfect star, and a complex star, each with a fountain 
fill applied
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The tools you need to create polygons and stars are located on the Object flyout.

●● To draw a polygon, open the Object flyout, click the Polygon tool  , and drag 
in the drawing window until the polygon is the size you want. You can draw a 
polygon from its center by holding down Shift as you drag. Also, you can draw 
a symmetrical polygon by holding down Ctrl as you drag.

●● To draw a perfect star, click the Star tool  , and drag in the drawing window 
until the star is the size you want.

●● To draw a complex star, click the Complex star tool  , and drag in the drawing 
window until the star is the size you want.

4. Working with the Mesh Fill tool

The Mesh Fill tool is one of the most powerful features in CorelDRAW®. It lets 
you design multi-colored filled objects with fluid transitions and unique effects. 
You can adjust single node transparency to create smooth, rich color transitions 
for any mesh filled object.

Unlike traditional fills, mesh fills can be molded, like clay. This allows you 
to create objects with a special form, similar to how a sculptor gives shape to his 
work. You can adapt and shape the fill to suit the object you're creating, and to 
achieve a realistic colored appearance. And best of all, mesh fills are vector objects 
which means that you can enlarge or reduce at any time without substantially 
increasing file size. 

Let's start by creating a simple rectangle and then clicking the Mesh Fill 
tool. You can also press M on your keyboard to access the tool quickly. With 
CorelDRAW X5, your rectangle will have one central point, which creates a grid 
with 2 rows and 2 columns. You can add additional, equidistant rows or columns 
by using the Grid size box on the property bar. You can add a single row or column 
without affecting the other rows and columns by double-clicking the dotted line at 
the desired point.

5. Adding color

Now, we can add color by selecting a node or several nodes. You can select nodes 
individually by using the Mesh Fill tool (M) or the Shape tool (F10). To select 



Computer 
Application 

in Apparel & 
Textile

NOTES

140  Self-Instructional Material

several nodes, press and hold Shift while clicking each node. If you want to select 
an irregular collection of nodes, choose Freehand from the Selection mode list 
box on the property bar. This lets you draw an irregular selection area.

At this point, we have a custom gradient fill, which we can achieve by using 
other tools or effects, such as the Blend or Contour tools. So what's so magical 
about a mesh fill? We can deform the mesh grid and add unlimited colors. For 
example, we can select a couple of nodes and move them together in the same 
direction.

One of the most fantastic features of the Mesh Fill tool is the ability to add 
new colors to any node. You simply select the desired node(s), and choose a color 
from one of the color palettes. With a mesh fill, the best part is that we don't need 
a complex drawing to produce good results. Often, the more simple the object, the 
better the resultant mesh fill.

6. Soft mesh fill

In versions prior to CorelDRAW X5, mesh fills produce hard edges by default; 
however, there is now a Smooth mesh color option on the property bar. This lets 
you choose whether you want soft or hard edges.

When editing an object with a mesh fill, most of the property bar options are similar 
as with any shape. You can select a segment and convert to a straight line or a 
curve. There are also options for converting nodes to cusp, smooth, or symmetrical. 
And you can define curve smoothness for any portion of an object. You can also add 
transparency on one or more nodes, which offers a powerful and exciting way to 
create unique effects. 

7. Mesh fill transparency

So, how to add transparency to a mesh fill? Easy, just select the node(s) and then 
adjust the Transparency slider on the property bar. You can choose different 
levels of transparency for each node in a mesh filled object. You can also restore 
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node transparency at any time, by selecting the node(s) and moving the slider to 
zero. The sample below shows a mesh filled object on a black background without 
transparency (left) and with transparency (right).

With transparency, you can instantly create soft edges on objects. Since vector 
drawings are always sharpened, you may sometimes want to create a more realistic 
appearance by adding transparency on the edge of the object or on selected areas 
of the object.

8. Shaping the mesh fill

You have two choices for shaping a mesh filled object. First, as I did with the leaf 
previously, you can create the object, shape it, and then apply a mesh fill. The 
second option is to apply a mesh fill to a basic object, such as a rectangle, and then 
shape the rectangle by moving the mesh nodes. For example, I can create a beer 
glass by first creating a rectangle, applying a mesh fill, adding color, adjusting 
nodes, and shaping the edges. I'll use ellipses to give the perspective of the glass 
opening, and another mesh fill to create a background.

As you can see, the most important thing is to work with simple, or basic, objects 
for applying mesh fills. Complex objects would be very difficult to handle, while 
simple shapes let you create great drawing with a high visual impact.

9. Mesh fill and PowerClip

Sometimes, a mesh fill isn't suitable for certain objects; for example, combined 
objects that are formed by combining two objects into a single curve with subpaths, 
such as text. Also, if the object if overly complex, the mesh fill will be very complex.

In this case, the best solution is to use a simple mesh fill and place it within 
a PowerClip (Effects > PowerClip > Place Inside Frame) on the text or object. You 
can edit the PowerClip (Ctrl + Click) if you want to shape the mesh fill to better 
adapt to the object.



Computer 
Application 

in Apparel & 
Textile

NOTES

142  Self-Instructional Material

10. Applying color to a mesh fill

When you're working with the Mesh Fill tool, the property bar provides a dedicated 
Mesh fill color palette. This makes it fast and easy to add colors. There's also a 
Sample mesh fill color eyedropper on the property bar, which lets you choose 
any color from an existing mesh fill and add it to the Document palette.

Another handy feature of the color palette is the ability to mix two colors by 
using the Ctrl key. For example, if you have a blue color, and Ctrl + Click on the 
white swatch of the color palette, the blue will become a shade lighter. If you 
want to darken a tone, it's best to mix with Composite Black (C:100, M:100, 
Y:100, K:100), which is the very last swatch on the default CMYK color palette.

11. Trying a simple exercise with mesh fill

Now, let's create a new drawing. I like to draw flowers, leaves, and animals since 
mesh fill is more realistic than other effects. Keep in mind, you don't need to be Da 
Vinci in order to use CorelDRAW to create something better than a bitmap logo 
or clipart. For this exercise, we'll start with basic shapes to help you discover the 
magic and power of CorelDRAW.

So, how to draw a leaf? From the toolbox, click the Freehand tool (F5) and 
start with straight lines for a simple drawing. With the Shape tool, drag over the 
shape to select all nodes, and click then Convert to Curve button on the property 
bar. The shape's appearance doesn't change. But wait, now select the top and 
bottom nodes, and click the Symmetrical node button on the property bar. Now 
the shape resembles an eye, which is a good start for our leaf.

Next, press M to select the Mesh Fill tool, select the center node in the shape and 
click a green swatch on the color palette. Double-click on the vertical line, and add 
a new node. Then select the new node and add another color. For example, try a 
different shade of green. Repeat this process for the rest of the shape and it should 
soon start to resemble a leaf.

You can create a very realistic drawing with only a few steps. And, if you want, 
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you can add a node close to the shape's border, and then add a transparency on the 
edge. This will give the drawing ‘soft' edges.

12. Creating a background

Now, let's try creating an abstract background. As always, start with a simple 
shape, such as an ellipse. Choose your color and fill with a Uniform Fill. Then, 
choose the Mesh Fill tool and only add transparency on the nodes. Try 100% on 
approximately half of the nodes, and 50% on the rest. You can change these values 
to create different results and combinations.

Next, rotate the ellipse, create a duplicate (just press the + key on the numeric 
keypad) and rotate on a different angle. When finished, add a background (double-
click with the Rectangle tool), choose another color. If you want, place the ellipses 
inside the rectangle, as a PowerClip (click Effects > PowerClip > Place Inside 
Frame). There are infinite combinations of results, this is only one example.

Here's a sample background, or wallpaper, that I created by using the Mesh Fill 
tool.
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And here are some sample abstract backgrounds, also created with the Mesh Fill 
tool.

13. A sample mesh fill landscape

I've included this sample to reinforce that you don't need to use complex objects to 
create nice drawings. I started with a rectangle, added an ellipse, and then a hand-
drawn irregular shape to create a landscape with mountains, the sun, and some 
clouds. Then I used the Mesh Fill tool to add a few colors, resulting in a realistic 
and beautiful landscape. To create that soft, glowing border around the sun, I used 
a simple Drop Shadow.

14. A sample complex drawing

Of course, there are times when you need to create a more complex drawing, such 
as a face. While that's not as easy as a leaf or flower, the process is similar. The 
key is to do it step-by-step and not try to do everything at once. These next sample 
illustrations will show you some steps I've used in the creation of Yoda, the Star 
Wars Jedi Master.

If you looked at just the final result, the process may seem difficult and 
daunting; however, by creating separate objects for each step, the process is very 
easy and fun. With each step, I've added nodes and shaped the face, adding lighter 
colors and increasing the tint to create darker areas.
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15. Mesh fill with complex shapes

So, what about using mesh fill for a very complex drawing, such as a human face? 
With Yoda, I used a basic shape and added a few elements, such as eyes, ears, and 
hair, slowly over a series of steps. The same method is useful for any other complex 
drawing, which can be a puzzle of little shapes. The new transparency with mesh 
fill helps to blend any shape with another, and the eyedropper makes it easy to 
copy exact colors for another object.

16. Mesh fill and other effects

You can use mesh fill together with other CorelDRAW effects, such as Drop 
Shadow, Lens, Transparency, and more. Certain effects do not all you to build 
other effects on top of them, so a workaround is to create duplicates. For example, 
you can apply mesh fill to one of the objects, and place the mesh filled object as a 
PowerClip within the duplicate object. But take care not to use too many effects at 
the same time. Remember, the more simple the object, the better the results you 
will achieve.

2.5  STUDENT ACTIVITY

1. 	 What is Color Trapping? Explain the CorelDRAW Tools?
	 ...........................................................................................................................
	 ...........................................................................................................................
	 ...........................................................................................................................

2. 	 What is Tool Bar? Explain the Different Tools In CorelDRAW?
	 ...........................................................................................................................
	 ...........................................................................................................................
	 ...........................................................................................................................

2.6 � ABLE TO DEVELOP DESIGNS THROUGH COREL 
DRAW

If you are pursuing your fashion designing, graphics designing or similar other 
courses, then you probably known what Coreldraw is. Corel draw is a designing 
software that allows users to use different tools to create original images or edit 
them beautifully as compared to other software.

You can be a pro at illustration or you may be just a newbie using Adobe 
illustrator. But if you learn the basics of Coreldraw, you can be a step ahead of 
others in illustrations. The best thing about Corel Draw is the wide variety of 
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tools that it provides you with to design an exceptionally professional art piece. 
When you take a course on online fashion designing, you get to learn these tools in 
details. Here are some of the elementary tools of Coreldraw that you need to look 
over:

A.  The Pen Tool

This is one of the basics tools that you will have to start with while working with 
the Corel illustrator. The preferred settings are RGB in color mode and at 300dpi. 
But if you ever want to switch to the CMYK, then you can always switch, but then 
it would be appropriate for the printing options. For web use, RGB is the best. You 
can also place nodes and draw curves in the segments.

1. B-Spline and smart drawing Tools

Using the B-spline tools you can start with shapes and sizes that would look precise 
enough. You can place the nodes at curved edges and corners, and then use the fill 
color option in the Object Properties docker. You can use the smart drawing tool 
that is similar to freehand smoothening. This will allow your shapes and sizes to 
be sharp as well as precise.
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2. Freehand and Bezier tools

If you want to illustrate fairly simple drawings with a graphics tablet, then using 
the freehand tool (F5) is the best option. You can start with a low setting of F12 
and then gradually switch to 97 that have three nodes in total. Then you can use 
the Bezier tool for entering different shapes like of faces or anything

3. 2-Pont line and 3-point curve tools

You can use this when you want to add the final touch to your sketch. Start with 
the 2-Point line and then gradually move to the 3-point. Draw lines, curves or 
whatever you want to and then group your objects. When your sketch is complete, 
you can fill it with curves, styles, templates or designs of your choice.

B. Creating a Geometric Fashion Mannequin in CorelDRAW

CorelDRAW is the most popular vector design software in the professional 
computer-aided fashion design industry, with many fashion designers using it to 
draw their mannequins and produce their designs. If you have attended fashion 
school or have simply visited a fashion design studio, you have likely seen the 
small wooden mannequins perched on the drafting tables. This classic mannequin 
is often used as a visual aid when creating different fashion figurine poses. You 
may not have one of your own, in which case you will find it very useful to have 
one in digital format and use it as a guide for creating the different poses of your 
upcoming designs.
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1. Divine Proportion

If you don't have previous experience drawing fashion figurines, before drawing the 
geometric shapes that will form yours we recommend that you start by positioning 
guidelines according to the proportion ratio that you decide on. The divine 
proportion or golden ratio is a guideline that establishes the ideal proportions 
of the human body, dividing it in sections called modules. Artists and scientists 
throughout history have established several ratios appropriate of their era and the 
figurative concepts of their times. 

When designing fashion figurines, the Greek golden ratio with some variations 
is often used. According to this ratio the size of the head is used as reference to 
define the subdivisions, so that the total height of the body is 8 times the size of the 
head. Since the fashion figurine needs to be more stylized for a slimmer and more 
elegant shape, the Greek ratio is slightly modified for a height of 9 or 10 times 
the size of the head.

If you find it helpful to have guide lines on your screen for better positioning 
of your geometric shapes, click and drag as many lines as you need from the 
horizontal or vertical rulers. These lines will not be visible when printing.

2. Drawing the parts of the geometric mannequin

We will start drawing the head and neck using two ellipses and a rectangle (using 
the Ellipse and Rectangle tools from the Toolbox). Using the Polygon tool we 
will create a pentagon (5-side polygon) for the torso, and with the Ellipse tool we'll 
create two circles for the shoulders. To complete the upper part of the body, we 
will draw two rectangles and then, using the Pick tool, we will turn them a few 
degrees to find the right inclination. We'll then create two circles to function as 
elbows, as shown in the following image. 
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To create the pelvis we will use a pentagon that we will stretch using the Pick tool 
and two circles in its base that will serve as joints for the legs. 

To draw the forearm we shall use a pentagon and a triangle. The hand will be 
made of another downward-facing pentagon joined to the forearm by a circle, as 
illustrated below. 

To draw the leg and foot we will use four pentagons and two triangles, and two 
circles for the knee and ankle respectively.

Once we have created one leg, we can duplicate it and place the two side-by-side. 
Using the Pick tool we can rotate some of the components in order to get asymmetry 
and movement.

At this point, the mannequin already has all of its elements, comprised exactly of 
37 basic objects. We can view them in the Object manager docker. To open the 
Object manager click on the Window menu > Dockers > Object Manager.
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3. Reducing the number of objects by welding them

Once the mannequin has all of its components, we can optimize it using the shaping 
tools mentioned earlier. More specifically, we will use the Weld and Trim options.

To simplify the future use of the mannequin we will reduce the number of 
components by welding some of them together.

We will start by joining the torso to the neck. Select both shapes (the pentagon 
and the rectangle) and click on the Weld button on the Property Bar , and you will 
see how both shapes become a single object.

Weld also the two ellipses that form the head into a single object.

We will then select the two polygons that form the forearm and will Weld them 
together. To help visualize the results, it is a good idea to select the resulting 
objects using the Pick tool and apply a fill color to them by clicking on the color of 
your preference from the color palette. We will continue welding the polygons that 
form the thighs, the calfs and the feet until we get a result similar to the following 
image. 
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4. Trimming shapes to obtain movement in the joints

The number of components of the original figurine has now been reduced to 27. In 
order to provide mobility to the joints we will trim the areas where the objects come 
together using the Trim option from the Property Bar . We can start by selecting 
the ellipse that forms the shoulder, clicking the Trim option and then clicking the 
pentagon that forms the torso. Since the triangle that forms the forearm extends 
to the hand, we will need to select the pentagon that forms the hand, activate the 
Trim option and click on the forearm triangle. This way, the hand and forearm will 
be ready for when we trim the wrist.

Continue trimming all the ellipses that make up the joints of the adjacent objects. 
If the object that forms the head appears behind the neck, click on the Object menu 
> Order > In Front Of... and add a white fill color to distinguish it better. To create 
the ankles we will follow the same procedure as with the wrists: select the object 
that represents the foot, activate the Trim option and click on the calf object, then 
trim the ellipse corresponding to the ankle.

Now that the mannequin is ready you can delete the lines that you used as guides, 
by choosing the Pick tool, clicking on each one of them and pressing the Delete 
key.

To unify the appearance of the figurine, select all the objects that comprise it with 
the Pick tool and click on the black color of the color palette.

Now we can test the versatility of the mannequin that we've just created. 
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5. Changing the mannequin's poses

Using the Pick tool and its skewing and rotating functions you can select the 
joints and give your new mannequin movement, and position it in as many poses 
as your want. The possibilities are endless, as shown in the below example.

6. Designing your own fashion with basic shapes 

You have seen the possibilities of the basic shape drawing tools to create 
mannequins, but there is much more creative power in these tools. Now that you 
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have your geometric mannequin as a starting point, try dressing it up using the 
techniques for drawing basic shapes, trimming and welding as shown below:

C. Applicability of Corel DRAW Software to Apparel Design

CorelDraw can perfectly represent fabric combinations and color combinations 
for various garments, allowing designers to quickly and arbitrarily design color 
schemes based on design needs. Therefore, today's fashion designers can use 
CorelDraw software to efficiently and quickly complete the design of clothing style 
drawings and costume renderings. CorelDRAW software features are as follows

(1) Powerful drawing function. Due to the non-standard nature of garment 
mapping, the general geometry cannot meet the drawing needs. Therefore, the 
costume design software should be able to draw arbitrary curves, change the 
line style of any line, set the origin of the drawing arbitrarily, add any auxiliary 
lines, and satisfy the accuracy of data changes. Corel DRAW has the advantage of 
drawing arbitrary curves and changing the line style of any line.

(2) The arbitrariness of the settings is further divided into the arbitrariness 
of drawing settings, the arbitrariness of the unit and ratio setting, and the 
interchangeability of various file formats. Practice shows that Corel DRAW has all 
the requirements for digital clothing professional software. It can perfectly draw 
the clothing effect chart and express the effect of the clothing. In the style design, 
the stitches, fabrics, patterns and other details are close to the clothing effect. 
Corel DRAW is able to complete the drawing of a series of drawings for apparel 
design, to meet the digital clothing teaching and production software.
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D. Fashion Design Ideas
The personality design in the clothing is actually the style design of the clothing. 
It is the unique creative thinking and artistic expression of the designer. It is also 
another interpretation of the modern fashion life. In this creative process, we must 
first analyze the logical structure of the clothing style design. The logical structure 
of the clothing style design. Through the logic structure diagram of clothing style 
design, accurate access to the current popular information, market and customer 
needs, reasonable arrangements for the entire company's quarterly development 
and design to prepare adequate data information.

Figure :2.2 Logical structuere of clothing style design. 

1. Practical Application of Corel DRAW Software in Fashion Design

In the design of costume design renderings, the application of Corel DRAW 
software color mode is shown in Figure below. From the analysis of the use of 
apparel fabrics in apparel design, Corel DRAW software can contrast and set off 
different apparel fabrics and help fashion designers find more suitable fabrics. 
Corel DRAW software in the design of renderings, through the pattern, the clothing 
image, vivid design results presented. In the Corel DRAW software, there is an 
import function that can import photos of costume designers’ own costumes into 
the costume design renderings. On this basis, the clothing is drawn, or according 
to the actual needs of the clothing style changes, the exchange of color, etc., so that 
the costume design renderings show an artistic effect. 

Figure :2.3 Design process flow chart. 
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2. The Digitalization of Corel DRAW Software in Fashion Design

In clothing style design, Corel DRAW software will not be affected by the human 
body, do not need to draw it, can clearly show the lines and structures clearly 
and concisely. Under normal circumstances, the style design of the clothing is 
mainly based on the front, in the case of demand, the style of the back, side of the 
clothing will be drawn. Through the drawing function of Corel DRAW software, 
a rectangle is drawn according to the clothing length and clothing width of the 
clothing design, and then the rectangle is slowly converted into a curve, and the 
design of the clothing style is completed by using the tools in the Corel DRAW 
software to process the curve and the like. draw. 

When drawing a clothing style effect chart, the scales, paths, etc. in the Corel 
DRAW software draw the style of the clothing, and show the style structure before 
and after the clothing in detail, providing clear parameters for the production and 
production of the clothing.

Through Corel DRAW software, under the guidance of the basic principles 
and performance techniques of the clothing style effects, the final rendering is 
shown in Figure below.

Figure :2.4 Apparel design effect using Corel DRAW software. 

3. �Corel DRAW Software in The Drawing of the Clothing Structure on The 
Digital Display

Use CorelDraw software's size, position, mirror, rotation and other functions, using 
drawing tools, according to any clothing drawing method, can be very accurately 
draw clothing structure.

During drawing, note that each piece of parts must be closed separately 
so that it can be separated in the future. Use line tools to divide different lines 
according to the requirements. The use of line tools and text tools allows easy data 
annotation, text annotation, and related symbol annotation. After the structure 
drawing is completed, a clothing model diagram should be made on the basis of 
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the structure drawing for cutting and use. Each piece of the garment is to be 
separated, and seams, hems and other allowances are added to the edges of the 
component graphics. This model is independent, complete, and each template 
should be marked with code, number, warp direction. The drawing points are: 
Select a piece of clothing, use the software to change the size of the size of the 
function, directly enter the amount of data added after the margin, and then make 
one, put it in the lower part of the clothing, and then adjust the position.

Figure :2.5 Costume structure drawing using Corel DRAW software. 

4. �The Digitalization of Corel DRAW Software on the Garment Design 
Layout

The main purpose of discharge is to save materials and reduce costs. In accordance 
with the principle of large first, small, closely arranged, gap-combined, and size-
matching, the material is laid out. In addition to the above requirements, the 
batch discharge should also set the number type ratio, calculate the length of the 
single-layer section, and calculate the number of layers. The need to pay attention 
to the process of nesting is the directionality of the fabric, including the direction 
of the warp and the fabric, and the direction of the reversed hair of the garment 
piece to be consistent, and the pattern and pattern of the garment piece should be 
consistent.

2.7  SUMMARY

CorelDraw as a program of design bestows the users with various tools to produce 
original images or acutely edit them. Users who can to do some of the things 
with this program include generating page layout, QR code and adding different 
exceptional effects. In addition to this, CorelDraw has the capability of working 
with other programs in the CorelDraw graphics suite, like Corel photo-paint, 
which helps users to produce furthermore composite images. 

CorelDraw as an editor of vector graphics is used predominantly for advertising 
and marketing businesses, especially those that are exclusively specialized in print 
broadcasting development. It has the capability of producing powerful texts and 
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specializes in raster image tools that are built-in. In professional space, CorelDRAW 
is used to design newsletters, brochures and different printable documents with 
the help of its page layout properties. It is also useful for creating new fonts, vinyl 
designs, artwork, vector-based designs for laser/metal engraving and cutting.

Fashion women's colors are based on gray tones, and then add some 
fashionable pop colors. This makes the notes in the dullness beat on the fabric of the 
garment. The use of knitted fabrics, water-washed cotton, and denim can increase 
the personalization of the garment through the treatment of washing, worn-
out, wrinkles, and holes. The style design of the garment adopts the processing 
method of dividing, splicing the structure. The whole of the finished clothing 
pattern is dominated by printing of various different techniques, combined with 
the combination of hanging dyeing, tie dyeing, printing and dyeing, nailing and 
other technologies. Adding a three-dimensional effect on the basis of the plane, 
let the monotonous trousers wear a stylish halo to feel the charm of fashion. The 
realization of the fashion design of fashion pants is realized by creating a flow 
chart: namely, the determination of the theme of the clothing, the collection of 
materials, the overall conception and the overall adjustment process, and finally 
the design of the digital clothing creation.

The creative design of the clothing style is mainly from three aspects: the color 
of the clothing, the design of the clothing style, the local and detailed design of the 
clothing. In order to achieve a better ideal effect when drawing styles in software, 
you need to split the parts of the clothing styles. Get a new work interface and 
data components, and then draw and assemble styles to get your own design. The 
problems that need to be solved in the design process are: When the online bar 
and the component are spliced, they cannot automatically find the dry contact 
point, that is, the splicing point; he style produced by the lines and bumps needs 
to be strengthened and improved in terms of practicality and artistry; The use of 
pictures and graphics during the use of the software requires constant conversions 
to make it easier to keep online and digitally.

The application of Corel DRAW software in apparel design has many 
advantages. It can quickly improve the efficiency and design quality of apparel 
design. The current Corel DRAW software has been scientifically validated in 
foreign apparel companies, effectively promoted and utilized. From the status 
quo of Corel DRAW software application in China's apparel industry, the use of 
Corel DRAW software in apparel design is the result of advancement of social 
information technology and computer technology, as well as the development 
direction of apparel design. It is also a future trend.

2.8  GLOSSARY

Angular Dimension Tool		  : �A tool that allows you to draw angular 
dimension lines with three points of 
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execution. Such markers inform you of the 
dimensions of objects within your document 
by giving accurate measurements between 
them.

Arrow Shapes			   : �A variety of perfect arrow shapes ready for 
use within your document and easily modified 
with the Shape and Pick tools and assorted 
dockers.

Artistic Media			   : �This docker is your central hub for all things 
Artistic Media tool related. Organize, create, 
and play with the variety of tool types 
courtesy of the Artistic Media tool. You can 
make custom brushes and sprayers within it 
too.

Artistic Media Tool		  : �This tool mimics the look of a variety of brushes 
and brush types. Create paintbrushes, vector 
brushes, sprayer brushes, and more. Use in 
conjunction with the Artistic Media docker 
for greater control and organization.

Attract Tool				   : �One of the Shape Edit tools, the Attract tool 
manipulates the edges of the object by pulling 
nodes to the center of the cursor so long as 
they're within the tool's nib diameter.

Attributes Eyedropper		  : �This tool samples not only the color, but other 
attributes (fill, outline, and more) of an object, 
allowing you to transfer these properties onto 
other objects within your document.

B-Spline				    : �This curve tool allows you to draw lines and 
curves by setting the boundaries around the 
curve itself rather than the nodes.

Banner Shapes			   : �An assortment of Perfect Banner Shapes 
ready for use within a document, with special 
nodes that manipulate various parts of each 
banner object.

Basic Shapes			   : �The basic set of perfect shapes containing 
a variety of geometric shapes ready for 
manipulation with the Pick and Shape tools, 
as well as special nodes that change a variety 
of features unique to each object.
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Bevel					    : �This docker allows you to fully control the 
Bevel effect on a selected text object. Chose 
the style, offset, shadow color, and various 
lighting controls for a quick and easy effect.

Bezier Tool				    : �This curve tool allows you to draw one 
segment of a curve or line at a time. Similar 
to the Pen tool, users place the nodes of a 
line or curve manually. This tool, however, 
does not allow users to preview curves before 
placing them, unlike some of the other curve 
tools.

Blend					    : �This docker offers additional control to the 
user when creating blends with the Blend tool. 
Control the number of steps, acceleration, 
and style of color blend.

Blend Tool				    : �This tool is an interactive one that creates a 
progression of objects shape, size, and colors 
between the two objects selected with the tool. 
Users can control the angle and acceleration 
of the blend, as well as how many steps will 
be created from point A to point B.

2.9  REVIEW QUESTIONS

1.	 Understanding the Pick Tool.

2.	 Explain the Shape Tool.

3.	 What is Free Transform Tools?

4.	 Explain the Curve Tools.

5.	 Discuss the Artistic Media Tool.

6.	 Defining the Freehand and Bézier Tools.

7.	 What is Drawing rectangles and squares?

8.	 How to Use Drawing polygons and stars.
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3.1  LEARNING OBJECTIVE

After studying this unit you should be able to:
●● Explain the meaning and significance of Prepare Design Sheets.
●● Explain the Making and working with a Pattern.
●● Describe the technology for modify of Text and Graphic Styles and Color 

Styles .
●● Given the meaning and significance of Make a Spec Sheet for Garments.
●● Describe the main responsibilities of a Color Perception Theory for Textiles.

3.2  INTRODUCTION

In the fashion world generation of new ideas or garment designing processes do find 
an important role as they tend to find new solutions of problems. Designers goal 
and personal creativity must look beyond that which already exist and find new 
combinations of ideas and materials that can satisfy people’s needs and desires.

Good designs must reflect works that are special and original, thereby 
awakening the interest of the viewer to have the edge of going for such attires.

Today, the whole profile of industry is transforming to new designs and 
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innovations. There could be many ways of dealing with these challenges that are 
commonly applied in the existing framework. However, one area that has been left 
untouched is to create a strong interface between design and technology. We need 
to stop thinking technology only as vehicle to productivity and design as some 
commodity that is used as add on for making the product good looking. Although 
these functions of technology and design are very legitimate but when we think 
about an interface of these two, they would need to break the barriers and play a 
critical role in every aspect of contemporary Indian business.

The mutual inter-dependence of design and technology has little been put to 
practical use for the benefit of the user. Motifs are often inspired from nature and 
are also closely linked to natural, cultural, religious and socio-economic factors 
prevailing in any society and can be seen as an object of beautification.. Motifs are 
repeated in different ways to create patterns and these patterns are repeated to 
create a design. Motif has a distinct identity of its own in a pattern or design.

In the present work we propose the development of algorithm and programming 
in C++ for the creation of motifs and for creating patterns of motifs. The motifs 
generated by the proposed programming method is compared with the motifs 
developed by commercially available tools like Reach Fashion Studio (3D) and 
CorelDraw(2D).

3.3  PREPARE DESIGN SHEETS

A.  Creating patterns in CorelDRAW®

The following tools and controls are used in this tutorial: Freehand tool, Shape 
tool, Join Nodes, Convert to Curves, Mirror and Duplicate, Rotate and 
Repeat, Angle of Rotation. 

1.   �Start CorelDRAW, and click New blank document on the Welcome screen. 
Set up the document as shown in Figure below.

Figure :3.1
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2.   �Select the Freehand tool   (F5). Draw a straight vertical line by holding down 
Ctrl, clicking in the drawing window to start the line, and then clicking to end 
it. Do not drag to draw the line.

3.   �Select the Shape tool   (F10). Click anywhere on the line, and click the Convert 
to curves button on the property bar (Figure below).

Figure :3.2

4.   �Click the third handle from top to bottom, and drag it to the left and slightly 
downwards. You'll get a shape similar to the one shown in Figure below.

5.   �Select the object by using the Pick tool  , and drag the middle left handle to 
the right while holding down Ctrl to create a perfectly mirrored object. Before 
releasing the left mouse button, right-click once to create a mirror duplicate.

Figure :3.3 Figure :3.4 

6.   �Select both objects, and click Arrange > Combine (or press Ctrl+L). With the 
combined object still selected, click the Shape tool (F10). Marquee select the 
two top nodes, and click the Join two nodes button on the property bar. Next, 
marquee select and join the bottom nodes of the object.

Figure :3.5

7.   �Now, we have a single closed object. Fill this object with any color from the color 
palette. The final object must look like the object in Figure below. If the object 
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is not filled with color, then something went wrong while you were joining the 
nodes or combining the objects. You may need to revisit Step 6.

8.   �With the object still selected, click it to change the size handles to rotation 
handles. Hold down Ctrl, and drag the object centre, which is also the center of 
rotation, to the bottom of the object as shown in Figure below.

Figure :3.6             Figure :3.7

9.   �Holding down Ctrl to constrain the angle of rotation, start to rotate the object 
by any degree divisible by 5 as shown in Figure below. Before releasing the left 
mouse button, right-click once to create a duplicate. Press Ctrl+R repeatedly 
to create rotated duplicates until the circle is complete.

Figure :3.8

10.   �Using the Pick tool, marquee select all objects, and press Ctrl+L to combine 
them. Different patterns can be created by altering the curve of the shape in 
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Step 4 and by using different angles of rotation. In this example, the objects 
have been rotated by 30°.

                

Figure : 3.9 Type of patterns created useing corel DRAW 

Various patterns can be created by using different curve shapes and angles of 
rotation.

B.  Create Halloween Pattern in CorelDRAW

1. Drawing the Moon

Step 1

Start by creating a New Document. I prefer to work out patterns within a square 
document of 8 inches or so. Your document's size is entirely up to you. Since I'm 
posting these designs online, I've chosen RGB for the color profile, and 300 dpi in 
case I'd like it to be printed or easily resized later. 
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Step 2

Use the Ellipse Tool (F7) to draw a simple circle. Hold down Control while drawing 
the circle to keep it uniform. Draw a second, smaller circle, and overlap the top 
right of the first circle.

Step 3

Select both shapes in the Objects Manager docker and, in the Property Bar, hit 
Back Minus Front to delete the smaller circle from the larger circle. You'll be left 
with a lovely crescent moon.

2. Drawing the Bat

Step 1

1.   �The bat begins the same way as the moon did: with a circle. Once again, grab 
the Ellipse Tool and draw a circle.

2.   �Using the Polygon Tool (Y), set the number of Points or Sides (in the Property 
Bar) to 3, and draw a triangle.

3.   �Don't worry about getting the shape just right on the first go. Using the Pick 
Tool, you can Scale or Rotate your triangle as you see fit.
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4.   �Place the triangle on the circle, Rotated slightly to the left (Double-click an 
object with the Pick Tool to toggle between Scale or Rotate).

Step 2

Copy (Control-C) and Paste (Control-V) the triangle and, in the Property Bar, hit 
Mirror Horizontally. Place the copied ear on the right side of the circle. Use the 
Align & Distribute docker to Align the two triangles as you see fit (usually by 
hitting Align Top).

Step 3

The bat's wings are constructed from three triangles. You can draw them with the 
Polygon Tool, or take more control over the design and use the Pen Tool.

1.   �Each triangle has Three Nodes or Points.

2.   �Make sure your triangles are closed shapes, where you return to the origin 
point with the Pen Tool.

3.   �Overlap the first triangle slightly while drawing the second.

4.   �Make sure the top points of the triangles are Aligned.

5.   �Adjust the triangles with the Pick Tool to make sure they overlap and line up 
at the top point of each and at their bottom corners.
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Step 4

Select all three shapes and hit Weld in the Property Bar. Your triangles will now 
be united into a single shape.

Step 5

I've Zoomed (Z) in on the top corner of the new shape created in the previous step. 
Using the Shape Tool (F10), Double-click to delete any extraneous nodes. Make 
sure that any you delete don't drastically change the overall shape of your five-
sided figure.

Step 6

Now that your object is free of extra, unneeded nodes, its ready to turn into a bat 
wing.
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1.   �Use the 3-Point Ellipse Tool draw a line along the bottom left side of the bat's 
wing.

2.   �Pull the ellipse outward to get the elliptical shape of your choice for the scallops 
on the bat's wing.

3.   �Repeat on the other two sides.

4.   �Select the main wing object and the first circle. Hit Back Minus Front in the 
Property Bar.

5.   �You've successfully deleted the circle from the bat wing! Let's continue.

6.   �Repeat with the other two circles and the main bat wing shape. Delete any 
extraneous nodes.

Step 7

Place the bat's wing next to the bat's head, overlapping slightly. Copy and Paste 
the left wing, Mirror Horizontally, and Align the two wings. Select all five objects 
and hit Weld in the Property Bar.
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3. Drawing the Cat Eyes

Step 1

Start with the Rectangle Tool (F6), drawing a wide rectangle. In the Property Bar, 
select Chamfered Corner and enter 2" in the Corner Radius boxes. You'll be left 
with a simple hexagon.

Step 2

•   �Draw a circle in the center of the hexagon. Make sure that it's large enough to 
nearly hit the top and bottom sides of the shape.

•   �Use the Pen Tool to draw a curve that starts on the left corner of the hexagon, 
curves along the edge of the circle, and stops at the right corner of the hexagon.

•   �Close the shape with a straight line at the origin point on the left side.
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Step 3

I chose arbitrary colors so that each shape was a bit more visible for this step.
●● Copy and Paste the half curve shape drawn in the previous step.
●● Delete the hexagon object. In the Property Bar, hit Mirror Vertically.
●● Place the circle off to the side of your other shapes. Align the two shapes and 

Weld them together.

Step 4
●● Back to simple black outlines and white fill color for now. Make sure the circle 

is Aligned in the center of the almond shape.
●● Copy and Paste the almond shape. Use the Pick Tool to Scale the copied shape 

down so it fits within the circle.
●● Rotate the copied, small almond shape so it's sitting vertically within the circle. 

You've successfully drawn a simple cat's eye.
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4. Completing the Design

Step 1

To complete your cat eyes, Group (Control-G) the three objects and Rotate them 
to the right. Copy, Paste, and hit Mirror Horizontally in the Property Bar for 
the second eye. Now that we have all three of our designs ready, let's add simple, 
flat colors to them.

Step 2

Ungroup (Control-U) any grouped components. Copy and Paste the almond 
shape of the eyes and set the copied shapes to a black, 3–4 pt Weight Outline in 
the Object Properties docker, with the fill color set to null. The other fill colors 
are as follows:

●● Almond eyes: white (#FFFFFF)
●● Iris of the eyes: orange (#FF9933)
●● Pupils: black (#000000)
●● Bat: purple (#9933CC)
●● Moon: orange (#FF9933)

Group together all of the objects below.

Step 3

I drew a large rectangle behind my main designs so that the next step is visible. 
Use the Star Tool to draw many five-pointed stars of varying sizes to fill up the 
gaps in the design. Make sure to Copy and Paste the moon and bat so you can 
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Scale and Rotate them around the pattern.

5. Creating the Pattern

Step 1
●● Select everything within the design except for the black rectangle. Go to Tools 

> Create > Pattern Fill.
●● Select Vector in the dialogue box that pops up and hit OK. Once you do so, 

select the pattern area using the marquee provided. It's like cropping an image 
or drawing a rectangle over the design.

●● Save your new pattern with a name and tags, and decide if you'd like the 
pattern to be shared with other users or not.

Step 2
●● Draw a large rectangle and select Vector Pattern Fill under Fill in the Object 

Properties docker. Choose your newly made pattern in the File Picker under 
Personal, and choose either Shared or Private.
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●● Your new pattern may be warped a bit. Adjust the Fill Width and Fill Height 
as needed.

●● To vary your pattern further, select either Horizontal or Vertical Row Offset 
and offset your design's pattern tile to the level you'd prefer. I offset my design 
by 30.

6. Making an element for Pattern

Firstly, open new document and save it for example “Background.cdr”. Now we will 
draw own element that will be in a background so create a square with a rectangle 
tool (F6). Press hold down CTRL key , press left mouse button and drag – it makes 
a square. Now open Size transformation panel ( Arrange -> Transformations -> 
Size) or ( ALT + F10). Change Width and Length to 1 unit for precision. Rotate a 
square by 45 degrees in property bar.

Now draw a curved line something similar like me. First draw line with 2-points 
line tool and with Shape tool(F10) right-click on line and choose “To curve”. This 
makes a curve from straight line. Curve Handles appear so grab one and drag to a 
curved line.Now make sure that Snap to object is on ( Tools -> options -> Snap to 
objects or ALT+Z). If Snap to objects is on grab curve from its node and drag to the 
center of rotated square. You will see it’s snapping then you drag near the center 
of square.
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Now select curve and open Properies panel (Windows -> dockers -> Properties 
or Alt + Enter). Choose Outline properties and set width to 2 units. Now click on 
advanced options and new window appears. Set in Calligraphy settings Stretch 
to 1% and Angle to 92 degrees and click OK. Now we have convert that curved 
caligraphy line to object ( Arrange -> Convert outline to object or CTRL + SHIFT 
+ Q). 

Now select curve and open Rotate Transformation panel (Windows -> dockers 
-> Transformations -> Rotate or Alt + F8). Set angle to 12 degrees, Pivot point 
choose bottom left one and copies 12 and click apply. Now duplicate rotated square 
(edit -> duplicate or CTRL + D) and resize it by holding SHIFT key and dragging 
transformation point.When you duplicate objects for the first time in CorelDRAW, 
the Duplicate offset dialog box appears. To specify the distance between the 
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duplicate and the original object along the x-axis and y-axis, type values in the 
Horizontal offset and Vertical offset boxes.You can change the default offset for 
duplicates at any time. To do this, go to (Tools -> Options -> Document -> General 
)v and type values in the Horizontal offset and Vertical offset boxes. Now duplicate 
one more that square and make a decorative angle something like I did. And then 
duplicate rotate and drag from node to node to the corners. Snapping helps to do it 
precisely. well we have an Element.
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7. Making and working with a Pattern

Now we will make a pattern which we could use for the backgrounds or to fill 
other shapes. Now group all shapes of the element (Arrange -> group or CTRL + 
G)  make a dublicates and drag from node to node as we did before.

Well the last step is to create a pattern. To do it go to Tools -> Create -> Pattern 
Fill. choose two color type and high resolution. Then you will get a marque tool, 
hold CTRL key to make a square selection, press and drag to select the zone of the 
pattern.To select that zone precisely draw guidelines ( Drag from right and top 
rulers) and then move the cursor on intersection (guideline turn to yellow then you 
are on it). that’s all we have created a pattern and can use it.

Well now we can use this Pattern for backgrounds ir filling any shapes. So try it. 
Draw some custom shapes and select one.Go to toolbox and choose 2-color type 
pattern fill .The new window appear. Choose the new created Pattern and click 
OK. Shape will fill with the Pattern. Now choose Interactive fill tool (G)     , click on 
shape and Pattern Gizmo appears. This gizmo can manipulate with the pattern. It 
has Move, Skew and rotate Points. Drag it and the pattern will change.
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That’s all the lesson is finished.There are some examples with Pattern fills.

8. Preparing documents for prepress and print

With CorelDRAW we can create files for a wide range of applications: print, web, 
signage, fashion, illustrations, etc. Each requires a different configuration. Now 
lets talk about how to prepare our jobs for pre-press and printing.

Of course, there are several types of jobs: magazines, business cards, brochures, 
etc. It's almost impossible to talk about all, but most of the settings are common for 
all jobs. But remember: it's very important to talk to the printing company before 
you start, because each company has its own rules and requirements. Cost is an 
important factor in any job, and any change (such as a change in the size or colors 
used), even minimal, can result in a change to the final price of the job.

The following rules for pre-press and printing are common to almost all jobs 
and businesses. We will speak in general terms and then we will perform two jobs 
as an example (a business card and a magazine).

9. Step 1 – Setting up the Document 

Let's start from the beginning. Open CorelDRAW, and go to File > New (Ctrl+N).
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Now, we must choose the final, actual size of our work. That means that if the size 
of a business card needs to be 90x50 mm (or 3.5x2 inches), this should be the size 
of the document. Please do not place multiple cards on an A4 page, since this not 
only means extra work and time, it can also cause errors.

In the "Create A New Document" dialog box you'll find some useful ítems, 
such as the name of the job, the number of pages, color mode, color settings, etc. 
but we will talk in more detail about each of these ítems later.

If you already have a new A4 document, don't worry, you can change the page 
size in the Property Bar.

There are some presets in the Page Size drop-down list on the left of the Property 
Bar. You can add your own if you want to the end of the list by clicking on the 
"Edit this list…" button at the bottom of the drop-down. Note: you can access the 
same menu faster by double-clicking on the page border.

10. Step 2 – Defning the Margins 

This is part of the Page Setup, but it's an important step. After defining the 
page size, you should choose the inside and outside page margins. Inside margins, 
because it's not good to place text or objects near the edge of page_ it's not just about 
the aesthetics or design visuals– even if there is little difference when cutting and 
it's not noticeable that there is a margin around the inside.
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To add inner margins, double click on the page border and navigate to Document 
> Guidelines > Presets, choose the desired margin width (depending on the job), 
then click on the "Apply Presets" button.

If you are using a background, or if an image is near the edge of the page, you 
should add extra space around the outside. This outer margin is called "bleeding" 
and is very important because the cut is not always as accurate as expected. This 
additional margin helps the process of post-printing a lot. You can specify the size 
of the Bleed when you choose the size of the page. Double-click on the edge of the 
page, or go to Tools > Options > Document > Page Size. In the section "Bleed" 
you can set the desired distance (usually 3mm or 0.125"). In addition, you can 
make this area visible by selecting "Show bleed area".

But it's not enough to set the bleed distance, it is also necessary to expand the 
objects (the background, for example), in order to extend over the page border. Don't 
worry if the image is larger than the bleed area, it will be cropped automatically 
when creating a PDF file or print.

11. Step 3 – Image Quality 

One of the most common issues is related to the image quality. For example, if 
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you download an image from the internet, such as a wallpaper, it will be good for 
viewing on your screen but not for printing. Most of the images on the internet are 
low-quality (for example 72 dpi or 96 dpi), because it makes uploading the images 
to the web faster. But this resolution is not good for printing, because the image 
will be "pixelated" with jagged edges and the printed result will be bad.

For printing color photos, you should use images with a resolution of around 300 
dpi and using the CMYK color mode. The "300 dpi" is a standard value, since 
imagesetters and CTP (computer-to-plate) use LPI (lines per inch) as the unit of 
measure.

●● If the file output at 150 lines per inch, the max resolution available will be 
150x2 = 300 dpi.

●● If the output is at 175 lpi, the maximum resolution available will be 350 dpi.
●● If the file output at 200 lpi, the max resolution will be 400 dpi, indeed 300 dpi 

will be good enough.

So far, there's no printing device on the market with more than 200 lpi, so the best 
quality will be between 300 and 400 dpi.

Therefore, if you send an image with 600 dpi or higher resolution, this will 
produce only slower and larger files but will not improve the resolution. Some 
people send images with 1800 dpi, 2400 dpi and more and this only creates much 
larger files, but does not increase the quality of the output. You'll see it better on 
screen if you zoom in on the image, but the printed result will be 300/400 dpi. Some 
people ask about inkjet printers that claim to print at 2400 dpi or more. There's 
a lot of confusion about this, since they use "dpi" (talking about printed dots per 
inch), which is the printing quality, not the resolution of the images. And, for large 
format printers (plotters), there is no need to use high resolution bitmaps ̶ on the 
contrary, the larger the size the lower the resolution needed. But, since they don't 
produce color separations and the printing process is totally different, the "300 
dpi" standard is not applied to plotters, laser or inkjets.

Another common mistake: be careful when enlarging or reducing the size of 
the images. If you import an image, for example 15x10 cm at 300 dpi, but want to 
enlarge it to 45x30 cm, the resolution decreases proportionally (in this example, 
it's going to 100 dpi), so the quality will be affected. On the contrary, if you reduce 
the image to 3x2 cm the resolution will increase proportionally (in this example, 
1500 dpi). Both are bad, so you should be careful with the resolution. Remember, 
300 dpi should be the resolution at real size, not before enlarging or reducing.

12. Step 4 - Defining Colors

The next step is to define the Color Mode and Color Profile. Under Tools > Color 
Management you will see two dialog options; one for the general settings (Default 
Settings), and other relative to the currect document only (Document Settings). 
Both are very important.
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The "Color mode" refers to the way in which we use the file, in this case, for 
high quality printing. The first choice is between RGB or CMYK color modes. RGB 
has brighter shades but is only good for web and desktop printers (for example 
inkjet printers) and plotters, but not for commercial printing. RGB has 16.8 million 
colors and CMYK only 64,000 but all commercial printers use CMYK. If you use 
a RGB color profile, the color mode will change when the file is sent to print, and 
perhaps the result will be bad or inaccurate. Then, you should choose CMYK as 
the "primary color mode" in both dialogues of Tools > Color Management.

Choosing a CMYK color profile doesn't means that all objects will be CMYK 
automatically. When you import an image, or copy/paste a text, if the image is 
RGB it will be stored as RGB until you change the color mode. The best way is to 
use a image-editing software (such as Corel PHOTO-PAINT, included with the 
CorelDRAW Graphics Suite, or Corel PaintShop Pro), for correcting the image 
before importing it in to CorelDRAW. But if you insert an RGB image you can 
always change the color mode later. (NOTE: You can go to File > Document 
Properties… to make sure that all objects are in CMYK mode) For this reason it's 
so important to have a good color management.

To adjust the color profiles go to Tools > Color Management and adjust the 
color settings for the current document and the overall settings (Default Settings 
and Document Settings). It's not enough to set the default settings, because each 
document can have its own color profile.

Color Management requires a very wide explanation since there's no "universal 
color profile" for all documents. So you should adjust the settings for each kind of 
job. For example, you should change your color profile according the paper of the 
document being used.

But not all documents can use the CMYK color mode, because it requires 4 inks. 
If you create a file with only two or three colors (e.g. blue and yellow) perhaps 
it is best to use only two or three colors (Spot Colors), such as Pantone colors. 
In addition, not all colors can be printed using CMYK, e.g. "Gold", "Silver", etc. 
Some bright colors can only be achieved by using special inks, and these cannot 
be achieved with CMYK. Spot colors are also important for "non-printing objects" 
(for example, an outline to die cut) or "overprinted objects" (such as UV varnish). 
It's not only vectors that can use spot colors, also bitmaps can use Spot Colors. 
On the Bitmap Menu go to Mode > Duotone and convert the bitmap to one 
("monotone"), or more spot colors.
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13. Step 5 – Create Styles 

Text and Graphic Styles and Color Styles will help you to change content 
faster and will speed up productivity.

For example, imagine that we start a job with 2 colors, Blue and Yellow. Instead 
of applying these colors to each individual object, it is better to create two Color 
Styles and apply these to the objects (to create a new color style, select the object 
and right-click and choose > Color Styles > New from Selected…), If you 
need to use shades of each color (such as 10% of Blue, 20%, 30%, etc) you can choose 
"Create Gradient" on the same Color Styles docker (Window > Dockers > 
Color Styles), or (CTRL+F6).

Yes, it is also possible to manually change a color (Edit > Find and Replace 
> Replace Objects > Replace a Color...), but it is necessary to change every 
color and every shade of this color for each page. The Color Styles docker will 
replace the color and all shades on all pages in just one step. But it is important to 
remember that it is necessary to "apply" the Color Style to the object, since it is not 
enough to be "Yellow" or the same color (e.g. Pantone 012), the Color Style must 
be applied. When you change the Color Style, only the objects using that style 
will change, not all yellow objects.

The same happens with the styles of text and graphics. Suppose that we are 
working on a magazine, and we use Garamond, 24 pts for titles and Times New 
Roman, 11 pts for the body of the text. But after we have finished, our customer 
wants to change the fonts, and asks us to use Humanist777 - 30 pts for the titles 
and HelveticaNeue LT Pro 55 Roman - 12 pts for the body of the text. Although 
you can change it manually if we edit the Style of the titles it will change on all 
the pages in a second.
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You can see, it's not only about the Font name and size, there are a lot of text 
attributes that can be used in the same style, including colors. And you can have 
several color styles, i.e. for footnotes, headers, etc. Editing a style will change 
the entire document in just one step. Remember that as with Color Styles, it is 
necessary to apply the style to an object/objects, so that replacing or editing a 
style that uses Garamond will change all text objects that have had this style 
applied, not each and every Garamond text object.

14. Step 6 – Sending Files & Publishing to PDF 
If you are sending the original .CDR file, you must provide all the required 
information. The best way to do this is to go to File > Collect for Output…, which 
creates a new folder with a copy of the .CDR file, the fonts used and the color 
profile. If you are using externally linked images, these files will be also be included. 
Optionally, you can also create a PDF.

It's not good if the file is opened in a different version of the program because some 
things can change. For example, the fills of CorelDRAW X7 are quite different to 
those of previous versions and also allow selective transparency. For this reason, 
if you save the file back as a previous version, the program will ask if you want to 
convert text to curves and fills to bitmaps.

Anyway, there's a good alternative: create a PDF. To do this, you can go to 
File > Publish to PDF (or go to File > Export (CTRL+I), and there choose PDF). 
But it is not enough just to create a PDF, since not all the PDF's have the same 
configuration. For example, a PDF for the web will produce a PDF of low quality 
but it will be a small file, suitable for attaching to an email or using on a web page. 
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But for printing, we need the opposite: images of high quality and resolution. PDF 
settings is also a topic that requires a lengthy explanation, but this excedes the 
scope of the current tutorial. 

There are many different configurations, according to each company's work 
flow. But we propose a simple format that should work with most of the job 
outputs: choose PDF X-3 in the PDF Presets drop-down list, then go to "Settings" 
and change the "Compatibility" to Acrobat 8.0 or higher. Why? Because the PDF 
X-3 is a good standard but it has a default compatibility with Acrobat 4.0, which 
does not support transparencies and lenses. This problem is solved by changing 
the compatibility.

On the "Color" tab of the PDF Settings, by default all color will output as 
CMYK, but you can change it to "Native" especially if you are using Spot colors. 
Always activate the option to embed Color Profile. If you use custom overprints 
on your document, don't forget to leave this option active (it's enabled by default).

On the "Objects" tab you had several important options. The standard PDF X-3 is 
good, so you don't need to change anything. In particular, it's not needed to convert 
text to curves, because the PDF will embed all the fonts. Use this option only if you 
use fonts with restrictions for print, but only a few fonts have this problem. The 
'Convert to curves' option will create a bigger and more complex file, and some 
RIPs will have problems processing it. Since the fonts will be embedded, it is not 
necessary to convert text to curves.

On the "Prepress" tab you have the option of activating "Bleed Limit". Even 
if the current document does not have an active bleed, you can activate it while 
creating the PDF. But remember that the objects must extend out from the page 
limit. Activating the "Bleed Limit" does not automatically increase the size of 
objects used to create the design. Another option which is often useful is to activate 
"Crop marks" to indicate the limits of our design. For this reason it is important 
that the page size is the real size.
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15. Step 7 - Creating a Card 

Consider a couple of practical examples. First, we will create some business cards. 
As we saw at the beginning, we define the page size to be 90x50 mm (or 3.5x2 
inches). Remember that it's only an example, the size can vary from model to 
model. 

Then we double-click on the edge of the sheet to define margins and add a 
3mm Bleed. 

Then, still in the Options panel, we'll go to Documents > Guidelines > 
Presets > and choose "User Defined" to establish an inner margin of 5mm. Do 
not forget to click the "Apply Presets" button. We click on OK, and we have a 
page ready to start work. 

Next step:

Define Color Styles (Ctrl + F6). In this case, we will use two spot colors, Blue 
(Pantone Reflex Blue C), and Yellow (Pantone Yellow 012 C), both of the Pantone 
Solid Coated v.2 color palette.

We will create an imaginary logo, and we apply the Blue Style. Then, to create the 
background, double click on the Rectangle tool (Toolbox > Rectangle tool or 
F6), to create a rectangle the size of the page. We apply the Yellow Style, and we 



Computer 
Application 

in Apparel & 
Textile

NOTES

186  Self-Instructional Material

then create a gradient (we press the G-key to activate the Interactive Fill tool 
and drag the handles to adjust the gradient). Finally, we expand the size to cover 
the bleed area. As the card measures 90x50 mm, we will make the background 
of 96x56 mm, centered on the page (to center the background object, select and 
press P on the keyboard).

What's happens if we need several different names on our business cards? If they 
were only two, we could duplicate the page contents (Layout > Duplicate page), 
but if we want to create several pages, the best way is to create a Master Layer. 
To do this, select the logo and background, and choose Edit > Cut (or CTRL + 
X). Then, go to the Object Manager docker (Window > Dockers > Object 
Manager), and there choose from the docker menu "New Master Layer - All 
pages". Or we can click on the New Master Layer (all pages) icon at the bottom 
of the Object Manager docker.



Design And Create  
Motifs Using Corel 

Draw

NOTES

Self-Instructional Material  187

If you want you can rename this layer. Then simply "paste" (Edit > Paste or 
CTRL+V), to place the logos and background on the new layer. We can create as 
many pages as we need names, and all will have the same logo and background. 
But the advantage is, that it will only exist once in the file: and if you modify 
one element it will be changed on all pages. To avoid a change by mistake, we 
can "lock" that layer by clicking on the padlock icon on the Object Manager. 
Then, we just have to select the page and layer (usually, Layer 1), and enter the 
appropriate text (Name, Phone, etc) 

If we send the file to Print (File > Print or CTRL+P), notice that one card per sheet 
appears. But if we go to File > Print Preview, we can perform an Imposition 
(the second tool on the left), as well as set the gutter distance between the cards. 
Replays can be identical or different, why we chose it as the page number. We can 
also add Crop Marks (third tool), and many other options. 

But we just need to create a PDF file, a print preview is not necessary. Just 
follow the steps above and create a PDF with several individual pages, each with 
crop marks and bleed. Imposition will be done automatically using PDF-based 
workflows programs (such as Heidelberg Kodak Preps or MetaDimensions).

16. Step 8 - Designing a Magazine 

As a magazine design, the process is similar but with a few differences. The first 
step, as always, is to define the format of the magazine. Suppose the finished 
magazine should measure 19x27 cm then double-click on the page border (this 
takes us to: Tools > Options > Workspace > Document > Page Size), and 
choose the size of two pages together: 38x27 cm (the bleed as always, should be 
3mm but can be more if preferred).

We now navigate to "Layout" and choose "Booklet" from the Layout drop-down 
list. It is important to verify that the option "Facing pages" is active in order to 
see the magazine as it is read: the first and last pages as individual pages (as if 
the magazine is closed), and then pages 2-3, 4-5, etc. However, when creating the 
PDF each page will be individual, as it should be, so you can use any imposition 
software. If an object or image occupies two pages, it will be cut automatically.
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As with the business card, go to "Tools > Options > Workspace > Document > 
Guides > Presets > User Defined" and chose the inner margins if desired. If you 
wish, we can set different margins, for example, we may leave 1.5 cm at the top 
and 1 cm at the bottom. For this, we disable the "Mirror margins" option.

If we want to work with columns, we can also determine the number of columns 
and distance between them in "Tools > Options > Workspace > Document > 
Guides > Presets > User Defined > Columns". An important detail is, not to be 
confused with Paragraph Text columns which involves splitting a block of text into 
two or more columns (Text menu > Columns…). Dividing the page into columns 
does not automatically separate the text or content – it's just a visual reference.

Then, after clicking on Apply Presets, we can add the desired number of 
pages (Layout > Insert page), or press the Page Down key). We are now ready 
to start working.

C.  Make a Spec Sheet for Garments

1. Garment spec sheet or tech pack

A garment specification sheet or spec sheet is a technical document that contains 
the construction details of the product, a technical diagram/ sketch of the garment, 
measurements of the product. Specification sheets are the blueprint of a product, 
sometimes referred to as the technical pack or tech pack, and should be as 
comprehensive as possible. It should be a complete package, covering all aspects of 
the product, including package and labeling. Core lines or styles derived from core 
lines need as much detail as possible; they are basics, the bread and butter lines, 
and they should be regularly reviewed, adding and amending information, where 
necessary, helping manufacturers to maintain or improve quality standards and 
also helping new suppliers to make correct samples with an accurate costing.
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Figure :3.10 Garment spec sheet or tech pack

2. Make a specification sheet for garments
Today manufacturing is truly international. Retailers place orders in many 
countries, and this needs to be reflected in the way we design and communicate 
product specifications, relying as much as possible on illustration rather than text, 
because much can be lost in translation.

The spec sheet or tech pack can be a complex document with many interrelating 
parts, and sometimes, at the start of building a range, not all the information will 
be available. The spec sheet is first initiated when the buyer allocates a reference 
number, confirms the supplier style, colors, sizes, and fabric details. It is then 
usually the quality controller’s job to be a nuisance and chase (remind) whoever 
necessary for any missing information to complete the picture.

A garment spec sheet can originate from several sources; the following are 
some of the most common:

●● Buyer or designer discussing new ranges directly with the factories and 
arranging for approval samples to be sent at the head office. (The buyer may 
give samples bought in local stores to create specifications to take with on the 
buying trip or use the suppliers spec sheet for initial reference.)

●● If company has its own pattern and sample room, the initial Spec sheets will 
be created at the same time the samples are made.

●● Creating new variations from existing style specifications.
●● Using existing specification sheets that require updating.

When received initial samples from the supplier for evaluation, please ensure that 
the buyer has seen and approved each garment first. This will include trying the 
garments on a figure to ensure that they fit correct and amendments to the size 
chart and specification might be necessary at this stage.

You can also read: Merchandiser and Merchandising Process in Garment 
Industry
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At this point, it is important to mention that, although the quality controller 
takes ownership for completing the spec sheets, approving samples and the 
production, the buyer has the ownership of the actual product. It is buyer’s choice 
of factory, style, and fabric; they have agreed to a price and delivery date; and at 
the end of the day, they’re responsible if the items don’t sell. Buyers will expect 
to be kept up to date on the progress of their merchandise and want to know 
immediately of any problems find or changes might consider necessary. In some 
instances, an e-mail informing them is sufficient, but it needs to make an important 
change, go and talk to them first, explain the problem and why think it necessary 
to change the specification sheet, because at this point, it’s sods or Murphy’s law 
that the supplier will try and increase prices or delay the delivery.

The amount of information that can include is almost limitless, but time is 
not! However, need a minimum of information, and the priority is to highlight the 
most important features and characteristics of the product.

Should try to include as much detail as possible within the time limit available 
and this does depend on how quickly and accurately can draw, and the process will 
be speeded up if already have a similar product in library of specification sheets. 
This demonstrates the advantages of using CAD.

Here is given a quality controller’s complete process for making spec sheet: 
I first used CAD when working for a sportswear company, which produced 
detailed performance garments. I desperately wanted to illustrate the garments 
and create working drawings, but my hand drawing was very poor. Obtaining a 
copy of CorelDraw, I began to teach myself to illustrate, practicing as much as 
possible, evenings and weekends, drawing anything of interest; this included a 
watch, guitar, mobile phone, and chess pieces. I wanted to learn to draw objects 
in proportion; if the height, width, and outline were accurate, then all the other 
features and detail would fall into place.

A good example of this was when I worked for a uniform supplier, which made 
many types of civil, police, and military uniforms and tunics. Although there are 
many army regiments, the uniform is basically the same; differences are minor, 
such as variations in pocket styles and sizes and positioning of braid and badges. 
Police tunics are based on army tunics, which again have minor differences, so there 
was often an overlap in styles, and other countries’ military uniforms are based 
on British uniforms. You can now appreciate how new styles could be produced 
very quickly. As you create new styles, they add to your library of templates. This 
applies equally to fashion garments, as new styles are usually a reworking or 
reinvention of past styles.

You cay also like:
●● Costing of Men's Long Sleeve Shirt
●● Costing Procedure for Men’s Basic T-shirts

You may work for a large company that has specialists in different areas of 
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merchandise, and you become familiar with creating specifications for a certain 
groups of items such as trousers and skirts, ladies tops, or dresses, or may be 
tailored coats and jackets. It is very possible that because of sick leaves or holidays, 
you may have to cover for an associate, which helps you broaden your experience of 
other textiles or you may be in a company where you are the only quality controller 
responsible for all products. Fashion brands often include bags, hats, and shoes 
in their ranges, as well as clothing, and it is another string to your bow if you can 
illustrate these competently.

Today, to encourage customers to spend more money, new styles are fed 
into the shops on a regular basis. They might have a short shelf life or be very 
successful. Buyers are constantly traveling to major fashion centers, looking for 
new ideas and buying garments that they think will fit into their ranges. They will 
quickly require specifications to send to suppliers that clearly depict the style that 
is required. Full size chart and packaging and labeling instructions can be added 
later. The priority is to get a price and then a sample. Suppliers will be chosen from 
those who can turn samples round quickly, are familiar with the type of garment 
you are asking them to sample, know how to interpret the specification, and choose 
a suitable material. The fit and balance of a garment cannot be properly specified; 
we can only give the main critical measurements of the width and length. Only 
when we see a garment tried on can we be sure that we are happy with the fit. 
Alternatively, if possible, we can base the new style on an existing pattern block, 
where we know that customers are happy with the fit. Size chart measurements 
should be taken from the made-up sample and not the patterns, because those are 
the dimensions that we want the garment to finish at. Patterns often have built-
in manufacturing allowances, and these may vary depending on the fabric’s or 
garment’s washing process.

There are issues about size charts that you will find the industry divided on: 
do we specify the full measurement (total circumference) or half measurement, 
sometimes referred to as the flat measurement (which is taken as we measure 
the garment flat on the table). These include bust, waist, hip, hem, bicep, and 
cuff measurements. Pattern cutters prefer working with full measurements, but 
factories and quality controllers prefer working with half measurements, as they 
don’t have to double the amount when measuring garments. Whichever method 
you decide to use, make sure it is clearly mentioned on the size chart.

The other issue is tolerances; now, this can be a tricky one! These are the 
measurement variations from the size chart that we are prepared to accept. Now, 
some companies do not indicate any tolerances, but that does not mean that they 
won’t accept any. It just means that they don’t want to advertise the fact to their 
suppliers. Other companies specify plus tolerances but not minus tolerances, their 
reasoning being that if there has to be variations, they better be slightly larger than 
smaller. Owing to the instability of fabrics and to the fact that sewing machinists 
cannot be 100% accurate all the time, manufacturers will want their customers to 
specify plus or minus tolerances; for example, if a bust grade is 5 cm (2″), they will 
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ask for }2.5 cm (1″). Can we accept garments that are half a size larger or smaller? 
The answer is, sometimes, yes, it does depend very much on the style. For larger 
loose-fitting styles, this tolerance would be acceptable, but for close-fitted styles, 
no; the manufacturer should be instructed to control the manufacturing better at 
all stages of production and work to a smaller tolerance. As we are not working 
with rigid materials, we have to accept some tolerance, but this has to be agreed 
with the buyer and suppliers and may vary depending on the type of garment.

In spec sheet, each page should have a heading, to include a date, reference 
number, style, fabric, factory or customer and buyer, and page number. This will 
give a unique identity to each specification and each page of the specification. 
This is especially useful when amend any part of the specification. The factory 
will be able to immediately locate the page that needs to be replaced. It could be 
considered safer to reissue the whole specification sheet with a note of what has 
been changed and ask the manufacturer to sign a form, acknowledging that it has 
received the amended specification and that it understands the changes.

D.  Garment Specification Sheet

How do you communicate with someone at the production line about your vision 
for the construction of a garment? Only base measurement is not enough for the 
manufacturer to prepare an apparel as the chances of error are extremely high. 
So, how will he know where to sew a button or put a label? A garment specification 
sheet is an effective way to communicate with the clothing manufacturer by 
providing the smallest of detail about the apparel pattern.

1. Importance Of A Specification Sheet 

Specification sheet is the most effective way to communicate your design and 
vision of the garment to the production team. It is the most important document 
when it comes to garment production due to the following reasons:

●● The specification sheet or ‘spec sheet’ makes the factory production of your 
garment easier as it helps the manufacturer know the construction and trims 
for each style precisely.

●● A spec sheet helps in cutting down the turnaround time and provides better 
quality control.

●● It is understood by factories around the world.
●● If the production team deviates from the design details given in the spec sheet, 

you will be in a stronger position to get your money back or to seek legal aid.
●● It can also be used as a resource that can be revisited to study vintage collection.

2. Components Of A Specification Sheet 

The spec sheet is made even before requesting for a garment sample. The 
specification sheet can be revised based on the feedback received after analyzing 
the sample. Comments on the specification sheet help in modifying material, 
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workmanship, and details in the spec sheet before the garment goes into mass 
production. Therefore, a spec sheet is a blueprint of your garment which contains 
all the necessary details, such as:

●● Flat pictures
●● Construction notes
●● Finished garment measurements
●● Fabric yields
●● Measurement grades
●● Size gradation
●● Material details
●● Trim details

3. Types Of Details In The Garment Specification Sheet
Every detail matters in a specification sheet. After all, you want to make the 
garment exactly the way you have imagined it. A meticulously made garment 
specification sheet can make all the difference. While filling a garment specification 
sheet, remember to pay close attention to the following areas:

●● Points of measure
●● Front and back sketches of the garment
●● Fabric details such as swatch samples, supplier details, product code, 

and fibre content.
●● Print instructions
●● Stitch instructions
●● Embroidery instructions
●● Label instructions such as placement details and care labels
●● Accessories instructions such as trim details.
●● Garment washing instructions
●● A ‘Comments’ section that will be used by the factory to make a note 

regarding garment construction

4. Basic Terminology

A garment specification sheet is going to be used by the production team, therefore, 
it is crucial that the language in the spec sheet is in line with the machinery and 
techniques used in factory production.

3.4  STUDENT ACTIVITY 

1. 	� What is Create Halloween Pattern in CorelDRAW? Explain the Drawing 
the Moon?

	 ...........................................................................................................................



Computer 
Application 

in Apparel & 
Textile

NOTES

194  Self-Instructional Material

	 ...........................................................................................................................
	 ...........................................................................................................................

2. 	� What is element for Pattern? Explain the future and improve Making an 
element for Pattern?

	 ...........................................................................................................................
	 ...........................................................................................................................
	 ...........................................................................................................................

3.5  Make Collage Using Different Motifs, Shapes and Colours

A.  Collage Techniques 

A collage is a visual representation made from an assembly of different forms, 
materials and sources creating a new whole. A collage may include newspaper 
clippings, ribbons, bits of coloured or hand-made papers, portions of other artwork, 
photographs, and such, glued (photoshopped) to a solid support or canvas. Making 
collages is an important visualisation technique in the design process, next to 
design drawing and threedimensional modelling. By means of collages, you make 
visual representations of the context, user group or product category with the 
objective of deriving (visual) criteria.

The use of collages serves different purposes in the design process. A collage 
can aid in determining the colour palette of the product ideas and concepts. 
Collages are very suitable to present a particular atmosphere or context that you 
want to capture in the form of the new product ideas and concepts. In addition, 
collages help to determine and analyse the context in which the product will be 
used. As a designer you must take into account the context of which the product 
will be a part, i.e. the users, usage and usage environment. Making a collage helps 
to identify an existing or a new context.

Visual thinking and visualisation of ideas is inherent in thinking up ideas and 
solutions in design. Some issues cannot simply be captured in words, and this is 
where collages come into play. Collages help in structuring, developing, analysing 
and presenting visual issues that are difficult to express in words. You could think 
of shape characteristics, colour palette, compositional issues and so on. The overall 
purpose of using collages in the design process is to bring together visual elements 
to explore their commonalities.

Analysing collages helps determine criteria (design requirements) to which 
the solution must apply. Criteria of this kind also set a general direction for idea 
generation. With a collage we can find criteria for such matters as the lifestyle 
of a target group, the visual appearance of a product, the context of use and the 
interaction with a product (actions and handling). Other criteria may be how the 
product functions in its environment, and criteria that concern the category of 
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products with which the new product is comparable. Collages in that way help 
to generate criteria by which the aesthetic qualities of ideas and solution can be 
assessed. Therefore, the creation of a collage is a process that is both creative 
(designing the collage) and analytical (deriving criteria).

After making collages for the context, target group, usage and environment, 
you can use these images to define a number of characteristic types of colour/ 
texture and materials. By means of analyses of collages you can determine the 
colours that will play a role. You can determine environment colours, preferred 
colours, target group and the colours used for existing products. Produce a palette 
for this by using for example cuttings from magazines/ colour guides and/or the 
computer. The advantage of cuttings from magazines is that you can also obtain 
an impression of a gloss, material and possible transparency and texture. After 
gathering these provisional palettes, try to determine which colours will be the 
main colour for each palette and what the accent colours will be. Determine the 
relationships of these colours to each other.

We distinguish between an abstract collage and a figurative collage. An 
abstract collage is built from pictures and images that are distorted in such a 
way that their origins are not visible anymore. Simple techniques are tearing up 
images, pasting images over one another, applying coloured surfaces with either 
straight edges or organically ripped edges. Usually, abstract collages also contain 
sections where drawing or painting is applied. Abstract collages miss any pictorial 
meaning, but only contain meaning on an abstract level in their use of colours 
and composition. Figurative collages are collages that make use of the pictorial 
meaning of the original pictures and images used in the collages. Various types of 
images are used to create a new image, which itself has a new pictorial meaning.

B.  Using Perfect Shapes in CorelDRAW

Step 1

You'll find an assortment of Perfect Shapes in the Toolbox under the Polygon 
Tool (Y) icon. I chose Flowchart Shapes to start this quick tutorial with, and 
from there I chose a shape from the drop-down menu in the Property Bar. Drag 
out the chosen shape and we'll manipulate it in the next step.
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Step 2

Perfect Shapes are only so manipulable before they're Converted to Curves 
(Control-Q). You can Scale, Rotate, and play with the object's properties as 
needed, but to add or delete nodes and really play with the shape as you would 
any other object, you must convert the object to its curves.

Working with this particular shape, open the Object Properties docker and set 
the Outline to None. Under Fill, choose Fountain Fill and select the colors of 
your choice. I opted for a light and medium hue of cyan. Right-click and Convert 
to Curves if you'd like to further manipulate the shape at the node level; otherwise 
let's move on.

Step 3

Finally with this shape style, Copy (Control-C) and Paste (Control-V) three 
instances of the shape, layer them on top of each other, and hit Distribute Center 
Vertically so that your little wavy shapes line up evenly. Change the Fountain 
Fill of the front two shapes in the Object Properties docker, and let's move on to 
additional styles of Perfect Shapes.
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1. Special Nodes and Effects on Text

Step 1

Select Banner Shapes from the Toolbox and choose the second banner from the 
drop-down menu in the Property Bar. Draw a banner. Note the red and yellow 
nodes in the upper left of the Perfect Shape.

Using the Shape Tool, grab the yellow node and move it on the vertical axis. 
Reducing or increasing the size of the banner's left tail also effects the center fold 
and right tail.

This time, grab the red node with the Shape Tool. Move the node on the 
horizontal axis and note how either lengthening or shortening the center fold of 
the banner also affects the tails.

Step 2

Perfect Shapes will allow anything created on their paths to be affected when 
red and yellow nodes are manipulated. Using the Text Tool (F8), type within the 
shape's boundaries. When you do so, Perfect Shapes react the same way as other 
objects with type inside them.

Type on the path of the Perfect Shape. In this case, do so on the center fold of 
the banner. Once you do, manipulate the red and yellow nodes. Note how the text 
moves with the changes in the Perfect Shape no matter which path the type was 
placed on within the object. In a normal object, the type would only be affected if a 
node on that exact path was manipulated.
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2. Creating Simple Infographics

Step 1

Now that we've gotten the basics of Perfect Shapes and their functions, let's go over 
a common use of the tools: infographics. While complex infographics can easily be 
created within the program, to keep this brief, let's create a simple design now.

Under Callout Shapes, select the first design in the drop-down menu. Grab 
the red node and pull it down beneath the rectangle of the Perfect Shape. Be 
careful to make sure the node is in the center of the Callout Shape's tail.

As we did before, set the Outline to None and Fill to the Fountain Fill colors 
of your choosing.
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Step 2

Copy and Paste three instances of the Callout Shape. Place each copied object 
behind the last, and move each down so they peek out from under the last one 
slightly. Change the Fountain Fill of the copied shapes to shades of pink and 
yellow.

Select the center shape and hit Mirror Horizontally in the Property Bar so 
the tails of the shape are staggered.

Step 3

From the Basic Shapes options, select three different shapes for the bottom right 
corner of each Callout Shape drawn previously. Note how shapes with red nodes 
were altered as needed.
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Step 4

Select the top Callout Shape and, using the Drop Shadow Tool (found in the 
Toolbox) drag out a Drop Shadow from the blue shape that aligns with the shape 
itself but is placed slightly below.

Hold down Control to keep the drop shadow on a straight line while pulling it out 
from the shape. In the Property Bar, set Shadow Feathering to a value of 4-7. 
Repeat this on the other two shapes.

Step 5

Use the Type Tool to add whatever information your infographic may need. The 
design for this tutorial is intended to be an interactive infographic which would 
reveal each shape and its information as it was clicked.

C.  Use Color Styles 

In CorelDRAW, a color style is a color that you save and apply to objects in a 
CorelDRAW design. Any time you update a color style, you also automatically 
update all objects using that color style. With the infinite color possibilities that 
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CorelDRAW provides, color styles can also make it easier to ensure that you apply 
the exact color you want.

1. How to create a color style

You can create a color style from an existing object or from scratch. Once created, 
color styles are saved to the currently active file and to the Color Styles palette.

Click Window > Dockers > Color Styles to open the Color Styles docker.

Drag any color from the adjacent default color palette and drop it right into the 
top gray portion of the Color Styles docker, where it says “Drag here to add color 
style”.

1.   �Click Window > Dockers > Color Styles to open the Color Styles docker.

2.   �Drag any color from the adjacent default color palette and drop it right into 
the top gray portion of the Color Styles docker, where it says “Drag here to add 
color style”.

3.   �Add some additional colors if you like. Color styles are denoted by a small white 
triangle in the upper left corner of each swatch.

Figure :3.10

You can also create a color style from an existing image. 1. Open that image in 
CorelDRAW. 2. Select any or all of the objects containing the color you want to use 
and drag them into the gray area at the top of the Color Styles docker.

A new color styles palette will then be created.

Figure. 3.11
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2. How to edit a color style

When you create a color style, the Color Editor automatically opens in the Color 
Styles docker. You can alter a color simply by selecting its swatch, and clicking the 
Show color sliders button in the Color Editor area. You can use any combination of 
the color sliders, numerical color value boxes, or the Color eyedropper tool.

1.   Select a color in the Color Styles palette.

2.   �Adjust the color using any of the various tools in the Color Editor area of the 
docker.

3.   �After you edit a color, the new color will replace the previous color anywhere it 
is used in your image.

You will also see the new color represented next to the previous color for reference.

Figure :3.12 

You can also change any or all of the colors to a different color model by using the 
Color model list box, or even add custom spot colors by clicking the More color 
options button.

After you finish editing the colors, or if you want to close the Color Styles docker, 
you can open the Color Styles palette so that it displays next to the Default color 
palette. Click Window > Color Palettes > Color Styles Palette to keep the 
Color Styles palette accessible.

Figure :3.13
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You can also select and delete all the unused colors styles in your document by 
clicking the Select unused button in the Color Styles docker and then clicking the 
Delete button.

Figure :3.14

3. How to apply color styles to other objects

You can treat a Color Styles palette just like any other color palette. Any other 
object in your current CorelDRAW document can utilize color styles. The only 
difference between a Color Styles palette and other color palettes is that, if the 
color is in a Color Styles palette, you’ll need to double-click the color style swatch to 
apply it, rather than clicking it just once, like you would with other color palettes.

Figure :3.15

Here are few things to keep in mind when you’re working with color styles:
●● Although you can create color palettes and color styles from a photograph, you 

can’t change the colors in a bitmap object on the fly by using the Color Editor 
like you can with vector graphics.

●● Although adding any color into a CorelDRAW design will add that color to the 
document palette, creating a color style does not automatically add that color 
to the Document palette. You add the color style to the Document palette by 
applying the color style to an object in your document.

●● As you probably noticed, your original colors can also be converted into a color 
style and can be used in a color harmony. This useful feature will be discussed 
in another tutorial, but color harmonies are used to create color palettes with 
colors of similar hue-based relationships to the original color. Change one color 
and all the other colors in the color harmony spectrum will update automatically 
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to maintain that hue-based relationship. You can create color harmonies from 
groups of color styles.

D.  Corel Colour Management System

Corel's Colour Management System is Kodak Colour Sync 2, used by Adobe 
applications, Windows 98, and Mac OS. Corel Colour Manager 7 and Corel Colour 
Profile Wizard 8 are the same systems with little differences in the way dialog 
settings display. Version 8 will be dealt with in this lesson. However, those running 
version 7 can easily compare and apply this method.

Run Corel Colour Wizard 8 to get the dialog box shown in Fig. below. In Device, 
select Monitor. In Profile, select Generic Profile, and then click the Tune button.

Figure :3.16 First Dialog box of Corel Colour Wizard 8

The next dialog, will ask to specify the monitor manufacturer, model, and any 
annotation to be added. Click Next. 

Figure :3.17 Second dialog box of Corel Colour Wizard 8
If the monitor has a profile, select copy another monitor characteristic and point to 
the factory monitor profile. Leave this option blank if there is no profile and click 
Next.



Design And Create  
Motifs Using Corel 

Draw

NOTES

Self-Instructional Material  205

Figure :3.18 Monitor calibration

Since most users do not have a device to calibrate other than their eyes, please do 
not check this option.

In the dialog box shown in Fig. below, select Monitor White Point of 5000 
Kelvin. In Gamma section, check identical RGB value, and type 1.8. Now check 
Red and open video card application dialog where gamma controls reside. Move 
this window to see the Corel wizard's red colour swatches. The Matrox Millenium 
II controls are shown in Fig. below. Click and hold Red handle and move it until 
the red colour swatches match each other. Move away from the monitor to a 
distance not to discern the line dithering in the left swatch and /or squint eyelids 
until dithering disappears. Repeat this process for Green and Blue selecting them 
in the Corel Wizard and moving the sliders for video card. When all three colours 
are set, click OK. If the video card has numerical gamma controls, set it to gamma 
1.8, and do not match swatch colour.

Figure :3.19 Matrox Display Properties
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E.  Construction, colours, motifs, patterns and design
Fustat fragments are hand woven, naturally dyed, mordant and resist printed, 
rather coarse, hand spun cotton cloth assumed to be traded for the general domestic 
market, for apparel and furnishing use. Many of the fragments have remains of 
stitching threads, seams and pleats indicating use; threads used for stitching were 
flax, a fibre local to Egypt; frayed edges from being cutting or ripped; worn sections 
where the fibres have disintegrated over time. 

Of the samples examined, many were small,  appear to have been cut or as 
a remanent from the construction of a garment or interior furnishing. Given that 
they were uncovered from refuse heaps, it is implied they were excess, tailors off 
cuts or pieces of fabric of no value, were rubbish and disposed of.

The predominant colours of Fustat fragments are indigo (blue), Indian 
madder (red) and the natural cotton colour of the undyed and resisted sections of 
the designs. The cloth is dyed in combinations of blue and white, red and white 
plus patterns with all three colours together. The resist material, possibly wax or 
a mud and lime paste, appears as hand drawn into the cloth or printed using a 
simple block or stamp to resist the Indigo dye while a mordant of either alum and 
iron have been used to bond the dye to the cotton. 

Madder requires a mordant to bond to the fibre, so where no mordant is 
applied, the colour will not take in the dye. Also, cloth first dyed in Indigo will not 
take the Madder dye unless alum has been applied.

The fragments examined all had strong, solid colours; some with faded sections. 
Generally, Fustat fragments are excellent examples of the durability of natural 
colours and clearly illustrate expertise in resist and mordant dye technologies. 
The Fustat fragments provide vital evidence of the Indian dyer’s highly developed 
skills, indicating the sophistication of manufacturing and design aesthetics being 
used on apparently every day textiles from India at that time.

In terms of the motifs, patterns and design, Guy writes that the dating of the 
fragments ‘concurs with stylistic comparisons which may be drawn with western 
Indian painting and sculpture’ especially in plant formations and to architecture 
references to stone screens, mosques and tombs in Gujarat.  Carved stone as 
illustrated below are examples of Islamic architecture of Gujarat and illustrate a 
link to patterns of textiles produced in the state.

F.  The Basics-Color Theory 
Color theory is a set of basic rules and definitions that help us understand how 
colors behave and interact. The starting point of color theory are the three primary 
hues – yellow, red, and blue, which mix to create secondary and tertiary hues. 
These twelve hues – three primary, three secondary and six tertiary colors – form 
the basis of the color wheel, which can be used to explore color relationships. 
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The color wheel contains pure hues – i.e. colors with no addition of white, gray 
or black. There is a slew of confusing terminology and definitions regarding color 
variations – you’ve probably heard the terms color, hue, chroma, saturation, tint, 
shade, tone, and more. The definitions for each of these terms vary slightly from 
source to source, but it is not essential to memorize them. The essence is this – you 
can modify each hue from the color wheel by mixing it with white, black, or both:

These four basic parameters – hue, tint, shade and tone, let us recreate billions of 
individual colors the human eye is capable of discerning. Color theory can quickly 
become math and physics if you want to go into how light works and how we 
perceive it, but for the purpose of making art we’ll leave the theory at this level.

All the colors we are capable of making – and seeing – together form the color 
spectrum. One thing to keep in mind is that the scope of the color spectrum is 
different depending on what you plan to do with your colors. Our eye can discern 
billions of distinct colors, your monitor can display millions, and the best printer 
can produce thousands, but a screen print on fabric won’t be able to include more 
than a dozen. At first this may seem like a crippling limitation, but I’ll show you 
later how it’s actually a blessing.
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1. How we Combine Colors 

There are a few main models for choosing an effective color palette:

Contrasting and complementary palettes – contrasting colors are separated 
by other colors on the color wheel. The more colors stand between them, the higher 
the contrast. Colors that stand at the opposite ends of the color wheel have the 
highest possible contrast – we call them complementary, or clashing colors.

Variations of contrasting color combinations are the triadic, tetradic, split-
complementary, and square color scheme. http://www.tigercolor.com/color-lab/
color-theory/color-theory-intro.htm

In spite of being accused of clashing, these colors provide great impact and visibility, 
and can be used together to great effect.

Analogous palette – opposite of contrasting colors, analogous colors stand next 
to each other on the color wheel, and they support each other when combined. 
Since they come from a similar place their transitions are gentle and the overall 
effect they give is one of harmony and balance.

Monochromatic palette – a monochromatic palette will focus on a single hue 
and use its tints, shades or tones to support it. Monochromatic palettes can feel 
very gentle and soothing, but they can also run the risk of feeling samey and too 
timid. To ensure a good effect you can play with the values (amount of black and 
white) you add to your chosen hue, and the effect can be quite stunning.

A monochromatic palette can also be very powerfully enhanced by small contrasting 
highlights.

Faux monochromatic palette – one thing I like to do is make a palette that 
is almost monochromatic, but in fact includes subtle hue shifts. Note how much 
richness these slight variations add to the piece, even though the overall feel is 
still monochrome:

Tints, shades and tones – when you’re picking your palette, it’s safest to start 
from a set of colors which live in the same neighborhood on the tints, shades, and 
tones scale:
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You can always tweak your choices later for added interest.

G.  Importance of Color in Textile 

1. The Importance of Color We Wear 

Colors have a demonstrable psychological effect. So, our automatic reaction to 
colors is so strong. The sight of red means warning and white mean simplicity and 
respective of title. Military uniforms are intentionally colored to give statement 
and impose authority. Colors are used in many ways to assert recognition because 
they are fairly easy to read and understand. 

Figure :3.20 Color in textile

Not all colors are good for any individual because of different skin color tones. The 
best way to find your personal skin color is to ask a friend who can be objective 
about your situation. Your friend can "drape" you with big swatches of different 
colors. The most flattering colors are sometimes the good colors for you. Often, 
you'll be surprised that the color you like best is also the best color for you.

Once you know your personal color, practice by understanding their association 
with seasonable colors (spring, summer, winter, and fall). They can give a set of 
guidelines for flattering effect of your clothes. 

List of Popular Colors and How Our Emotions Respond
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BLACK		  Severe, mysterious, sophisticated, glum, depressing, deadly
BLUE			  Serene, calming, cool, quiet, sleepy, sad
BROWN		  Warm, earthy, drab
GRAY			  Well-informed, subtle, dignified, gloomy, cold
GREEN		  Fresh, successful, loving, greedy, restful, calm.
HOT COLORS	 (ie. pink) Wild, sensual, daring, flashy, vulgar
ORANGE		  Happy, cheerful, new, motivated, garish, warm.
PINK			   Soft, innocent, delicate, feminine, delicious
RED			�   Alert, warning, sexual, aggressive, energetic, cheerful, angry, 

vital, exciting
VIOLET		�  Royal, rich, stately, passionate, subtle but sexy, impressive, 

alone
WHITE		  Clean, pure, young, safe, simple
YELLOW		�  Sunny, bright, hopeful, optimistic, joyful, clear, positive, 

alive

It is important to understand that color has three properties. These properties do 
not affect the meaning of colors unless their appearances have actually changed 
(ie hot violet, frosted brown)

2. Color Guidelines According to Seasons

H.  Color Perception Theory for Textiles

1. Color Perception Theory for Textiles

What is color ? Color is something which makes the object more appealing, attractive 
and gives the pleasure of observation. color is defined as visual sensation arising 
from the stimulation of the retina of eye. Thus it is defined as psychophysical 
(the psychological response to the physical stimulus). Color may have different 
meaning to the different people.

●● To chemist - It may be a chemical compound (Dye or Pigment).
●● To physicist - It is a scattering or absorption of light or reflectance spectra 

of an object.
●● To physiologist - It is a measurable electrical activity of nerves.
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●● To psychologist - It is a complex process in brain of interpreting the signal 
of the nerve.

●● To artist and others - It is the means to create the sensation in the mind of 
the observer.

With the consideration of textiles, color is a very desirable parameter of a textile 
product. In case of technical textiles, color of the material is not necessary. Because 
it is only made with functional characteristics for high performance application. 
But in case of apparel production, color is a very crucial parameter. Because the 
consumers while buying the cloth in the market, they are highly attracted by the 
color of the material as well as the handle of the product.

The color of the textile product may varies with person to person and also 
the source which is used to perceive the color. The main reason for the variation 
of color vision in human is body motors (physically balancing) and mentality 
(psychologically balancing) of the person. Then the color of the material varies under 
the different sources. It is called metameric behaviour of the textile material. Also 
the color of the sample should be matched with buyers sample was very difficult. 
There are numerous coloring material available for coloration of textiles. Now we 
shall learn about principle of perception of color in the human vision.

Perception of color involves a series of events which are interdisciplinary in 
nature. Perception of color includes source of light, object that is illuminated and 
eye and brain that perceive the color. It is clearly shown in the following figure.

Figure :3.21 Perception of color

The source of the light is characterized by its energy distributed at different 
wavelengths (i.e. spectral power distribution of the light source). The modification 
of the incident light depending upon the nature the colorant which is present 
in the object. Then the radiations reflected by the object is received by the eye. 
The radiant energy is absorbed by the photosensitive pigments in the retina of 
eye. This gives rise to nerve impulse which transmitted to the brain. The brain 
interprets the signal of the nerve depending on the informations (data’s) stored 
in the memory. We shall now consider each of these components of color viewing 
separately.
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2. Source of Light:

Light is a form of energy and its propagates in the form of electromagnetic waves. 
Wavelength is important characteristic of electromagnetic wave. Therefore the 
the waves at the different ranges are identified by different names like gama rays, 
X rays, UV rays, visible rays, IR rays. Only a small part of the electromagnetic 
spectrum produces the sensation of vision. This part of the spectrum is called 
visible region. The wavelengths of the visible region varies from 380 to 750 nm.

Figure :3.22 Electromagnetic spectrum

The source of the light is characterized by its relative power distribution at different 
wavelengths. The light sources may be incandescent lamp, fluorescent lamp and 
arc lamp. Spectral power distribution of sources like candle light, sunlight and 
incandescent lamps are continuous.

The standard sources are recommended by CIE ( Commission International de 
L’Eclairage).This system quantify the colors interms of mathematical numbers. 
The sources are called as standard illuminants A,B and C.
CIE illuminant A has color temperature of about 2854 K. its spectral power 
distribution is similar to that energy radiated by 100 watt tungston lamp.
CIE illuminant B has color temperature of about 2854 K. its spectral power 
distribution is similar to that energy radiated by noon daylight.
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CIE illuminant C has color temperature of about 6500 K. its spectral power 
distribution is similar to that energy radiated by average daylight.
CIE defines the above illuminants for visible range of wavelength about 380 to 780 
nm. But with the development of fluorescent colors and fluorescent whiting agent, 
it is necessary to give standard illuminant for UV region. So that CIE defined the 
daylight illuminant D65. The color temperature of the D65 illuminant is 6500 K. 
The following figure will shows the relative power distribution of the CIE standard 
illuminants.

With the development of source technology, variety of efficient fluorescent sources 
have come into the market and are widely used in the house and shops for lightings. 
These are mainly fluorescent sources having discontinuous spectral power 
distribution. The manufacturers of garments and textiles, they would like to asses 
their color of products under these illuminants. CIE also defines the fluorescent 
sources F1,F2 and F3 to enable to calculate matameric indices of any product.

3. Object

The illuminating radiations are modified by the physical processes such as 
transmission, absorption,reflection and scattering. The relative proportions of 
these processes depends on the characteristics of the material. When the emerging 
light is same in the direction of incident light , it said to be transmission. When 
the material absorbs light it absorb all the spectral components except some color, 
so that it appears some color. The absorption occur in the material depends on the 
concentration of the coloring matter in the material. In addition to the absorption, 
scattering may occur in the material. In scattering process light travels in many 
direction other than the incident direction. 

When sufficient scattering occurs, it said to be diffuse reflection or transmission. 
The amount of light scatters depends relative refractive index and particle size of 
colorants. When the light is incident on the surface, some amount of light may 
be reflected from the surface. If the angle of incident is angle of reflection, then 
it said to be specular reflection. The reflection with varies angle is called diffused 
reflection. The amount of reflection depends on the nature of the colorants in the 
material and surface texture of the material.
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The appearance of the object is characterized by its spectral reflectance curve. 
The location of peaks spectral reflectance curve determines the hue of the object 
color. The object exhibits absorption peaks in the spectral reflectance curve at 
definite wavelength depending upon the color of the object. The spectral reflectance 
of achromatic colors( black and white) do not exhibits any peaks. The spectral 
reflectance curve of achromatic and chromatic objects are shown in the below 
figure.

The reflectance of any object can be determined by using the instrument called 
spectrophotometer. It gives a reflectance curve (spectrum) of an any object. The 
reflectance value varies from 0 to 1. The corresponding reflection percentage lies 
between 0 to 100.

4. Observer

The common detector of light and color is eye, nerve system and brain. The focuses 
the image of the object on retina. The photosensitive detectors in retina are called 
as rods and cones from their shape. The rods only detect the light but it have no 
ability to specify the color. The cones are responsible for color detection. There are 
three types of cones receptors in the retina. They are sensitive to light at different 
range of wavelengths. Three types of cones in the retina are

	 1.   Red sensitive cones

	 2.   Green sensitive cones

	 3.   Blue sensitive cones.
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The ultimate sensation of colors depends on the degree of stimulation of these three 
color receptors. If all the three cones are equally stimulated, it gives sensation of 
grey to white depending on the degree of stimulation.

The CIE recommends the standard observer data for color calculation. The 
standard observer is a person who is physically and psychologically balanced. A 
task of defining standard observer which may represent the normal color vision 
of average human population is difficult. CIE defined the standard observer data. 
There are two types of standard observer data called as 2º and 10º observer data. 2º 
observer data were prepared using fovea region of human eye. In practice in visual 
assessment of color, one uses larger are of retinal surface. The structure of fovea 
and the surroundings of retina are different. Therefore CIE defined another set 
of data is called 10º observer data. These data’s defined by using 10º field of view.

I.  Color Mixing Theories

1. Primary colors

Red, yellow and blue are called primary colors. These colors cannot be mixed or 
formed by any combination of other colors. All other colors are derived from the 
primary colors.

2. Secondary colors

Green, orange and purple are called secondary colors. These colors are formed by 
mixing of the primary colors.

3. Tertiary colors

Yellow-orange, red-orange, red-purple, blue-purple, blue-green and yellow-green 
are called tertiary colors. These colors are formed by mixing of primary and 
secondary colors.

There are two types of color mixing namely additive and subtractive mixing.

4. Additive color mixing

Additive color mixing occurs when two or more lights are added by focusing them on 
the white screen. In additive color mixing, red, green and blue are used as primaries 
to produce different colors. The primary colors are selected are independent in 
the sense that mixture of two primary will not produce the other primary. The 
combination of different primaries produces different colors like following,
Red + Green → yellow
Green + Blue → cyan (blue-green)
Blue + Red → purple (magenta)
Red + Green + Blue → White
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5. Subtractive color mixing

Subtractive color mixing occurs when one or more spectral components are removed 
from the incident light. The removal of part of incident energy can occur by process 
of absorption or scattering. In absorption process, the light energy is converted 
into a heat. When the subtraction is made by absorption only, it said to be simple 
subtractive mixing. When the light is removed by scattering and absorption, it said 
to be complex subtractive color mixing. The subtractive primaries are obtained by 
removing blue, green and red light from the white light. 

J.  How to Select Best Color for Dress

Colors are the phenomena of visual insight. You cannot hear, taste or feel 
the color, the only way to recognize the color is to see it. A color is a means of 
nonverbal communication and says a lot more than you can ever imagine. Color is 
a fundamental consideration in the design process. Color can also have an effect 
on the way you look in the clothing you wear. It is often the first element that is 
noticed about a design and influences how the garment or collection is perceived. 
Color is often the starting point of the design process. Color is something which 
makes the object more appealing, attractive and gives the pleasure of observation.

Our fashion color choices say a lot about the image we are trying to portray 
and how we feel about ourselves. Gender and personality are the most common 
factors for determining the type of colors a person will wear. Males are typically 
dressed in dark colors such as blue, black, green, gray, red, and brown. These 
colors are usually worn in various shades but they still consist of these primary 
hues. Females typically wear lighter colors such as pink, yellow, cyan, lime green, 
orange, and peach. Women and girls also wear the darker colors that are normally 
associated with men but men normally do not wear lighter colors associated 
with women. Color also has an impact on your apparent shape, personality and 
emotions.
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Figure :3.24 Selecting best color for dress 

The eleven basic colors have fundamental psychological properties that are 
universal, regardless of which particular shade, tone or tint of it you are using. 
Every color is having a positive as well as negative effect; negative effect shows 
when it is mixed with lighter or darker shade. The psychological properties of the 
eleven basic colors are as follows:

Red have positive properties like strength, warmth, energy, excitement and 
its negatives are demanding, aggression, strain. Blue have positive properties 
like trust, coolness, calm and its negatives are coldness, reserve, lack of emotion. 
Yellow have positive properties like optimism, confidence, self-esteem, emotional 
strength and its negatives irrationality, depression, anxiety. Green have positive 
properties like harmony, balance, refreshment, environmental awareness, peace 
symmetry and its negatives are boredom, heavy. Violet have positive properties 
like spiritual awareness, vision, truth, quality and its negatives are introversion, 
decadent, and inferior. 

Pink have positive properties like physical, nurture, love and its negatives 
are inhibition, physical weakness. Grey have positive properties like neutral 
and negatives lack of confidence, depression, lack of energy. Black have positive 
properties like sophisticated, glamour, secure, emotional safety and its negatives 
are domination, coldness, heavy. White has positive properties like hygiene, clarity, 
purity, cleanness and its negatives are coldness, barriers, and unfriendliness. 
Brown have positive properties like serious, warmth, nature, earthiness, reliable, 
support and its negatives are humorless, heavy, lack of sophistication.

1. Personal Coloring

The colors play an important role and one should think before adding the colors. 
Once the desired effect is achieved half the job is done! Contrast colors in clothes 
look stunning and catches the attention in its own way and tones of the same color 
also adds a lot of smartness. A garment’s message can be completely altered by 
the color.
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Simply wear the same color / shades of the same color (that is, a suit/top and 
bottom) from head to toe. Create interest by wearing different textures .You could 
also choose a shirt in a brighter/lighter shade. Now you’ve created a vertical Line-
slimming. This will also emphasize your face.

If you want to look taller then you should wear a light color from head to toe. 
You will also look taller when you repeat the same color tones in top and bottom. 
For example medium colored top and bottom. You can minimize your upper torso 
if you wear a darker top and lighter bottom. You can appear shorter/heavier when 
you wear a different color in your skirt/slacks/trousers, hose/socks and shoes.

2. How to Choose Best Clothing Colors

Everybody has a favorite color, but your favorite may not be the best one for your 
wardrobe. Everyone has a unique group of colors that make them look their best 
and another that makes them look their worst. Coordinating the right colors 
together makes the difference between a stunning outfit and an ugly.

3. Finding your color profile

It is important to determine your skin's undertone with the help of above guide. 
You will want to mostly stick to colours that match your undertone. While there 
are many different skin tones, there are only two undertones: warm and cool. 
Warm skin has a yellow or orange tint, while cool skin has a blue or pale pink one. 
There are two main ways to figure out which category applies to you.

●● Vein test: Look at the veins on your wrist or palm. People with warm 
undertones have Green-looking veins, while people with cool undertones have 
veins that are blue or purple.

●● Jewellery test: Under natural light, wear a silver bracelet on one wrist and a 
gold one on the other. Look at each hand and figure out which enhances your 
complexion better. If it's gold, your undertones are warm. If silver looks best, 
your undertones are cool.

●● Keep your skin's shade in mind: In addition to your undertones, your 
main skin tone can also determine which color families look best. A good rule 
of thumb is that colors that create a contrast in brightness with your skin are 
more flattering. If your skin is dark, saturated oranges and yellows almost 
always look great, even if your undertone is cool.

●● Wear tops and scarves that bring out the color in your eyes: If you want 
to make your eyes "pop," make sure a flattering color is near them. You will 
want to pick either a color that matches your eyes closely or one that produces 
the greatest contrast. For example deep red brings out the richness of brown 
eyes and serve as a stunning complement to pale eyes.

●● Look at your face next to each object: Do this under bright natural bright 
with a hand mirror. Try to decide which color makes you look your best. The 
right color will make your eyes look brighter and your skin healthier. Neutrals 
that make your skin look ruddy or sallow should be avoided. If you have trouble 
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choosing, ask a fashionable friend for their opinion.
●● Keep in mind what you want to convey with your colors: Earth tones and 

light, unsaturated warm colors can make you look friendly and approachable. 
Bright reds are attention grabbers. Dark, monochromatic colors can make you 
look stern or powerful. Wear muted or pale colors if you want to be noticed 
less. Bright, bold colors, especially purple, may make you seem more creative.

4. Something about Color Seasons

Spring colors are clear and bright, just like the colors of a spring day. The colors 
of this season are truly like a spring bouquet of flowers: red-orange and coral 
tulips, bright yellow jonquils and daffodils. The colors of summer are muted with 
blue undertones. Baby blue, slate blue, periwinkle, powder pink, sea foam green 
and slate grey are typical summer colors. Autumn colors are perennially popular, 
because they bring a feeling of warmth and security. These colors are as golden-
hued as a fall day, and typical colors from the palette include colors like pumpkin, 
mustard yellow, burnt orange, brown, camel, beige, avocado green, rust and teal. 
The colors from winter season are clear and icy, like a winter's day; always with 
subtle blue undertones, to name a few: holly berry red, emerald and evergreen, 
royal blue, magenta and violet.

K.  Color Mixing Systems 

1. Additive Color Matching System

In textile dyeing, single dyes are rarely used to obtain the final fabric shade. Color 
mixing is an important issue in color control of textile materials. There are two 
distinct color-mixing systems. The first mixing system deals with colored light 
such as is shown in the use of a computer color monitor or television. Different 
colors are obtained by mixing just three primary colors: red, green, and blue. There 
is no perfect red, green, or blue that will reproduce all the colors perceived by 
color normal humans, but modern high resolution computer monitors reproduce 
approximately 16 million different colors. This mixing of light is known as the 
additive color mixing system. Mixing of red and blue yields magenta, mixing of 
blue and green yields cyan, and mixing of red and green yields yellow. The mixed 
colors magenta, cyan, and yellow are all brighter than each primary, because they 
have greater final radiant energy. White is a mixture of all three primaries, and 
true black is the absence of any light.

2. Subtractive Color Mixing System

The second mixing system deals with colorants such as dyes and pigments used 
for textiles. In this system the primary colors are magenta, cyan, and yellow. 
However, in practical terms, dye houses use workhorse red, blue, and yellow dyes. 
Because of the way dyes absorb and reflect color wavelengths of light, this system 
is known as the subtractive color mixing system. Mixing of red and blue yields 
purple, mixing of red and yellow yields orange, and mixing of blue and yellow yields 
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green. White is obtained by destroying inherent color in textiles (bleaching) while 
black is produced by mixing red, blue, and yellow. Black is considered a “recovery” 
color for textile products. Off quality dyeings of any hue can be recovered into first 
quality black shades.

L.  Visual Color Sensation Variables 
In the textile industry, retail stores, business offices, and homes throughout the 
world, visual assessment of color is the primary method of determining color 
accuracy and control. Several visual color sensation variables are important and 
must be considered.

1. Metamerism

Historically, one of the most difficult of these variables for textile producers and 
buyers to deal with is known as “metamerism.” Metamerism occurs when two 
objects (textile materials) match under one set of viewing conditions (light and 
observer), but do not match when the viewing conditions are changed. Metamerism 
has benefits and challenges for the textile producer and buyer. For instance, as a 
benefit, the color of a dyed standard fabric can be matched even if the dyes used 
for the standard are unknown. However, a major problem can be that when a 
different light source is used, the standard fabric and trial color match flare in 
widely different directions. The minimization of negative metamerism effects on a 
wide range of shades of textile materials is an indication of a highly skilled textile 
producer.

2. Color Fatigue

Another problematic color sensation variable is color fatigue. When an individual 
views a potential color match, because of the process of color vision, the nerve 
light receptors in the eye begin to fatigue. The result is that color matches begin 
to appear closer over time, usually after 15-20 seconds of viewing. Also viewing 
bright colors just before viewing deep colors can affect color judgment without 
enough time allowed for visual rest and recovery. Many have suggested that at 
least 1-2 minutes are required for color vision to recover between viewing divergent 
colors. As mentioned earlier, color monitors only have three primary color stimuli. 
The condition known as a color fusion allows for perception of smooth solid colors 
rather than specky or uneven color on monitors, color photos, color paper printing, 
and certain textile materials. Another color sensation variable, which often 
creates problems for textile producers and buyers, is the influence of the surround 
or background on the color being judged. To minimize this effect, shade booths 
normally have standard gray interior color. However, this variable (simultaneous 
contrast) is a definite factor when judging individual colors within pattern fabrics 
such as textile prints or yarn dyes.

3. Visual Assessment of Color Difference of Textiles

Because of the importance and widespread use of visual assessment of color and 
the fact that numerous variables exist in this process, AATCC has published an 
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evaluation procedure entitled “Visual Assessment of Color Difference of Textiles.” 
The procedure provides information and a systematic method for standardized 
visual color evaluation. It also describes important color matching variables such 
as illumination type, illumination level, viewing environment, viewing geometry, 
and reporting procedures. This method is highly recommended as a guide for 
textile materials. It does not give definite pass/fail tolerances for shade matching, 
but does indicate some important considerations.

M.  Shade Sorting 

Once textile materials have been dyed or printed, several other issues concerning 
shade quality and evaluation should be considered. Shade sorting is a color quality 
control system, which works well when high volumes of the same shade on the same 
fabric constructions are sold to numerous fabric buyers. Once shade tolerances 
are set, then fabrics that fall within those tolerance limits, yet are somewhat 
dissimilar from each other due to cast or shade depth, are sorted and grouped in 
the finished goods warehouse, so each fabric buyer receives as consistent a fabric 
shade as possible. For example, each roll of cotton twill khaki fabric will be color 
evaluated, then color grouped such as slightly red, slightly yellow, slightly blue, 
slightly deep, and slightly light. Once grouped, the slightly green khaki is shipped 
to buyer #1, the slightly red khaki is shipped to buyer #2, and so forth. However, 
this system does not work so well for low volumes of wide shade ranges to multiple 
buyers. There are a number of these types of color control systems available, but 
any system used should be adapted to the specific needs of the supplier and buyer.

Not only is the initial acceptable shade important for textile product quality, but also 
the retention of shade by the textile after exposure to various end use conditions. 
AATCC has published three visual color evaluation procedures employing scales 
to help standardize the judgment of shade quality of textiles. These procedures are 
the “Gray Scale for Color Change,” the “Gray Scale for Staining,” and the “AATCC 
9-Step Chromatic Transference Scale.” All three scales require consideration of 
key issues such as illuminant choice, viewing conditions, and the color normalcy 
and skill of the observer. Each scale is designed for specific circumstances.

1. Gray Scale for Color Change

The Gray Scale for Color Change is used for visual evaluation of changes in 
color of the textiles resulting from colorfastness tests such as washing in home 
or commercial laundries, dry cleaning, and exposure to light, or exposure to 
chlorinated pool water. The scale allows for a rating of 1-5 with half-step grades 
intermediate between each whole step pair. Grade 5 is the highest grade and is 
considered as no noticeable color change after testing between the original and 
tested fabric samples.

2. Gray Scale for Staining
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The Gray Scale for Staining is the scale used in visual evaluation of staining (color 
transfer) from dyed to unstained textiles resulting from colorfastness tests, such 
as crocking or accelerated washing. Here crock squares or multifiber strips are 
evaluated for staining acquired during the specific tests. The scale allows for a 
rating of 1-5 with half-step grades intermediate between each whole step pair. 
Grade 5 is the highest grade and considered no transfer of color or staining from 
the original fabric during the testing. As can be seen, although similar, these two 
gray scales are intended for different purposes and are very different from each 
other.

3. Chromatic Transference Scale
The AATCC 9-Step Chromatic Transference Scale is used in the evaluation of 
staining of undyed textiles in colorfastness tests, especially crockfastness. The 
purpose of this scale is similar to that of the Gray Scale for Staining. It differs in 
that it consists of 60 color chips in five hues: red, yellow, green, blue, purple, and 
neutral gray, corresponding to the Gray Scale for Staining. Many manufacturers 
have found these chromatic scales somewhat easier to use than the gray scale. 
However, for critical evaluations or in the case of legal arbitration or litigation, the 
Gray Scale for Staining should be used.

3.6  SUMMARY

In summary, although the perception of color is as normal to human beings as 
sight itself, the complexities of color make color perception difficult at best. These 
complications of color vision include different light sources, differences of fibers, 
yarns, and fabrics as well as complications caused by color sensation variations 
and communication. The color professional should always take steps to control 
as many variables as possible when judging the color and color quality of textile 
products. Consideration of factors such as illuminants, textile product content, and 
constructions and observer issues are all important to the accurate and consistent 
evaluation of the color of textiles.

Color is extremely important in the modern world. In most cases color 
is an important factor in the production of the material and it is often vital to 
the commercial success of the product. It is obvious that a standard system for 
measuring and specifying color is much desirable. The color of an object depends 
on many factors, such as lighting, size of sample, and background and surrounding 
colors. In considering the appearance of an object, factors such as texture and gloss 
are important, as well as color. Almost all modern color measurement is based on 
the CIE (International Commission on Illumination) system of color specification. 
The system is empirical, i.e. is based on experimental observations rather than on 
theories of color vision.

The motifs which are developed by using C++ programming are more 
systematic, accurate and can be changed with the use of change in parameters 
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given in the program. Motifs created through Corel Draw and Reach Fashion 
Studio software are designed manually through creating lines and sketches and 
requires repetitive changes like redrawing and erasing. The time taken to draw 
a motif in Corel Draw or Reach Fashion Studio are time consuming whereas in 
the program developed the same can be designed in a small time as compared to 
the other software's. Therefore, it can be safely concluded that the motifs created 
through the developed program can be easily created within no time and as per 
the user's specification .

There are many 2D as well as 3D software's available in the market for motif 
designing but the new tool developed in the present work establishes the visual 
superiority over the commercially available tools. The visual output generated by 
the programming method developed in the present work is sharp and clear as 
any 3D motif (created by RFS) and too superior to any 2D motif (Corel Draw). 
Although the range of colors used in this software is limited as compared to other 
software's in the market, it is still the sharpest of all the motifs created by other 
commercially available tools and it is as good as in any commercial software.

Geometric designs are one of the most visually appealing forms in graphic 
design. They can appear in a wide variety of styles and fulfill a huge range of roles.

This blog post tells you everything you need to know about these designs and 
shows you how to create your own unique piece.

However, before we get into how you can create designs, it’s important to 
know exactly what they are.

At its core, design is based on shapes. Geometric shapes design – with circles, 
triangles, squares, rectangles and many other shapes often combine to form 
beautifully intricate patterns. Even if you only use a few shapes in your design, 
there are so many possibilities as to what you can create.

They were first used thousands of years ago in the art of many ancient 
civilisations, and it is their unique ability to stand the test of time that sets them 
apart.

However, colour Managers are not 100% reliable, they may do well, but under 
certain conditions they do not. Several colours that display well on the monitor 
cannot be reproduced in print. Reading CMYK is preferable than Colour Manager. 
Read the shadows, highlights, and neutral colours after a CMYK image is done. 
Adjust them using curves. Shadows should be C80 M70 Y70 K70. Highlight 
C5M2Y2K0. Reading CMYK and adjusting them results in good prints always.

The context for the development of a colour palette is discussed along with the 
focus of colour in textile design for fashion and interiors. The relationship of colour 
to trend prediction and manufacture is explored along with the technical aspects 
of communicating colour within industry.
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3.7  GLOSSARY

Garment Base Width 		  : �This measurement is taken horizontally 
straight from edge to edge.

Shoulder Drop 			   : �This measurement is from the shoulder seam 
at the armhole to the HPS

Leg Opening 			   : �This measurement is taken across the bottom 
edge of the leg opening, horizontally.

Knee Opening 			   : �This measurement is taken 30.5 centimeters 
below the crotch and is perpendicular to the 
trouser leg from side to side.

Inseam 				    : �The measurement between the inner leg 
seam, i.e. the crotch seam to the leg opening.

Sleeve Overarm 			   : �It is the measurement from HPS to the outer 
shoulder edge.

Armhole Straight 			   : �It is the horizontal measurement from outer 
edge to the bottom of the armhole.

Armhole Curved 			   : �It is the curved measurement from the outer 
shoulder edge to the bottom of the armhole.

Front Neck Drop 			   : �It is the measurement from the back neck 
seam to the top edge of the front neck.

Bottom Hem 			   : �It is the horizontal measurement, curved or 
straight, along the bottom edge, from one 
side seam to the other.

Cuff Opening 			   : �It is the measurement along the cuff opening, 
edge to edge.

Cuff Depth 				    : �It is the measurement from the edge of the 
cuff to the seam.

3.8  REVIEW QUESTIONS

1.     What is meant by Drawing the Moon?

2.     What are Preparing documents for prepress and print?

3.     What is garment spec sheet or tech pack?

4.     How to make a specification sheet for garments?
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5.     Discuss the Importance Of A Specification Sheet.

6.     What Is Types Of Details In The Garment Specification Sheet?

7.     What are color styles in CorelDRAW®?

8.     How to create a color style.

9.     How to edit a color style.

10.   How to apply color styles to other objects.

11.   What is color ?


	content new
	Index Computer application in Apparel & Textile - Copy
	content 266

	content - Copy
	content 2
	content


	Blank Page

	BFA(F) 105 SE 2 Computer application in Apparel & Textile



